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Document Revision Control

This document is under revision control in accordance with Datalogic’s Quality
System. Any addenda or other documents associated with this manual are under
separate revision controls. A revision number is changed by 0.1 whenever
technical information is changed or added to a document.

Copyright Information

Copyright © 2011-2012 DATALOGIC. All rights reserved.

No part of this document is to be reproduced or utilized in any form or by any
means, electronic or mechanical, including photocopying, recording, or by an
information storage and retrieval system without prior written consent of
Datalogic Systems, Inc. All drawings and specifications contained in this manual
are the property of Datalogic Systems, Inc. and shall not be reproduced, copied
or used in whole or in part as the basis for the sale or manufacture of products
without the written permission.

Datalogic and DRX® are registered trademarks and the AS logotype, 1-800-
BAR-CODE " is a trademark of Datalogic.

All other company or product names are mentioned for purposes of identification
only, and may be trademarks of their respective owners.

Disclaimer Information

The information contained in this manual is subject to change without notice.
Supplemental information or documentation may be required for certain
applications or usage.

The examples and diagrams in this manual are included solely for illustrative
purposes. Because of the many variables and requirements associated with any
particular installation, Datalogic cannot assume responsibility or liability for
actual use based on the examples and diagrams.

No patent liability is assumed by Datalogic with respect to use of information,
circuits, equipment, or software described in this manual.

In no event will DATALOGIC. be responsible or liable for indirect or
consequential damages resulting from the use or application of this equipment.
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Preface

Welcome to the AccuLazr™ AL5010 Product Line Manual from Accu-Sort
Systems, Inc. This user manual includes the information you need to
integrate effectively the AL5010 Bar Code Reader with your application. It
contains detailed information about the following:

= Product features, capabilities, specifications and accessories
= Safety information

= |nstallation guidelines and procedures

= Configuring the AL5010 for your application

= Maintenance and Troubleshooting

This preface explains how this user manual is organized and introduces
other sources of information that you will find useful.

Intended Audience

You should have a basic understanding of bar code scanning. Equipment
installers must be familiar with standard wiring techniques and terminology.
Because the Acculazr user interface software runs on a web browser in the
Microsoft® Windows® environment, you should know how to use a mouse,
choose commands, and work with windows and dialog boxes.

This manual contains some terms that may be unfamiliar. Use the glossary
at the back of this manual for assistance.

Thank You

Thank you for using an AL5010 bar code scanning solution and this manual.

We value your comments and feedback. Feel free to let us know what you
like or dislike about AL5010 (or this manual) by e-mailing us at
info.automation.us@datalogic.com.

You can also mail your comments to our corporate headquarters address or
call us directly at 1-800-BAR-CODE ' or (215) 723-0981.

\ NOTE: There may be additional material that was not available when this
A product manual was produced. To learn if there is a documentation update,

go to our web site’s corresponding product page at Datalogic website.

Other Sources of Information

You can choose from many information sources, including documentation,
training, and support services, to increase your knowledge and
understanding of the AL5010 bar code scanning solutions. If this manual
refers you to other documentation, use only the latest versions unless
otherwise specified.
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viii Preface AcculLazr™ AL5010 Product Line Manuals

Conventions

WARNINGS or CAUTIONS: This symbol identifies a hazard or
procedure that, if incorrectly performed, could cause personal injury or

result in equipment damage. It is also used to bring the user’s attention to
details that are considered IMPORTANT.

HIGH VOLTAGE CAUTION: This symbol alerts the user they are about
to perform an action involving, either a dangerous level of voltage, or to
warn against an action that could result in damage to devices or electrical
shock.

LASER CAUTION: This symbol alerts the user they are about to perform
an action involving possible exposure to laser light radiation.

ESD CAUTION: This symbol identifies a procedure that requires you take
measures to prevent Electrostatic Discharge (ESD) e.g., use an ESD wrist
strap. Circuit boards are most at risk. Please follow ESD procedures.

NOTES: This symbol draws attention to details or procedures that may be
useful in improving, maintaining, or enhancing the performance of the
hardware or software being discussed.

NOTE REGARDING DIMENSIONAL REFERENCES: This manual
provides all dimensional references in inches and in most cases Metric
referenced in brackets, for example 10 inches [254 mm].

> B

Customer Service

Training

Accu-Sort Systems offers a complete set of training courses to help you and
your staff get the most out of your investment. We can help you develop a
training plan that provides thorough training for both your project team and
your end users. We will work with you to organize courses appropriate to

your job or area of responsibility. Training professionals can show you how
to plan your training throughout the implementation process so that the right
amount of information is delivered to key people when they need it the most.
You can attend courses at our training center, or you can arrange for our
trainers to teach at your facility. In addition, we can tailor standard courses or
develop custom courses to meet your needs.

Support

From on-site support to central support, our team of experienced
professionals provides the help and information you need to keep your
equipment working for you. This team includes your Account Manager and
Accu-Sort’s large staff of support specialists with expertise in your business
area and managing your hardware and software environment.

NOTE: If you have any problems or questions that require Accu-Sort's
A assistance, direct your calls to Customer Service at 1-800-BAR-CODE" or

(215) 723-0981.
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1 Introduction

This chapter presents an introductory description of the AccuLazr™ AL5010
laser barcode scanner product line including:

= AL5010 Product Line Overview
= Acculazr User Interface

AL5010 Product Line Overview

The AL5010 line of laser barcode readers is designed with industrial and
manufacturing applications in mind, providing high-speed scanning and high
reliability in a rugged industrial enclosure. The entire AL5010 product line
offers a large depth of field that provides accurate barcode reading from as
little as 4 inches up to 48 inches.

The AcculLazr AL5010 Mid-Range Laser Barcode Readers include:
= AL5010 Scan Head

= AL5010 Mounting Base

= Acculazr Interface Module (optional)

= Power Supply Module (optional)

AL5010 Barcode Reader Acculazr Basic Interface Module
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AL5010 Scan Head

The AL5010 Scan Head incorporates the optics and laser module(s) for
scanning barcodes as well as the decoding engine and parameter storage
module. The control panel provides several LED status indicators and three
function buttons.

There are five models of the AL5010 Scan Head (each available with
optional adjustable raster):
= One-laser models for standard and high-density

= Two-laser models for standard, near-focus high-density and high-density

An optional Adjustable Raster (adjustable up to 20-degrees above or below
0-degrees, variable DOF) is available in the existing scan head housing. No
bolt-on additions are required.

AL5010 Mounting Base

The AL5010 Mounting Base provides for the mounting of the AL5010 as well
as the wiring interface between the scan head and AcculLazr Interface
Module. It includes a parameter storage module that enables parameters to
be uploaded/downloaded with the ‘hot-swappable’ scan head.

Phone: 800.894.0412 - Fax: 888.723.4773 - Web: www.ctiautomation.net - Email: info@ctiautomation.net



AcculLazr Interface Module

The Acculazr Interface Module is fully compatible with the AL5010 line of
barcode readers and is available in both a Basic and Enhanced version.

The AcculLazr Basic Interface Module provides the following connections:
= Scanner (15-pin and RJ45)

= Ethernet/ EtherNet/IP (1)

=  Serial ports (2)

= Trigger Input

=  Power
!

The Enhanced Interface Module provides the following additional
connections:

= Tach Input
= Up to four Opto22 I/O modules
= Fieldbus communications (either DeviceNet or Profibus)

Phone: 800.894.0412 - Fax: 888.723.4773 - Web: www.ctiautomation.net - Email: info@ctiautomation.net



AcculLazr™ User Interface

The AcculLazr User Interface lets you configure an AL5010 through a series
of intuitive, user-friendly menus, tools and dialog boxes accessed via a web
browser. Context sensitive help is available to assist with use of the software.

[F————

Acculazr™

= Modify

0

Eonfiguration

User Defined Modulo
Padding and Stripping
Match Code Setup

u Serial Settings.
Network Settings
Trigger Settings
Relay Settings
Tracking
DRX

Save/Retreive Settings

Diagnostics

Modify > Configuration

Reader Information
Reader Name

ALS010

Reader Modal

AL5010-1L

Configuration Options

Scan Rate (700-1400)

NOTE: Modifying the scan rate from the
factory setting can adversely affect
the AL5010 performance

[ Enabled Trigger/Track Controlled Laser

Name/Revision
AL5010 ‘
Decode Software Name/Revision
DECTST

|~ Control Panel Options

[ enable control Panel Buttons

| Use Butten | For Text Mode >

| Metwork Access Options

Usemame |accusort
Passuiord

With the user interface, you can:
Integrate AL5010 to your system and application without custom

software.

%J Local intranat

Modify output messages to accommodate your system needs.
Add or modify the barcode symbologies read by AL5010.

Define up to four (4) relay input/outputs.

Monitor AL5010 performance using diagnostic tools.
Fine-tune optional adjustable raster.

You can easily configure your AL5010 reader by using a desktop or laptop
computer, an Ethernet network connection and the browser-based interface.

oo ~
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Typical AL5010 Mid-Range Barcode Reading Applications

Use the AL5010 in the following applications:
= single-reader applications (side or top)

= pick module scanning

= multi-sided scanning

= retail distribution centers

= industrial manufacturing

With optional Adjustable Raster:

= pallet scanning

= hard-to-read barcodes

= plastic shrink-wrapped barcodes
= unknown label positioning

Phone: 800.894.0412 - Fax: 888.723.4773 - Web: www.ctiautomation.net - Email: info@ctiautomation.net
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Options and Accessories

Contact your sales representative for assistance in determining which
options and accessories will be applicable to your application.

If you know which items are needed, contact Accu-Sort’s Customer Service

Department (ask for the Spare Parts Coordinator) between 8 AM and

4:30PM (EST) Monday through Friday at 1-800-BAR-CODE (Fax: 215-723-
1515).
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2 Safety

Please follow the safety precautions and warnings found in this manual when
installing, setting up, operating, maintaining, troubleshooting or replacing any
Accu-Sort products, parts, or related equipment. Following these precautions
will prevent personal injury or damage to the unit. Failure to follow these
precautions may also void your warranty.

This section provides important information regarding safety and your
AL5010, especially involving issues regarding:

= General Precautions during Mounting and Installation

= Compliance Requirements

= Electrical Safety

= Electrical Grounding Requirements

= Electrostatic Discharge Precautions and Control

= Laser Safety

Contact Accu-Sort at 1-800-BAR-CODE™ if you need more information.

Symbols

Throughout this manual, special safety alerts are indicated by the following
symbols:

WARNINGS or CAUTIONS: This symbol identifies a hazard or

procedure that, if incorrectly performed, could cause personal injury or
result in equipment damage.

HIGH VOLTAGE CAUTION: This symbol alerts the user they are about
to perform an action involving, either a dangerous level of voltage, or to
warn against an action that could result in damage to devices or electrical
shock.

LASER CAUTION: This symbol alerts the user they are about to perform
an action involving possible exposure to laser light radiation.

B B b

ESD CAUTION: This symbol identifies a procedure that requires you take

‘._: &4, measures to prevent Electrostatic Discharge (ESD) e.g., use an ESD wrist
strap. Circuit boards are most at risk. Please follow ESD procedures.

Alerts help you to:
= |dentify a hazard and its consequences
= Avoid a hazard by taking adequate safety precautions

=  Get the most out of your bar code solution

Phone: 800.894.0412 - Fax: 888.723.4773 - Web: www.ctiautomation.net - Email: info@ctiautomation.net



General Precautions

Installation and Service by Qualified Service Technician Only

WARNING: All procedures involving exposure to the inside of the
AL5010 Interface Module must be performed by a trained
technician because of possible exposure to emitted laser radiation,
high voltage, and could reduce the effectiveness of the device’s IP
rating. There are no user-serviceable parts inside. Do not attempt
to open the unit or perform any installation/service procedures
unless you are a trained technician! DO NOT REMOVE the
faceplate from the scan head enclosure. Opening the AL5010 will
void the factory warranty.

Refer all servicing and advanced troubleshooting to a qualified service
technician. Technical training is available from Accu-Sort Systems.

Furthermore, even trained technicians should always reference the specific
product documentation for more detailed service procedures that may not be
described in the AL5010 Product Manual.

Unpacking, Mounting and Installation Recommendations

CAUTION: Firmly fasten mounting structures in place before installing the

& equipment to any mounting structure. Avoid using freestanding mounting
structures. If your application requires a freestanding mounting structure,
avoid making the structure top-heavy.

= Follow all procedures regarding electrical safety, laser safety, and
electrostatic discharge safety (ESD) as outlined in this manual.

= Save all packing material in case you have to transport your readers.

= Use steel or aluminum as a mounting structure. An Accu-Sort mounting
structure is recommended for optimum system performance.

= Check mounting hardware periodically for tightness and stability.

= Do not use sheet rock, plaster board, wood, or other unstable mounting
surfaces.

= Do not use mounting surfaces that are subject to high vibrations.

= Do not create any obstructions of airflow around the modules. Keep the
area around the modules clean to provide for cooling. (Refer to specific
product manuals for minimum clearances.)

= Avoid dropping the readers during unpacking and installation.
= Do not touch the window glass of the scan head.
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Compliance Requirements

FCC NOTICE: The AL5010 has been tested and found to comply with the
limits for a Class A digital device, pursuant to Title 47, Part 15 of the FCC
Rules. These limits are designed to provide a reasonable protection against
harmful interference when the equipment is operated in a commercial
environment. This equipment generates, uses, and can radiate radio frequency
energy and, if not installed and used in accordance with the instruction
manuals, may cause harmful interference to radio communications. Operation
of this equipment in a residential area is likely to cause harmful interference in
which case the user will be required to correct the interference at his own
expense.

WARNING: These are Class A products. In a domestic environment, these
products can cause radio interference, in which case the user may be required

& to take adequate measures. (Ref. CISPR 22 = EN 55 022:1995.)

& IMPORTANT: Follow the guidelines below to maintain Electromagnetic
Compatibility (EMC) Compliance:
= Interconnecting cables must be twisted pair cables.
= All shielded I/O cables shall have the shield terminated to the chassis.
= NOTE: DRAIN WIRE SHIELDING IS NOT ADEQUATE.
= Do not remove the shielding covers.

= Refer to the details on making custom cables as provided in the specific
technical manual for the component.

Electrical Safety

AL5010 must be installed in accordance with Canadian Electrical Code, Part I,
CSA C22.1; CSA C22.2 No. 0; and the National Electrical Code, NFPA 70.
For complete requirements, National Electrical Code, ANSI/NFPA 70,
Canadian Electrical Code, Part I, C22.1, or other national standard must be
consulted.

= For PERMANENTLY CONNECTED EQUIPMENT/RACK MOUNTED,
incorporate a readily accessible disconnect device in the fixed wiring.

=  For PLUGGABLE EQUIPMENT/RACK MOUNTED, install the socket-
outlet near the equipment so it is easily accessible.

= Make sure that all personnel who work with the equipment know where
the disconnect switches or circuit breakers are located.

= Before performing any type of maintenance, turn off power to the unit and
disconnect the power cord.

= Be certain your hands and the floor of your work area are dry before
touching electrical equipment or connecting cords.

= Routinely check all power cords, plugs, wiring, and cable connections for
any signs of exposed wire or deteriorating insulation. If you notice any
damage, make arrangements with service personnel to repair or replace
the damaged item immediately.
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Electrical Grounding Requirements

Before applying power to any device, ALL components MUST be electrically
grounded. Follow these precautions:

= Ensure all AC power outlets have a properly grounded receptacle.

= ALL components MUST be properly cabled and grounded with three-
conductor AC power cords.

= Use the correct power cord for your country.

= Reference specific grounding instructions for each component.
= Do not use a two-prong adapter.

= Do not cut/remove the round grounding prong from any plug.

= Do not use an extension cord to defeat any ground.

Electrostatic Discharge

‘ ESD CAUTION: Measures must be taken to prevent Electrostatic
‘._: N Discharge (ESD) at all times when handling any product, equipment, unit or
part (e.g. use a grounded ESD wrist strap). It should be noted that circuit
boards are at greatest risk to damage from ESD. Please follow standard
ESD precautions!

Electrostatic discharge (ESD), the transfer of static electricity from one object
to another, is an often-unnoticeable hazard to electronic components.
Boards and other devices with integrated circuits are particularly sensitive to
ESD damage. Product failures may not occur until days or weeks after the
component was damaged.

Static damage to units can take the form of upset failures or catastrophic
failures (direct and latent).

An upset failure occurs when an electrostatic discharge is not significant
enough to cause total failure, but may result in intermittent gate leakage,
causing loss of software or incorrect storage of information.

Direct catastrophic failures occur when a unit is damaged to the point where
it is permanently damaged.

Basic Rules for ESD Control

Below are some keys to effectively control unnecessary ESD damage when
working with ESD-sensitive devices:

= Define an ESD protective area and work on the ESD-sensitive devices in
this area only.

= Define static sensitivity of devices to be handled in ESD protective area.

= Establish suitable static control program that limits static generation to
less than the damage threshold of the most sensitive device and
provides a safe, defined path for static charge dissipation.

= Prevent contamination of the protective area by unnecessary non-static
controlled materials.

= Audit the ESD protective area regularly to ensure that static control is
maintained. Document the findings for future reference.
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= Refer to the specific ESD precautions for each component.

Laser Safety

The AL5010 uses visible laser diodes and emits a “moving” red beam. Do
not stare into the AL5010’s exit window at the laser light source. Avoid
unintentional exposure to laser light whenever possible. The laser light level
does not constitute a health hazard, however staring at the laser light for
prolonged periods could result in eye damage.

The following appears next to the AL5010 laser exit window:
WARNING! LASER LIGHT EMITTED FROM THIS APERTURE

Warning on AL5010 Laser Exit Window to Avoid Exposure

WARNING: Use of controls, adjustments, or procedures other than those
specified in this document may result in hazardous laser light exposure.

The AL5010 Line Scanning Bar Code Reader is rated as a Class 1 Laser
Product by the International Electrotechnical Commission. Compliances are
as follows: Class 1 Laser Product (IEC-60825-1) 2007.

Before performing any maintenance or service procedures, perform
the laser shutoff procedure provided in Chapter 7.
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Safety Labels and Locations

Refer to the following figures for specific label locations and warnings. When
operating, repairing, or replacing an AL5010, note all label content on the
unit. These labels provide special precautions for operation, usage
specifications, product identification, and service information.

% WARNING: LASER LIGHT EMITTED FROM THIS APERTURE.

CLASS 1 LASER PRODUCT
(IEC-60825-1 2007)
COMPLIESWITH 21CFR1040.10 AND
21CFR1040.11 WITH DEVIATIONS

PURSUANT TO LASER NOTICE 50
DATED JUNE 24, 2007

Label Placement AL5010 Scan Head
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3 Mechanical Installation

A
Aad

A\

IMPORTANT: The AL5010 contains electronics that may be affected by

electrostatic discharge (ESD). To prevent personal injury or damage to the
unit, please follow the safety precautions and warnings found in Chapter 2.
Failure to follow these precautions may void your warranty.

WARNING: There are no user serviceable parts inside the AL5010. No
internal components of the AL5010 are field replaceable units (FRUSs).
Opening the unit will potentially expose the user to emitted laser radiation,

high voltage, and could reduce the effectiveness of the device’s IP rating.
DO NOT REMOVE the faceplate from the scan head enclosure. Opening
the AL5010 will also void the factory warranty.

Prerequisites

Read all instructions before beginning your installation.
Define and confirm the accuracy of your application’s requirements.
Review all installation-specific drawings.

Review and plan the mechanical installation of all devices used in your
application. Be sure to allow adequate clearance for maintenance.

Review and plan the power requirements for your application.
Check the contents of the shipping cartons against the packing list.

Record all product serial numbers.

Tools Required

5/32” Allen Wrench

10mm Nut Driver or box wrench
Phillips Screw Driver (1 x 80 [#1] )
Tape Measure

Pencil or Marker

Additional Information

See also: Quick Reference Guides for Installation

AL5010 with Basic Interface Module (1000070256)
AL5010 with Enhanced Interface Module (1000070257)
Establishing A Connection to the User Interface (1000070258)

Phone: 800.894.0412 - Fax: 888.723.4773 - Web: www.ctiautomation.net - Email: info@ctiautomation.net

13



Unpacking Instructions

during shipment. Do not throw it away. Save all packing material in case

f IMPORTANT: The AL5010 packaging is designed to protect the unit(s)
you need to transport your unit(s).
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Installation Sequence

NOTE: Everything should be MECHANICALLY INSTALLED before
A performing any ELECTRICAL INSTALLATION. Reference Chapter 4 for

electrical installation details.

Installing a Single Unit

To install a single unit, follow this sequence of steps:

= Complete mechanical installation.
= Review the details of your application’s requirements.
= Determine and mark the reader mounting location.
= Erect mounting frame or other supporting structures.

= Attach the Universal Mounting Bracket (UMB) to the frame.
(UMB and mounting frame options are available from Accu-Sort.)

= |Install the mounting base to the UMB (or frame, if UMB not used).

=  Mount the AcculLazr Basic or Enhanced Interface Module to
structure.

= Mount the Accu-Sort power supply to structure.

= Mount Trigger Photoeye (optional).

=  Mount tachometer (Enhanced Interface Module only).
= Complete electrical installation.

= Install the scan head to the mounting base and wire interface
module. (See Chapter 4.)

NOTE: To reduce the possibility of damage to the scan head, install it after
A the mounting base is mounted, wired, and all wiring checked for accuracy.
=  Setup your reader.
= See Chapter 5.

= Check operations.
= See Chapter 6.

Installing multiple units

To mechanically install multiple units, follow the same sequence of steps, per
reader, as defined in Installing a Single Unit. Your application will define how
the mounting requirements vary for each reader.

Multiple-reader networks may require a different approach to physical
location of the power source, trigger photoeye, and tachometer since they
are most likely being shared by the group of readers.
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Orientation Considerations

Consider the important factors that affect how the reader is oriented in
respect to the barcoded packages (products) and their method of
conveyance.

Mounting the reader for optimum performance depends on these factors:

= Read Range defining the distance (and variations) between the reader
and packages, including the near/far distances, and overall depth of field

= Barcode Orientation on products (ladder or picket fence) as well as the
angle in which codes will appear (skew, pitch and tilt)

= Reader Positioning for type of scanning required to accommodate
picket fence or ladder barcode orientation (yaw, pitch and roll angles)

Read Range

The AL5010 must be positioned in the scanning area to accommodate
reading products over a read range specific to your application. Use the
following diagram to determine the near/optimum/far read distances. These
dimensions result in the overall depth of field your application requires.

Far Py
Distanhce w ~

Depth

/of Field

~

Reference the read charts for
maximum usable beam width.

AL5010
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Barcode Orientation to Scanning Area

Picket Fence or Ladder Orientation Barcode placement usually
determines the AL5010’s positioning. The AL5010 can be mounted to read
codes in either a ladder or picket fence orientation.

3in. (7.62cm)

A 6in.(15.20cm) Picket Fence

=, ML

6in.(15.24 cm) 8 in. (20.32 cm)

Ladder

f
r

8in. (20.32 cm)

-
o

Y

i

J

Y
<— DIRECTION OF TRAVEL —

Picket Fence and Ladder Orientation Illlustrated

Barcode Skew, Pitch and Tilt These angles affect barcode readability.
Barcodes pitched or skewed up to 45 degrees are still readable. Although
some skew may occur, it should not exceed 45 degrees.

Skewed Symbol

Pitched Symbol

Tilted Symbol

No Tilt, Pitch
or Skew
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General Mounting Guidelines

As you plan and install the AL5010 barcode solution for your application, be
sure to keep the following mounting guidelines in mind:

= Determine the proper orientation and position of the reader.
= Leave adequate clearances for maintenance and wiring.

= AL5010 Reader: ~ 1-inch [25 mm]
Required for scan head removal from mounting base.

= Interface Modules: ~ 8-12 inches [203-305 mm]

= Plan mechanical installation based on the application’s electrical require-
ments. See General Electrical Installation Guidelines in Chapter 4.

It is important that you follow all safety precautions when installing, setting
up, operating, maintaining, troubleshooting or replacing any Accu-Sort
products, parts or related equipment. See Chapter 2, Safety.

Reader Positioning: Fixed Laser

IMPORTANT: The AL5010 is able to decode barcodes at a variety of

A angles; however significant angular distortion may degrade reading
performance. When positioning the reader, remember that the scan beam
exits the scan window parallel to the mounting base.

=  When mounting the AL5010, take into consideration your
application’s barcode orientation.

= Mount the reader so that the scan beams will intersect barcodes.

PITCH +15°

TILT .
SEE NOTE 1 SKEW 150

IMPORTANT: To avoid the laser reflecting back onto itself AL5070’s Range of Motion with Universal
and lowering performance, install at a 10-degree skew. Mounting Bracket (UMB)
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Reader Positioning: Adjustable Raster

The Adjustable Raster version (sometimes referred to as “vibrating vein”) of
the AL5010 uses an additional mirror that oscillates to throw the laser over a
configurable area. This extra functionality has all been engineered into the
original AL5010 housing. As the mirror oscillates, the scan line sweeps
across the target surface in application where greater coverage is needed.
Specifically, the AL5010 Adjustable Raster can be configured to sweep up to
20-degrees above or below zero. When an AL5010 with the adjustable raster
feature is installed, the user interface will include a Raster setup screen (see
chapter 5 Setup).

AccuLazr™ AL5010 Adjustable Raster

Up to 20° Adjustable to 20" Up or Down from Zero

The adjustable raster is ideal for pallet scanning or other applications when
the position of the barcode is variable, but scan rate (scans/second) is
decreased because of the oscillation of the mirror. The sweep of the raster
and scanner skew angle is adjusted to get the best coverage over the
probable scan area.
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Raster Setup

The Adjustable Raster version of the AccuLazr™ AL5010 Laser barcode
scanner requires some extra care during installation. The procedures below
will help achieve the coverage needed for your application while ensuring the
maximum read rate.
AL5010 Adjustable Raster Installation
Mount the Scanner
1. Mount the scanner according to specifications.

2. Tilt the scanner back at a 15-degree angle.

4

1 15° back tilt

e =0

Set Up the Raster Sweep
1. Start the user interface (See chapter 5, Setup).

2. In Modify Settings > Barcode, select Code 128. The test barcode
label is a 12 character, code 128.

3. Print out or photo copy the barcode test label sheet found at the end
of this appendix.

4. Place the barcode test labels on a test box.
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5. Position box at nearest read distance to the scanner.

6. Identify the highest and lowest code placement on the side of a box
in your system. Mark the highest and lowest code positions on the

test box.
Ty 1l Wi L

Phone: 800.894.0412 - Fax: 888.723.4773 - Web: www.ctiautomation.net - Email: info@ctiautomation.net



7. Inthe user interface, navigate to Modify Settings > Raster.

8. Type -20 in the Upper Sweep and Lower Sweep text fields.

Raster Scanline

Upper Sweep (-20 to +20 degrees) -20

Lower Sweep (-20 to +20 degrees) -20
Oscillating Frequency (Hz) 5.0
: - +20° $20° ———
— ~m +10°
. | -10°
— B Ty

~ .20° =20° =

\ NOTE: This will stop the raster from
sweeping and lock it in position at the -20

degrees.

9. Adjust the height of the scanner, so that at -20-degrees, the scan
line is aligned with the lowest barcode mark on the test box.

10. With the laser line intersecting the barcode, put the scanner into test
mode using the user interface. To do this, navigate to Diagnostics >
Monitor.

11. On the Monitor screen, click Start Test Mode.

12. Check the read quality on the monitor. The quality should be 100%.
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13. In Modify Settings > Raster, gradually increment your upper and
lower sweep values toward 0%. Try 5% increments first, i.e.: Set
both the Upper Sweep and Lower Sweep to -15, then -10, -5, 0, 5,
and etc. The laser should intersect a barcode at each degree setting.

14. Check the read quality on the monitor at each increment. The quality
should be 100%.

15. Continue incrementing the upper and lower sweep settings until the
scan line reaches or goes just beyond the level of the highest
barcode.

16. In Modify Settings > Raster, set the lower sweep at -20 and the
upper sweep to the value determined in step 15.
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17. Click Update, and then click the Save icon (ﬂ) at the top of the user
interface screen. The laser will begin to sweep between your lowest
and highest barcode indicators.
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Run Test Labels

1. Configure the scanner for your application by setting up
communications, barcode types, triggers and relays as applicable to
your system (See Chapter 5 Setup).

In the user interface, navigate to Diagnostics > Monitor.

Place a test barcode at the front edge of the box in the lowest
position and run the box through the system.

4. Check the Monitor screen to see how the barcode reads. The
quality will likely not be 100%, but it is just important that it reads.

5. Next, place the test barcode at the front edge of the box in the
highest position and run the box through the system.

6. Again, check the Monitor screen to make sure the barcode has
been read.
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7. Continue checking for good reads by placing the label at the back
edge of the box, once in the lowest position and then at the highest
position.

4-0740 i
== - [0
[T

Phone: 800.894.0412 - Fax: 888.723.4773 - Web: www.ctiautomation.net - Email: info@ctiautomation.net



Dimensions and Clearances

The overall dimensions of the AL5010 when the Universal Mounting Bracket
(UMB) is used are shown on the mechanical specification drawings provided
in the drawings folder of the documentation CD. This section also includes

drawings without the UMB.

The reader is a sealed, unventilated unit. No specific clearance is required
for the purpose of cooling. However, ease-of-access should be considered

when locating the mounting position.

NOTE: For installation, maintenance and service reasons, approximately
A 8-12 inches [203-305 mm] of clearance is recommended.

Attaching the Mounting Base
If your application is not using the universal mounting bracket (UMB), mount
the mounting base to any flat surface with the two mounting screws provided.
The length of the screws must not be greater than 0.5 inch [12.7 mm] plus
the thickness of the mounting surface.
Use the following diagram as a reference to create a mounting template.

_520°SCAN __
READ DISTANCE
‘.‘.-"ﬁREFERENCE PLANE
‘ ‘——_:n ,/
- — 1 4 !
e S S S S —E— | ‘.
,__7 ‘ll 7'737 [ 99]
1.96] B r 186 s
s O 5 0 O —
. ‘ ) !
[.85] 1
216 |
1 |
i
y s0] | _|
2X / 12.7
M4X0.7 \ 5[0.20]
» [2.17] |
55

Mounting Base Dimensions (not actual size)
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Attaching the Universal Mounting Bracket (UMB)

The Universal Mounting Bracket (UMB) is an optional accessory that
simplifies reader mounting and installation. Included with the bracket is the
necessary hardware to attach it to the mounting structure.

1. When using this option in your application, follow the assembly
instructions provided with the universal-mounting bracket (UMB).

Attach the UMB to the mounting structure with the provided hardware.

Attach the mounting base to the UMB.
Use the two screws provided with the mounting base.

4. Insert the screws through the UMB into the threaded holes on bottom of
mounting base.

5. DO NOT over-tighten screws. Leave the screws slightly loose to allow for
some movement in the mounting base so that final adjustment of the
reader in relation to scanning area can be made after wiring is
completed.

W
\(® |
\ -
e - T
L), @ |
— e
& e |
|
-__|—_£ - # .
} IR
il i
=

Attaching Mounting Base to Universal Mounting Bracket (UMB)
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Installing an AL5010 Scan Head

Perform the electrical installation as outlined in Chapter 4. Once all wiring is
checked for accuracy, install the AL5010 scan head to the mounting base.
You can install the scan head with or without the power disconnected from
the mounting base.

To install a scan head:

1. Carefully align the scan head (1) alignment tabs to the mounting base.
This automatically assures the correct scan head-to-mounting base
connector alignment.

2. Gently, press the scan head down until it firmly connects with the
connector in the mounting base (2).

3. Tighten the two captive screws to secure the scan head to the base.
Do not over tighten.

4. Adjust the UMB so the reader’s laser exit window faces the approximate
location of where the bar-coded packages will appear.

AL5010 Scan Head Installation on Mounting Base
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Mounting the Trigger Photoeye

The standard photoeye works by bouncing a light beam off a reflector and
detecting when something breaks the path of light. In order for photoeyes to
work properly, make sure the following things are done when mounting the
trigger photoeye option:

= Mount trigger and reflector so the reader’s scan beam does not strike
either of them.

= Mount a reflector directly opposite the photoeye on the other side of the
conveyor.

= Install the reflector within the operating range of the trigger photoeye.

= The photoeye must be mounted so the light exit window is perpendicular
to the conveyor, facing the reflector.

= The reflector must be mounted perpendicular to the conveyor, facing the
photoeye.

= Secure the photoeye and reflector to the mounting brackets with the
hardware provided.

reflector) must be blocked by a package before the barcode is in position
for scanning. The trigger signal should remain active while the symbol is
being scanned. This does NOT apply to tracking applications.

f IMPORTANT: The trigger photoeye’s beam (between photoeye and

PHOTOEYE MOUNTING HOLE

NOTE: The Trigger Photoeye can also be used in a Start/End Trigger
application as the Start Trigger Photoeye. In this instance, an End Trigger

Photoeye Kit (with DC input module) is also required. An End Trigger

photoeye can only be used with an Enhanced Interface Module.
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Mounting the Tachometer

The tachometer (tach) option outputs a set number of pulses for each wheel
rotation. This tells the AL5010 the precise conveyor speed, allowing it to
determine accurate package position. Tracking allows for multiple boxes to
be in the scanning area at the same time. Barcodes on each box are
decoded and assigned to the correct box. Follow the guidelines below:

= Mount the anti-static brush to the tachometer as shown in the drawing
provided with the tach. The anti-static brush provided with the tach must
be installed to assure proper operation.

= Mount the tach on the conveyor section where scanning is performed.

= Mount the tach on the underside of the conveyor, away from areas
where the conveyor bows downward. A good place to mount the tach is
on one end of the conveyor, underneath the drive shaft.

= Make sure the tach assembly angles in the same direction that the
underside of the conveyor travels.

= The tach must make good contact with the conveyor.

= Use the general mounting kit provided with your system to make
tachometer mounting and setup easier.

——

CONVEYOR DIRECTION

.
o T3

-
Pt
-

2.00[50.8]
APPROX.

LOAD TACH ASSEMBLY
SPRING TO 25% OF
TOTAL MOVEMENT.

10.87
[276.1]

|

13.00 [330.2)

.00 [152.4) 4.50 [114.3]
-
328[83] u i
sLoTs i 75 [19.1]

66 [16.8]— 3.03[76.9]

1.50 [38.1] —

281[714)

Tachometer Mounting (anti-static brush not shown)

Tachometer with Anti-Static Brush Installed
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Mounting the Interface Modules

Mechanical installation sequence for AL5010 with either the Basic or
Enhanced Interface Module:

1. Determine the location of the scanning system at the installation site.
2. Erect the mounting frame or other supporting structures.
3. Mark the mounting locations for each:

a. AL5010 Reader

b. Basic or Enhanced Interface Module

4. Attach the Universal Mounting Bracket(s) (UMB) to the frame.
(UMB and mounting frame options are available from Accu-Sort.)

5. Attach the AL5010 Mounting Base to the UMB (or frame, if UMB not
used).

Mount the Basic or Enhanced Interface Module. (See below.)
Mount the Accu-Sort power supply.
Mount the Trigger Photoeye (optional).

© © N o

Mount the Tachometer (optional).
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To mount the Basic Interface Module:

1. Position the basic interface module in the desired mounting position.
(Position the cord grips so they are face down or to the side.)

2. Using a Phillips screw driver, attach with the supplied mounting

hardware.
136.4
[5.37]
6.2 124
[.24] ‘ [4.88]

92.5
[3.64]
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To mount the Enhanced Interface Module:

1. Position the basic interface module in the desired mounting position.
(Position the cord grips so they are face down or to the side.)

2. Using a Phillips screw driver, attach with the supplied mounting

hardware.
. 1914 _
i [7.54] o
6.2 | 179
.24 | ' [7.05]

£ Trcsen 59
o] [2.32.
o ¢ 123.9
o 14.88]
0
_

i 8 v e e
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Mounting the 1/0 Modules
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e

The Enhanced Interface Module supports four (4) optional input or output

I/0 MODULE APPLICATIONS modules that can be used for trigger inputs or to operate diverters, alarms,
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To install your optional I/0 module(s):
1. Remove the cover to gain access to the printed circuit board.

2. The I/O modules may be plugged into locations 1/O 1 through 1/O 4.
These locations run left-to-right, as shown on the circuit board
silkscreen.

3. Plug the appropriate 1/0 module directly into the interface module’s
circuit board.

4. Using a screwdriver, secure the I/O module by tightening the captive
screw (that goes through the module) into the circuit board. DO NOT
over-tighten screw.

Installing an I/O Module
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AcculLazr™ AL5010 Product Line Manual Electrical Installation

4 Electrical Installation

/N
A

)
A

WARNING: Electrical Installation by Qualified Service Technicians
Only! Several procedures involve exposure to voltage inside the interface
module. A trained technician must perform these procedures. Do not
attempt to perform any electrical installation procedures unless you are a
trained technician.

WARNING: There are no user serviceable parts inside the AL5010. No
internal components of the AL5010 are field replaceable units (FRUSs).
Opening the unit will potentially expose the user to emitted laser radiation,
high voltage, and could reduce the effectiveness of the device’s IP rating.
DO NOT REMOVE the faceplate from the scan head enclosure. Opening
the AL5010 will also void the factory warranty.

IMPORTANT: The AL5010 contains electronics that may be affected by
electrostatic discharge (ESD). To prevent personal injury or damage to the
unit, please follow the safety precautions and warnings found in Chapter 2.
Failure to follow these precautions may void your warranty.

Prerequisites

Before mounting any components, please do the following:

= Read all instructions before beginning your installation.

= Define and confirm the accuracy of your application’s requirements.

= Review the standard electrical wiring drawings provided in Appendix F.
= Review all installation-specific drawings.

= Review and plan the power requirements for your application.

= Review and plan the communications requirements for your application.

Tools Required

= Phillips Screw Driver (#1)

= Flat Head Screw Driver (small)
= Wire Cutters

= Wire Strippers

= Needle-nose Pliers

Additional Information

Phone: 800.894.0412 - Fax: 888.723.4773 - Web: www.ctiautomation.net - Email: info@ctiautomation.net

See also: Quick Reference Guides for Installation

= AL5010 with Basic Interface Module (1000070256)

= AL5010 with Enhanced Interface Module (1000070257)

= Establishing A Connection to the User Interface (1000070258)
= Getting Started with the User Interface (1000070259)
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Installation Sequence(s)

NOTE: Everything should be MECHANICALLY INSTALLED before
A performing any ELECTRICAL INSTALLATION. See Chapter 3 for

mechanical installation details.

Installing a Single Unit

To install a single unit, follow this sequence of steps:

= Complete mechanical installation.
= See Chapter 3.

= Complete electrical installation.
= Ground the mounting structure to protective earth (PE) ground.
= Connect AL5010 reader to interface module (two connections).
= Connect Ethernet network to interface module.
= Connect the power supply to interface module.
= Connect trigger to interface module.

= Connect tachometer to interface module (Enhanced Interface
Module Only).

=  Connect serial communications to interface module.

= Connect wiring for I/O module(s) to interface module (Enhanced
Interface Module Only).

= Install Fieldbus if needed- DeviceNet or Profibus (Enhanced
Interface Module Only).

= Attach scan head to mounting base.
NOTE: To reduce the possibility of damage to the scan head, install it after
A the interface module is mounted, wired, and all wiring is checked for
accuracy. Be sure to perform the polarity check before attaching the scan
head.

= Setup your AL5010.
= See Chapter 5.

= Check operations.
= See Chapter 6.
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Installing Multiple Readers

For electrical installation, multiple-reader networks will require a different
approach to wiring, since the trigger photoeye and tachometer are most likely
being shared by the group of readers.

(See drawing 113492 in Appendix F.)

Special instructions for functional set-up of a multi-reader network are
provided in Chapters 5 and 6.

NOTE: If Tracking, Fieldbus and/or I/O Modules are not needed, an
Enhanced Interface Module is not required.

AL5010

ENHANCED
INTERFACE
MODULE

BASIC
INTERFACE
MODULE

BASIC
INTERFACE
MODULE

ETHERNET
SWITCH

+ HOST

Multiple Readers with EtherNet Communications

AL5010 AL5010 AL5010

ENHANCED
INTERFACE
MODULE

BASIC
INTERFACE
MODULE

BASIC
INTERFACE
MODULE

ETHERNET
SWITCH

SERIAL
HOST

Multiple Readers with Serial Communications
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AL5010

AL5010

ENHANCED
INTERFACE
MODULE

Photoeye

ETHERNET
SWITCH

Tachometer

Multiple Readers with a Single Interface Module

General Electrical Installation Guidelines and Precautions

It is important that you follow these general precautions when installing,
setting up, operating, maintaining, troubleshooting or replacing any Accu-Sort
products, parts or related equipment.

CAUTION: The AL5010 use lasers for bar code scanning. Do not view
directly with optical instruments (binoculars or telescopes). Avoid
unintentional exposure to laser light whenever possible.

As you plan and install your AL5010 bar code solution application, be sure to

keep the following guidelines in mind:

= Determine the reader is in the proper orientation and position as outlined
in Chapter 3.

= Leave adequate clearances (approximately 8-12 inches [203.2-
304.8mm]) for wiring.

= The interface modules have several cord grip openings. Seal unused
openings with rubber grommet plugs (units ship with rubber plugs in
place). Remove the grommet plugs when inserting cables. Use cord
grips with rubber grommets on cables that enter the interface module.

= Route wires carefully to reduce or minimize electrical noise. The
interface modules are designed so power and communication wiring
should not need to cross.

WARNING: To assure no ESD damage will occur, be sure to observe the
‘Z N precautions outlined in Chapter 2, Safety.
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Cable and Cord Grip Connections

Determine the wiring connections needed for your application. All permanent
connections are made to the basic or enhanced interface module with either
cables or through cord grips. Be sure to follow Accu-Sort’s wiring
recommendations.

Wiring Recommendations

Connection Recommended Wiring Type Max. Length
Safety Earth For 15-20 Amp branch circuit, use #18 AWG min.
Ground For 16-25 Amp branch circuit, use #14 AWG min.

For 26-32 Amp branch circuit, use #12 AWG min.
Power #20 AWG minimum
RS232 #24 AWG minimum 50’ [15.2]
RS422 #24 AWG minimum 1000’ [300]
Ethernet #24 AWG CATS5 UTP (unshielded twisted pair) 330’ [100]
Tach / Trigger #24 AWG minimum
I/O Modules Depends upon module rating. See Appendix A.

NOTE: ALL external wiring must be UL listed or recognized rated VW-1 or FT-1 and
conforming to NEC ANSI/NFPA 70.

Cord Grips Recommended Wiring Diameters

Small Diameter Accommodates 0.138 to 0.276 inches (3.5 to 7.0 mm)
Large Diameter Accommodates 0.177 to 0.394 inches (4.5 to 10.0 mm)

Cable Connections to Interface Module

=  Where the cabling enters the interface module, use the supplied cord
grips with rubber grommets.

= Once all cabling is completed, plug all unused interface module
openings.

IMPORTANT: All unused openings must be plugged to maintain the
Interface Module’s IP54 rating.

Proper Wiring to Terminal Blocks inside Interface Modules

1. If necessary, strip the insulation off the end of wire approximately 1/4”
[6,35mm].

2. Use flathead screwdriver to push the spring-cage terminal block open
until it stops.

3. Insert wire into terminal opening.
4. Allow the screwdriver to release the spring-cage terminal block.
5. Confirm the wire is held firmly in place.

Wiring the AL5010 Interface Modules

After completing mechanical installation, use this section to properly wire
your AL5010 reader for optimal performance in your application. All wiring
connections are made via a basic or enhanced interface module.

Use the conduit openings for running wires into the interface module. Route
your cabling for power, tachometer, trigger, communications, and I/O through
the recommended conduit openings.
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Basic Interface Module
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Wiring tables, printed on the interface module, help simplify installation.
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Basic Interface Module Terminal Block Locations

See also: Drawing 113491 in Appendix F.
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Electrical wiring sequence:

1. SCANNER - Mounting base Cable Jacket Stripping Strip All Wires
(two connections, 15-pin ‘D’ and RJ-45)

2. ETHERNET - Host (Network)

4. TRIG — Trigger 31/2” 1/4”

5. POWER - Power supply or user-supplied 2 3/4” 1/4”

Wiring Installation Sequence (Connection Panel)
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Wiring Installation Sequence (Circuit Board) and TB Wiring Tables
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Enhanced Interface Module
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Wiring tables, printed on the interface module, help simplify installation.
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Enhanced Interface Module Terminal Block Locations

See also: Drawing 113490 in Appendix F.
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Electrical wiring sequence:

1. SCANNER - Mounting base Cable Jacket Stripping Strip All Wires
(two connections, 15-pin ‘D’ and RJ-45)
2. ETHERNET - Host (Network)
4. FIELDBUS (DeviceNet or Profibus, optional) 4 3/8” 1/4”
5. TRIG - Trigger 31/2" 1/4”
6. TACH — Tachometer 314 1/4”
7. POWER - Power supply or user-supplied 2 3/4” 1/4”
8. 1/0 1 through I/O 4 - I/O module(s) (optional) 21/2” 1/4”
Wiring Installation Sequence (Connection Panel)
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Wiring Installation Sequence (Circuit Board) and TB Wiring Tables
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Power Requirements

IMPORTANT: When planning your installation wiring, remember all power

A connections must be quick-disconnect. For PERMANENTLY CONNECTED
EQUIPMENT (i.e., AL5010 using DC power) a readily accessible
disconnect device must be incorporated in the building installation wiring.
For PLUGGABLE EQUIPMENT (i.e., AL5010 using AC power supply with
non-detachable power cord), the socket-outlet must be installed near the
equipment and must be easily accessible.

Power Supply Connections

CAUTION: Follow all safety procedures regarding high-voltage as outlined
in Chapter 2, Safety. No power should be applied to any device until all
wiring is completed and checked for accuracy.

REMEMBER: The socket-outlet must be installed near the AL5010’s
power supply. The outlet must be a readily accessible disconnect device.

Using Accu-Sort Power Supplies

Single Reader The AL5010 reader requires 25 watts (maximum) of power.
The Accu-Sort power supplies are IP54 rated for industrial environments.
The supply includes a power cord for either 125V or 230V applications.

1. Locate the POWER terminal blocks on the interface module.

2. Connect the power supply wiring to the terminal blocks as shown below.
3. Make sure wiring cannot come loose from the terminal blocks.

4. Properly tighten the cord grips.

o [110-28Y e " POWER
Ww | - |l —mack i
g B MW syppLy
Fn i
O oy | (5 GREEN
(8 \_L\_\ r"‘"-
,

Multiple Readers When a multiple reader application uses Accu-Sort power
supplies, each AL5010 is powered by a separate power supply. DO NOT
connect power supplies in parallel. (See drawing in Appendix F.)

Power Connections Using Other Power Supplies

IMPORTANT: All non Accu-Sort power supplies, whether for single or
multiple reader applications, must be an LPS or Class 2 power supply. The
supply must provide 25 watts (10-28 VDC) of power to each AL5010.
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Trigger Connections

The AL5010 supports three trigger modes: hardware, software, and
* continuous. When using hardware trigger, one or more input signals “trigger”
the reader. Software trigger is accomplished by sending a specific ASCII

message via serial or network communications. Continuous trigger requires
no external trigger.

When a hardware trigger (i.e., package detector) is required, Accu-Sort’s
retro-reflective photoeye (PN 100020569) is recommended.

Wiring Trigger to the Enhanced Interface Module

Connect trigger wiring to the interface module terminal blocks.
Wire the Accu-Sort photoeye as shown below.

JUMPER ACCU-SORT STANDARD NPN PHOTO EYE JUMPER ACCU-SORT STANDARD NPN PHOTO EYE
SETTING SETTING
[TRIG - T0  OUT) VOouT| (5 (TRIG = TOW OUT) VOUT | [ —nen—
) TRIG +| ()
o llEs | o {0 o llEr [ o]
o | TRIG -| (S{—wm=—| IZ | TRIG -| (Sf——wrire-
OE E4 |+ £ 31 plack—] OFF - E2 |+ —4— i:} BLACK
on [l 36 - (:e__mﬂbJ on [ E14 i e E—
JUMPER CUSTOMER OPTION PNP PHOTO EYE JUMPER CUSTOMER OFTION PNF PHOTO EYE
SETTING SETTING .
[TRIG - TO GHD) vouT| (= (TRIG - TO G VOUT| | ——nFo—
Cinn TRIG +] (| wre
OFF E3 | o RGN "““L oFF [0 o] E1 [ @ |
— 0O = |TRIG-| ()
e me O T O
S 2 ey o on[lllE2 |F| L o sa—
ON- E36 o | O—smew ON - E14 o, | (s
JUMPER CUSTOMER OPTION DIFFERENTIAL JUMPER CUSTOMER OPTION DIFFERENTIAL
SETTING vour O SETTING vour| O | | b
TRIG + ’A—I 7N TRIG+| ( TN
OFF E3 9 ?: | 16-28vDC OFF |0 | E1 Q = | 0asvoc
T | TRIG-| (= \\ F |TRIG -| (2 \ ya
= = P = — W
OFF E4|F[ L0 oFF [0 0| E2 10 T
on [ €36 & |G sHeLD on [l E14 e SHIELD
NOTE: REMOVE E36 TO INCREASE MINIMUM TRIGGER LEVEL TO NOTE: REMOVE E14 TO INCREASE MINIMUM TRIGGER LEVEL TO
APPROXIMATELY 7 VDC APPROXIMATELY 7 VDC
Enhanced Interface Module Basic Interface Module

In applications using a photoeye other than the Accu-Sort standard, follow
the TRIGGER wiring table to assure proper wiring. The trigger must be able
to operate using the +24V DC source (24V) and not draw more than 100mA.
The trigger input must be able to sink (or source) 10mA at +24V DC.

NOTE: To confirm the Trigger photoeye is functioning properly, watch the
A Trigger LED while the photoeye’s beam is blocked. (See Chapter 5 for
details.) The Accu-Sort photoeye also includes a status LED.

Multiple Readers In controller/client applications, wire the trigger photoeye
to the AL5010 set up as the controller. (See drawing in Appendix F.)
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Tachometer Connections

In applications where product tracking is required, a tachometer is typically
used. When a tachometer is required, the Accu-Sort tachometer is
recommended. Connect the tachometer wiring to the interface module
terminal blocks.

Wiring Tachometer to the Enhanced Interface Module

JUMPER ACCU-SORT STANDARD NPN TACHOMETER
ﬁf;,'fﬁ"o"‘jm VOUT | (34—rep
ON - E5 5 TACH +{ ()
TACH - (3 WHITE
Lo E6 ﬂ:' =L :’:‘j BLACK:
\—l:—\' i-:} SHIELD
JUMPER CUSTOMER OPTION PNP TACHOMETER
(raf:ﬁnrfum VouT| (3 e
OFF E5 6 TFAEH + IETE&— WHITE——
a ACH - ()
ON - E6 - J:_ C, . BLACK
o [ SHIELD

WARNING: The maximum tachometer current should not be more than
0.3 amps @ 24 volts.

If your application uses a tachometer other than the one available from Accu-
Sort, follow the TACH wiring table to assure proper wiring.

Multiple Readers In controller/client applications, wire the tachometer to
the AL5010 set up as the controller. (See drawing in Appendix F.)
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Serial Communications Connections (COM1 and COM2)

The interface module provides an RS232/RS422 terminal block for serial
point-to-point communications. Typically, network communications will use
Ethernet.

R$422 HOST COMMUNICATIONS
COM10R COM 2 [ene

422 RX-| (31— HOST TX-
422 RX+| (39— HOST TX+
422 TX-| (21— HOST RX-

A
™y

422 TX4 (31— HOST RX+
i
22RX| )

227X ()

L | (3+—= SIGNAL GND

L | (3}—= cHassis GnD

R$232 HOST COMMUNICATIONS
COM10ORCOM2 R$232 HOST COMMUNICATIONS
422 RX{ () __com1
22 O 232 RX| (S-—— HOST TX
A 232 TX| (S+—» HOST RX
. L | (% —» SIGNAL GND
422 TX+ () ==
o | (3—> CHASSIS GND
232 RX| (#}—— HOST TX
oy » NOTE: RECOMMEND CABLE TYPE
Ll ‘\—_J UL ALPHA 5473C OR EQUIVALENT
L | (%}—» SIGNAL GND
ooy | (33— CHASSIS GND R$422 HOST COMMUNICATIONS

COM 2
NOTE: RECOMMEND CABLE TYPE 422 RXA /"\1 HOST TX-
ALPHA 5473C OR EQUIVALENT —

A22 RX4 (9H—— HOST TX+
422 TX-| (S5+—» HOST RX-

422 TXH C}—p HOST RX+

JUMPER SETTING

%’: . COM 1 RS422 TERMINATING RESISTOR

JUMPER SETTING

E13. COM 2 RS422
ON TERMINATING RESISTOR
£2s . COM 2 R$422 TERMINATING RESISTOR

ON NOTE: RECOMMEND CABLE TYPE
ALPHA 5473C OR EQUIVALENT

Enhanced Interface Module Basic Interface Module
Serial Communications Wiring (RS232/422)

RS232 Connections

Use RS232 for a direct connection to a controller, personal computer, or
other device. RS232 provides point-to-point communications at distances up
to 50 feet (15.2 meters). If longer cable lengths are needed, use RS422.
RS232 connections are made to the COM1 and COM2 terminal blocks.
Follow the SERIAL COM / RS232 wiring table to assure proper wiring.
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IMPORTANT: Before attempting to use RS232 communications with
RTS/CTS, contact Accu-Sort Customer Service for additional information.

RS422 Connections

Use RS422 for a direct connection to a controller, personal computer, or
other device. RS422 provides point-to-point communications at distances up
to 1000 feet (300 meters). RS422 connections are made to the COM1 and
COM2 terminal block. Follow the SERIAL COM / RS422 wiring table to
assure proper wiring.

Line Termination The end devices on an RS422 point-to-point connection
must be terminated. A termination resistor is pre-installed in the interface
module. The HOST end of the connection must also be terminated using a
120-ohm resistor between the RECEIVE+ and RECEIVE- terminals.

Ethernet Communications Connections

Use Ethernet for network/host communications or multiple-reader networks.
Ethernet communications cabling can be run up to 330 feet (100 meters).
Ethernet connections are made to the Network connector on the Interface
Module’s connector panel.

—1IN

ANV Yl V'

l®]

e— B
® |5

Ethernet Connections to Basic Interface Module

'g NOTE: To simplify network installations, Accu-Sort offers these options:

= CAT 6 network cables (7 and 15 ft. lengths)
» a 5-port Ethernet switch (dual speed 10/100) and
= an 8-port dual speed Ethernet switch (10/100).

Multiple Readers Most multi-reader applications will use Ethernet or
EtherNet/IP communications. See drawing 113492 in Appendix F for wiring
details.
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1/0 Module Connections

The Enhanced Interface Module supports up to four (4) optional input or
output (I/0O) modules. The modules listed in the table below may be used.
These modules function like switches; they do not supply a voltage.

(See Appendix A.)

Connect I/O wiring to the correct terminal blocks. When using DC modules,
observe the polarity of the connections illustrated on the circuit board.

101 102 103 104
o SR o CR o SR o SRE
) Y i ™y
UL - S .o s md L.‘___/

TES TE& ™ TR&

B H[BHEE A8 HA
~ st ~ -~

g 8l g9 e legs

1/0 Module Wiring

Available /0 Modules for use with AL5010

Part Number Description Color Rating Current Range
1000056135 DC Input Module white 3.3t032VDC 32 mA
1000056136 DC Output Module red 31060 VDC 3 Amax. *
1000056137 AC Output Module black 12 to 42 VACPeak 3 Amax. *

also meet the requirements for Class 2.

NOTE: Relay modules are only for connection to SELV, LPS power source and shall
A * Derate 33mA/deg above 25C.

See also: Drawing 113490 in Appendix F.
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Output Module Application

Shown below is a typical output module application. When connecting high
impedance loads, you may need to add a resistor in parallel with the load.
This resistor (typically 300 to 6,000 ohms) provides a continuous minimum
current flow (10 mA DC or 50 mA AC) through the output module in the
closed state.

Fuse Load
Recommended |

Output Module TB
+

Optional Resistor

()
N\

AC or DC Source

Optional Resistor for High Impedance Loads

Back Electromotive Force (EMF) is sometimes generated when an
inductive load is switched off. Back EMF may damage the output module. A
diode in parallel with the inductive device dissipates the back EMF.

Inductive [_

Fuse | Load

Recommended

Output Module TB

+ } /\.

Optional Diode

O
DC Source

Optional Diode to Dissipate Back EMF

An example output module application is the use of a Stack Light. The
AL5010 would use three output modules to send signals to the stack light to
visually indicate specific conditions (e.g., green = read, yellow = multiple
codes, red = no read). (See drawing in Appendix F.)

Input Module Application

Input module 1000056135 is most often used for an End Trigger Photoeye
application. (See drawing 113490 sheet 3 in Appendix F.)

NOTE: Any other input module application requires custom software.
A Contact Accu-Sort Customer Service for more information.
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DeviceNet

DEVICE NET COMMUNICATIONS

FB1
FB2
FB3
FB5
FB6
S1
S2

™

—» CAN HIGH

—» CAN LOW

| » V-

—» V+

FIELDBUS

Poolplplollp

—™ CHASSIS GND

Profibus

PROFIBUS COMMUNICATIONS

FB1 —» A LINE

FB2
FB3
FBS
FB6
S1
s2

th

— B LINE

—» RTS

—» BUS GND

—» +5V BUS

1

—» CHASSIS GND

FIELDBUS

PIPIPLP PPy

Connecting the AL5010

Once all wiring is completed and checked for accuracy, connect the AL5010
Reader’s cable connections to the Interface Module. (See Wiring the
Interface Modules in this chapter.) You can install the scan head with or
without the power disconnected from the interface module. (See Installing the
Scan Head in Chapter 3.)
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Wiring to the AL5010 without an Interface Module

s @5 | =g
(0] xZ | xZ
cABLE| INSULATION |22 PZ | PZ | wire
A o o
NO. COLOR _ |0%| DIM™W" ol | o5 | NAME) (WIRE FUNCTION)
(SOLID/STRIPE) % zZs | 2=
i ZW | Zw
= OkE | Ok
[&] (8]
WHT/ORG 24 1 ETXP Ethernet Transmit (TX)
CABLE ORANGE 24 2 ETXN Ethernet TX Compliment
ITEM2| WHT/GRN |24 3 | ERXP Ethernet Receive (RX)
GREEN 24 ] ERXN Ethernet RX Compliment
WHT/BLUE 24 | COMZRXP| R5422 Interface Box RX [Scan Head TX]
BLUE . A =1 e COM2ZRXN|RS422 Interface Box /RX [Scan Head /TX]
WHT/BRN |23 7 3:122 2 COM2TXP | RS422 Interface Box TX [Scan Head RX]
BROWN b b SN I 7 COM2TXN |RS5422 Interface Box /TX [Scan Head /RX]
WHT/GRY 24 3 COM1TX | RS232 Scan Head TX [Interface Box RX]
GRAY 24 8 COMIRX | R5232 Scan Head RX [Interface Box TX]
WHT/YEL 24 4 TACHP Tachometer Input
?T»ﬁEE:\Iﬁ YELLOW 24 9 TACHN Tachometer Return
WHT/PUR 24 5 TRIGP Trigger Input
PURPLE 24 10 TRIGN Trigger Return
FINK 22 11 VDCIN DC Power Supply Input
WHT/BLK 22 6112.4] 12 GND DC Power Supply Retumn
RED 22 ' 13 VDCIN DC Power Supply Input
BLACK 22 14 GND DC Power Supply Return
UNINSULATED | 20 |12 AND CASE, DRAIN Safety Ground

AL5010 Pin-Out Table

See also: Drawing 113493 in Appendix F.
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Check Installation

After completing the installation of your AL5010:

Confirm that the reader has been properly installed mechanically and
electrically. Use the Installation Sequence at the beginning of this
chapter and your application specifications to check your installation.

Configure the reader’s parameters to meet the needs of your application.
(See Chapter 5 and online help for details.)

See Chapter 5 and 6 for details regarding first-time startup and an
operations checklist.

Check installations using Basic Interface Module:

1.
2.

B

Apply power to the interface module.
Check the following:
=  Power ‘on’ (POWER LED)

= Trigger photoeye operation (TRIGGER LED)
Finger-tighten all water-tights.

Install cover.

Tighten four Phillips screws.
Do not over tighten.
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Check installations using Enhanced Interface Module:

1.
2.

Plug in the power supply.
Check the following:

3. Power ‘on’ (POWER LED)
= Trigger photoeye operation (TRIGGER LED)
= Tachometer operation (TACH LED)

= Serial communications, receive data
(RX1, RX2 LEDs)

= Input Relay (if applicable, I/O 1 LED).

4. Finger-tighten all water-tights.
Install cover.

6. Tighten four Phillips screws.
Do not over tighten.
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5 Setup

Getting Started

The AL5010 line of laser bar code readers is designed for ease-of-setup,
allowing you to program a reader to fit your application seamlessly.

AcculLazr" User Interface for AL5010 is a browser-based application. It is
the tool you will use to define operating parameters, determine bar code read
quality, and construct output messages, including filtering, stripping and
padding capabilities. AccuLazr User Interface enables you to easily
configure, fine-tune, and monitor your AL5010’s operations.

Acculazr User Interface provides ease-of-use for any operator level. A
beginner operator follows basic setup procedures for a standard
configuration. More experienced operators may use the advanced setup
features that allow access to more complex options.

Prerequisites
Before setting up your AL5010 will need the following:
e Computer: Laptop or desktop

» Browser: Internet Explorer 7 or Firefox 3.6 (or later)
» Java: Version 6.0.210 (or later)
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Starting the AcculLazr User Interface

To start the AccuLazr™ User Interface software in the Windows
environment:

1. Open your web browser and enter the IP address for your AL5010 unit. If
the correct IP address is entered, the AL5010 Login screen will appear
(If you don’t know the IP address, see Discovering the IP Address in
Chapter 8.)

The default IP address is: 192.168.3.100
2. Enter the User ID and Password for your system in the fields provided.

3. Click Log On. The Home screen appears.
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AcculLazr User Interface Basics

AcculLazr™ User Interface Menu Tree . Modify Settings

The functions that you can select are displayed Configuration

in a navigation list on the left—-hand side of the Bar Codes
AccuLazr™ User Interface. The function list is Modulo Checks
organized much like the hierarchy of a file Srinping/Paddin
system, where you can expand items that begin i 9
with a plus sign (+) to further sub—levels until SSich:Codes

you find a function of interest. = Serial Communications
Sub-levels appear indented below the items o d il
from which they are expanded. ltems that are Serial Port 2
expanded are preceded by a minus sign (-). Network

You can expand no further when an item Trigger

displays neither a plus or minus sign. Relay

The AccuLazr™ User Interface menu tree Tracking
appears with no items expanded. Click the FAST Monitor

folders to display the active window for the
setup function and/or expand the folders to
view any additional setup features.

Advanced
Raster
Save/Retrieve
- Diagnostics
Monitor

Log Viewer

Update Firmware

Getting Help

AccuLazr™ User Interface provides complete online help.
To display help for a current window:
Choose Help Index from the Help drop-down menu or press the 0 icon at

the top of the screen. A help window appears, providing you with information
and an index of topics associated with the current application window.

Click on a topic of interest to display more detailed information.

You can use the menus or buttons in the help window to navigate to other
topics of interest, or from the File menu in the help window, you can choose
Exit to quit from Help.
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Modify Settings

Use the Modify Settings menu tree selections during initial setup to configure
your AL5010 Laser Bar Code Reader. If necessary, you can later make
modifications to the reader’s configuration using the same menu selections,
including:

»  Configuration

» Bar Codes / Bar Code Groups
*  Modulo Checks

»  Stripping and Padding

* Match Codes

» Serial Communications

*  Network Communications

* Message Definitions

» Trigger
* Relay
* Tracking

e FAST Monitor Setup
» Advanced Settings

» Raster
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Modify Settings > Configuration

Use Configuration to identify and configure an AL5010 bar code reader. This
includes access to reader information as well as configuration options (scan
rate, control panel and network access).

To set the reader Configuration:

1. Click in the Reader Name entry field and enter a unique reader name up
to 15-characters in length. Use of unique reader names is especially
useful in multiple scanner applications.

Adjust the scan rate, if necessary.

Enable Trigger/Track Controlled Laser, if required by your application.
Set the Units of measure for either ENGLISH or METRIC.

Assign a unique Username and Password.

Click Update.

o a0 &~ DN

reader performance. Do not change the scan rate unless

CAUTION: Changing the scan rate can adversely affect
A instructed to do so by Accu-Sort Technical Support.

See also: Modify Settings > Configuration in Appendix C.
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Modify Settings > Bar Codes

Use Bar Codes to define the symbologies the AL5010 should read for your
application. Modulo check verification within a bar code can also be
specified. Create bar code groups, if needed.

Bar Code Groups

When more than one bar code type is in the Selected Symbologies list, the
Bar Code Groups tab is available. This enables you to define the valid
“groups” of bar codes that are to be transmitted together.

For example, in the Modify Settings > Bar Codes, Bar Code Group tab
shown here, the reader is configured to transmit EITHER:

» Group 1: a code 128 bar code, or

* Group 2: both an Interleaved 2 of 5 code and a Code 39 code.
(  Barcode Y Fliters ] Bar Code Group |

Groups Interleaved
Nor . Code 128 TTERSC) code 39

1=

o w o

W

L]

B

[l

10
i
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HOERTTEN TN TR T
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WCH N

To add a bar code using Learn Bar Code:
1. Click Learn. The Bar Code Learn screen is displayed.

2. Hold the bar code (as illustrated in the user interface) within the reader’s
depth of field. The reader will attempt to read the bar code for three
minutes to 'learn' all codes in the scan line. After three minutes, the
reader will stop the learn operation. If necessary, click Cancel Learn to
stop Learn Bar Code.

NOTE: When one code is in the scan line, it must be saved
‘@ after Learn before another code can be “Learned.”

3. Once the reader has finished ‘learning’ it displays a list of all codes
including the code data.

4. If no codes are found within three minutes, the Learn Bar Code function
will end.

5. Use the checkboxes to select any of the codes learned to the Selected
Symbologies list.

Click ‘Add’. The codes will be added to the Selected Symbologies list.

NOTE: The reader can learn multiple bar codes appearing in
the scan line at the same time.
REMEMBER: These 'learned' codes that are added to

Selected Symbologies will only be added to the reader's
functional parameters after clicking Update. Use the Save to
Reader function (found on the Save/Retrieve screen) to save
the parameters for continuous use.
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To add a bar code manually:
1. To add a bar code, go to the Modify Settings > Bar Code screen.

2. Be sure you know the parameters for the symbology you are adding to
your active list.

Select the symbology from the Code Type drop-down list.
Assign a unique Code Label, if necessary.

Define the minimum and maximum code length.

Define the minimum and maximum quantity.

Select the Modulo Check.

Enter a Filter, if required.

© ® N o o bk~ w

Click Add. The code added will appear in the Selected Symbologies list
highlighted in yellow.

10. Click Update.
To edit a bar code:
1. To edit a bar code, go to the Modify > Bar Code screen.

2. Select an option button to highlight any Symbology listed under Selected
Symbologies that you want to edit.

3. To change any of the settings (e.g. Code Label, Min/Max Length,
Min/Max Quantity, Modulo Check, Extension), click in the field and make
the required changes.

4. Click Update and then click the save icon (::ﬂ)
To move a bar code:
5. To move a bar code, go to the Modify > Bar Code screen.

6. Select an option button to highlight any Symbology listed under Selected
Symbologies that you want to move.

7. Click Move Up to move the selected bar code toward the top (beginning)
of the list.

8. Click Move Down to move the selected bar code further back (toward
the end) of the list.

9. Any changes are highlighted in the list.
10. Click Update and then click the save icon (::ﬂ)

NOTE: Bar code data is transmitted in the order that they
‘@ appear in the Selected Symbologies list.

To remove a bar code:
1. Toremove a bar code, go to the Modify > Bar Code screen.

2. Select an option button to highlight any Symbology listed under Selected
Symbologies that you want to remove.

Click Remove to delete the selected bar code from the list.
4. Click Update.
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To create a bar code group:

1. Go to the Bar Code Groups tab.
(This tab becomes available when two or more codes are available
under Selected Symbologies.)

2. Create Group 1 by clicking the checkbox for the codes to be included in
the group.

3. Create any additional groups required.
4. Click Update.

See also: Modify Settings > Bar Codes in Appendix C.
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Modify Settings > Modulo Checks

Use the Modulo Checks screen to setup the user defined modulo checks for
any bar code symbologies that you have specified need them. If you selected
a User Defined Modulo Check while in the Modify Settings > Bar Codes
setup screen, you will need to define it on the Modulo Checks screen.

To set a user defined modulo check for a bar code:

If a bar code requires a User Defined Modulo Check as defined on the Bar
Codes page, go to the Modify Settings > Modulo Checks page.

1. Find the correct modulo check row (i.e., User Defined 1 through 5) for
the code.

Set the Factor.

Set a Divisor.

Select Remain, if required.

Select Right, if required.

Select Wrap, if required.

Repeat as necessary for all codes with a user defined modulo check.
Click Update.

® N o g bk 0w Db

See also: Modify Settings > Modulo Checks in Appendix C.
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Modify Settings > Stripping/Padding

For each symbology type (defined in Modify Settings > Bar Codes),
stripping and/or padding of the bar code data can be specified. This stripping
and padding is applied to the bar code before any message formatting.

NOTE: Character stripping is applied before character
‘@ padding.

To set the character stripping for a bar code:

1. Select the bar code from the Available Bar Codes drop-down list.
2. Click on the required character stripping option.

3. Proceed to character padding if required.

4. Click Update when finished.

To set the character padding for a bar code:

5. Select the bar code from the Available Bar Codes drop-down list.
6. Click on the required character padding option.

7. Make the necessary entry based on the padding option selected.
8. Click Update.

See also: Modify Settings > Stripping/Padding in Appendix C.
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Modify Settings > Match Codes

Use Modify Settings > Match Codes to define a specific code pattern within
a symbology type that is to be considered a "match condition".

In addition to identifying and reading a symbology you defined (using Modify
Settings > Bar Codes), this feature enables you to configure a reader to
match specific select characters within a bar code.

All bar codes are compared to the complete list of Match Codes. If a bar
code matches ANY of the codes defined in Match Code settings, it is
considered a MATCH. When a match code is read, you can setup your
reader to:

» fire a relay output (Example: Activate a diverter)

» send a user-defined message (Example: Acknowledge match code
found)

The following wildcards are available:

nin

. represents a string with arbitrary length

» If you enter 9* and the AL5010 reads bar code data 91234567890,
then the AL5010 will transmit a valid read to the host because the
leading 9 matches the pre-defined match character. The rest of the
characters in the bar code are not effected because the asterisk
wildcard instructs the AL5010 that the 9 is the only character that
need to be matched.

» If the AL5010 reads bar code data 01234567890 then the AL5010
will transmit a no read because the leading 0 in the bar code did not
match the pre-define 9.

« "?"represents a single character

»  With this condition, the AL5010 will ignore the character located in
the designated location in the data string and only match the
identified data.

See also: Modify Settings > Match Codes in Appendix C.

NOTE: If ANY match code pattern is set to “*” ALL codes will
‘@ match it.
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Modify Settings > Serial Communications

Use the Serial Communications menu tree selections to set the serial port
connection parameters including:

* Baud Rate
» Data Bits
» Stop Bits

o Parity

* Flow Control
» Message Format

Individual settings can be made for Serial Port 1 and Serial Port 2. If the User
Defined Message format is selected, an addition tab screen is supplied for
creating unique message definitions.

Serial Port 1 and 2

Use Modify Settings > Serial Communications > Serial Port 1 (or 2) to
define the format of message the reader sends to your host computer (or
other device) connected to Serial Port 1 (or 2).

To set or modify the communications parameters for Serial Port #1:
Go to the Serial Communications Port#1 screen.

Click a Baud Rate option group button.

Click a Data Bits option group button.

Click a Stop Bits option group button.

Click a Parity option group button.

Click a Flow Control option group button.

Select a Message Format from the drop-down list.

Click Update.
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Message Definitions

When any option, other then the Standard Message selection, under the
Message Format item is selected a Message Definition tab is made
available.

Creating User-defined Messages
NOTE: Use the same procedure to create user-defined
messages for both the serial (Modify > Serial Communications
Port #1 or Port #2) and network communications (Modify >
Network Settings).
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To create user-defined messages:
Under Message Format, select User Defined Message.

A Message Definitions tab becomes available. For the serial port, select
Message Definitions — Port #1(or 2) (example shown below). For network
communications, select Message Definitions — Net#1(or 2).

To define message framing:

Header - Character string specified for the header. Sent at beginning of
every message.

Trailer - Character string specified for the trailer. Use to terminate every
message.

Seq # - When enabled, a sequence number consisting of the specified
number of digits is inserted just after the header.

Check Digit - When enabled, a two-character hexadecimal check character
is inserted just prior to the trailer.

Include Multi-Bar code in single message (checkbox) - Affects how the
reader handles multiple bar code transmissions. If enabled, the bar codes
are sent in one message (between one header and trailer) and each bar
code is separated by the specified “separator.” If disabled, all bar codes are
always sent as a complete message (with a header and trailer).

Bar Code Separator - String used to separate multiple bar codes (see above.

Power Up/Connect Message - String that is always sent on reader
initialization. Note that for a Network connection, this string is always sent
when the socket connection is made.

To define Serial Port 1 message content:

The message drop-down lists define the message options for each bar code.
The message content can be defined for transmissions from the reader’s
serial port #1 as well as any network connection (via Net#1). These
messages are based on various conditions. For each condition, there are
options for what message can be sent. These options include:

Send Bar Code - Bar code (with padding and/or stripping) is sent.

Repeat Character - Send a message consisting of the specified character
repeated for the minimum number of characters for the bar code (example is

User Specified Message - Send a message defined string for this condition.

Category 1: Read, No Read, or Multiple Bar Code

These three conditions are mutually exclusive, so only one of these three
messages can be sent for any bar code.

Read - If disabled, nothing is sent for a valid read; otherwise either the bar
code or a user specified message is sent.

No Read - If disabled, nothing is sent for a no-read; otherwise either the
specified “repeated character” or the user specified message is sent.
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Multiple Bar Code - If disabled, a multiple bar code condition will be reported
as a “Read” of the first bar code reported. Otherwise, the specified
“repeated character” or the user-specified message is sent.

Category 2: Match, No Match, No Match Read

These conditions are IN ADDITION to the conditions specified in Category 1.
If a condition in both categories is met, these messages will be appended. If
you desire to only generate a message based on Category 2 conditions, all
messages in Category 1 should be disabled.

Match - If the bar code matches any of the match codes, this message is
sent. Options include sending the bar code or a user specified message.

No Match - If the bar code does not match any of the match codes (or was a
no-read), this message is sent. Options include sending a “repeated
character” or a user specified message.

No Match Read - If a valid bar code was read, but it does not match any of
the match code, this message is sent. Options include sending the bar code
or a user specified message.

Category 3: Append QQ, Heart Beat Message, and Heart Beat Timeout

Append QQ (code quality) to message (checkbox) - When selected a two
digit “code quality” indication (number from 00 to 99) is appended to the bar
code message. The code quality value is separated from the message with
the specified separator.

Heart Beat Message - When enabled, if no other message is sent for the
time period specified in Heart Beat Time Out, the specified heart beat
message string is sent. A time-out of zero disables the heart beat message.

Heart Beat Time Out (0-30,000 ms) - 0 = Disable Heart Beat Message, 1-
30,000 = Delay before sending Heart Beat Message

Append Distance to Message - allows the AL5010’s measured approximate
distance from the scanner to the bar code read to be in the transmitted
message.

See also: Modify Settings > Serial Communications in Appendix C.
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Modify Settings > Network

Use Modify Settings > Network to specify network settings (including the
IP address) for the reader. Currently, the reader can only be configured to
use a Static IP address. Net Host Port1 and Net Host Port2 define two
network connections for sending bar code messages. The Connection Type
and Message Format for each port can be set independently. Message
formatting is the same as for the serial port.

e IP Address - An IP address specifies a unique host ID for the
reader on a particular TCP/IP network. Consult your network
administrator for a valid IP address for the reader.

* Net Mask - A netmask modifies a standard IP address into subnets.
A default net mask should be valid in most cases (255.255.255.0).
Consult your network administrator for the net mask value.

» Gateway IP Address - A gateway allows the reader to reach other
systems not on the local network and remote systems to reach the
reader. If the reader requires external connectivity, consult your
network administrator for a valid gateway address.

Net Host Port 1 or 2
Connection Type
The following connection types are available for each network port:

e TCP/IP Server: As a TCP/IP server, a Port # must be specified. In
this case it is the TCP/IP client’s responsibility to initiate a reader
connection.

» TCP/IP Client: As a TCP/IP client, aside from the Port #, the Remote
IP Address of the TCP/IP server which is to receive the barcode
messages must be specified. The Reconnect Time specifies the
interval (in seconds) at which the reader attempts to establish a
connection.

» UDP Messaging: In some instances, it may be desirable to use a
connectionless UDP message to send bar code data. In this case,
only the Port # and Remote IP Address of the receiver need to be
specified.

» EtherNet/IP (Net Host Port 1 only): This enables use of the
EtherNet/IP protocol on the reader.

* Message Format - There are four message format options: Custom
Message, Standard Message, User Defined Message, and MUX
(ADP) Message.

Controller/Client Configuration

Number of Client Readers - The number of client readers in a multi-reader
network must be defined on the reader acting as the Controller. Drop-down
list selectable for up to 14 readers functioning as “Clients”. Client readers
must be set at zero (0).

Group Number - All readers in a Controller/Client group (both the Controller
and ALL Clients) must be set to the same controller group number. The
default of zero (0) disables a reader from listening for messages to become a
client.
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Ethernet Link

Drop-down list with 5 selections: AutoDetect, 100 Mbps/Full Duplex, 100
Mbps/Half Duplex, 10 Mbps/Full Duplex, 10 Mbps/Half Duplex

» Controller Multicast IP Address: This is the IP address used by
this controller to communicate to its Group (ldentified by the Group
No.) to broadcast such messages as tach and trigger.

.g NOTE: This IP address should not be changed.

* Telnet Port: The port number used to Telnet into the AL5010.

Message Definitions

Whenever you specify a user-defined message format for either serial port
#1 or network settings, Message Definitions become available

Creating User-defined Messages
NOTE: Use the same procedure to create user-defined
messages for both the serial (Modify > Serial Communications
Port #1) and network communications (Modify > Network
Settings).

To create user-defined messages:
Under Message Format, select User Defined Message.

A Message Definitions tab becomes available. For the serial port, select
Message Definitions — Port #1 (example shown below). For network
communications, select Message Definitions — Net#1.

To define message framing:

Header - Character string specified for the header. Sent at beginning of
every message.

Trailer - Character string specified for the trailer. Use to terminate every
message.

Seq # - When enabled, a sequence number consisting of the specified
number of digits is inserted just after the header.

Check Digit - When enabled, a two-character hexadecimal check character
is inserted just prior to the trailer.

Include Multi-Bar code in single message (checkbox) - Affects how the
reader handles multiple bar code transmissions. If enabled, the bar codes
are sent in one message (between one header and trailer) and each bar
code is separated by the specified “separator.” If disabled, all bar codes are
always sent as a complete message (with a header and trailer).

Bar Code Separator - String used to separate multiple bar codes (see above.

Power Up/Connect Message - String that is always sent on reader
initialization. Note that for a Network connection, this string is always sent
when the socket connection is made.
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To define Serial Port 1 message content:

The message drop-down lists define the message options for each bar code.
The message content can be defined for transmissions from the reader’s
serial port #1 as well as any network connection (via Net#1). These
messages are based on various conditions. For each condition, there are
options for what message can be sent. These options include:

Send Bar Code - Bar code (with padding and/or stripping) is sent.

Repeat Character - Send a message consisting of the specified character
repeated for the minimum number of characters for the bar code (example is

User Specified Message - Send a message defined string for this condition.
User Specified Message - Send a message defined string for this condition.
Category 1: Read, No Read, or Multiple Bar Code

These three conditions are mutually exclusive, so only one of these three
messages can be sent for any bar code.

Read - If disabled, nothing is sent for a valid read; otherwise either the bar
code or a user specified message is sent.

No Read - If disabled, nothing is sent for a no-read; otherwise either the
specified “repeated character” or the user specified message is sent.

Multiple Bar Code - If disabled, a multiple bar code condition will be reported
as a “Read” of the first bar code reported. Otherwise, the specified
“repeated character” or the user-specified message is sent.

Category 2: Match, No Match, No Match Read

These conditions are IN ADDITION to the conditions specified in Category 1.
If a condition in both categories is met, these messages will be appended. If
you desire to only generate a message based on Category 2 conditions, all
messages in Category 1 should be disabled.

Match - If the bar code matches any of the match codes, this message is
sent. Options include sending the bar code or a user specified message.

No Match - If the bar code does not match any of the match codes (or was a
no-read), this message is sent. Options include sending a “repeated
character” or a user specified message.

No Match Read - If a valid bar code was read, but it does not match any of
the match code, this message is sent. Options include sending the bar code
or a user specified message.

Category 3: Append QQ, Heart Beat Message, and Heart Beat Timeout

Append QQ (code quality) to message (checkbox) - When selected a two
digit “code quality” indication (number from 00 to 99) is appended to the bar
code message. The code quality value is separated from the message with
the specified separator.

Heart Beat Message - When enabled, if no other message is sent for the
time period specified in Heart Beat Time Out, the specified heart beat
message string is sent. A time-out of zero disables the heart beat message.

Heart Beat Time Out (0-30,000 ms) - 0 = Disable Heart Beat Message, 1-
30,000 = Delay before sending Heart Beat Message
See also: Modify Settings > Network in Appendix C.
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Modify Settings > Trigger

The trigger helps the reader identify when products with bar codes are
entering the scanning area. Use Modify Settings > Trigger Settings to set
the various trigger parameters.

Trigger Source

There are three options for trigger source:
» Hardware Trigger
»  Software Trigger
»  Continuous Trigger

Since the trigger parameters vary based on trigger type selected, the trigger
parameter options have been defined within the context of the specific trigger
source.

See also: Modify Settings > Trigger in Appendix C.
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Modify Settings > Relay

Use to define functionality of any I/O relay module options utilized by your
reader. For additional information and field descriptions, see Modify
Settings > Relay in Appendix C.

To configure an 1/O relay:

1. Select the intended use of the relay (output or input).
2. Select the intended purpose for the relay.

3. Set for either Active High or Active Low.

4. For relay outputs, set an output signal duration.

5

After configuring the relays, click Update.
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Modify Settings > Tracking
Use tracking in application that require:
» Tight package spacing

« Transmit point is greater than the "smallest box + minimum box
spacing" distance.

Use Modify Settings > Tracking to define all of the parameters associated
with monitoring package travel on the conveyance system. The tracking
parameters are only available if tracking is enabled, otherwise they are not
shown in this window.

To enable tracking:

1. Click in the Tracking Enabled checkbox. When tracking is enabled, a
checkmark appears in the checkbox and the tracking parameter settings
are visible in the Modify Settings > Tracking screen.

2. Adjust the tracking settings for Tachometer (Encoder), Reader Mounting,
Transmit, and Tracking Configuration.

3. Click Update.

See also: Modify Settings > Tracking in Appendix C.
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Modify Settings > FAST Monitor™

FAST Monitor is a browser-based application, running on a FAST Monitor
Server, that gives facility managers and maintenance personnel the ability to
monitor multiple Accu-Sort products within their facility or across multiple
facilities from anywhere an internet connection is available. FAST Monitor
provides real time and historical performance data in an easy to use browser
interface as well as automatic status and error condition reporting of all
Accu-Sort products and systems to which it is connected.

Use the FAST Monitor screen to configure an AL5010 reader for FAST
Monitor message format compatibility. For additional information and field
descriptions, see Modify Settings > FAST Monitor in Appendix C.

NOTE: For more information on FAST Monitor functionality,
see the FAST Monitor Product CD, online help or contact us at

1-800-BAR-CODE.

To Configure an AL5010 reader for FAST Monitor messaging:

1. On the Modify Settings > Configuration screen, confirm a unique
Reader Name is set.

2. On the Modify Settings > Network screen, confirm the reader is
properly set as either the Controller or a Client.

Go to the Modify Settings > FAST Monitor screen.
Under Tunnel Information, assign a Tunnel Name.

Select the Reader Position from the drop-down menu. Reference the
illustration for relative positions.

6. If the reader is a standalone unit or controller in a scanning tunnel, be
sure to set the FAST Monitor Port information. The Port No. is always
9899.

the reader’s location in the scanning tunnel. Avoid assigning

IMPORTANT: Be sure to use a unique position that relates to
A the same Reader Position to two different readers.

See also: Modify Settings > FAST Monitor in Appendix C.
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Modify Settings > Advanced

The Advanced screen provides filters for enhancing the scanners ability to
read a bar code. Adjusting these values may have a negative or positive
effect on the reader’s ability to decode a bar code.

The Data Filtering, DRX (Data Reconstruction) and Transmit QQ settings are
considered advanced settings because they require comprehensive training
to understand how they should be modified.

NOTE: cChanging the Advanced settings can adversely
affect reader performance. These settings are to be modified
only under the guidance of Accu-Sort Technical Support.

Data Filtering
Scan Filtering (Skip Scan) IO— Minimum Transitions |6—
hZi?rDliS[t)Cg;:.] [0 Far bist (i) 45.0
::Jzi?r;is??;; | Far Dist (in) 38.0
Bar Code Size
Scan Rate Il[]DD— Field of View |54—
Min Marrow Element (mils) IlCl— Max Narrow Element (mils) ll:—?—
Maximum Tilt |45—
DRX Setting
¥ DRX Enabled
Overlay Ratio |65— Radio M Factor |1-1—
Win. |4— Max Recurse ll—
Pairs |6— Kill Limit IS—
Change 500 Overlay |2—
Search (0.0-3.0) IT ¥ overlay Recover Enabled

Default DRX |
Transmit QQ
Minimum QQ |3— Maximum QQ 200

Update | Reset |

Data Filtering

The data filtering parameters specify the minimum and maximum pulse width
(in counts) for the bar code data. This important data filter setting assures
optimal reader performance. The Sampling Frequency default of 100 Mhz
assures better decoder resolution for poorly printed bar codes.

Scan Filtering (Skip Scan) —

» This option is used on applications that have slow conveyance
and/or reading bar codes with a large bar height. Under these
conditions the reader fills its memory with so much data that it does
not have time to process all the data before the end of trigger,
causing the reader to no-read. The Scan Filtering (Skip Scan) option
limits the amount of data, allowing the reader to processing less data
and give it a more of an opportunity to read the bar code.

Minimum Transitions —

» There have to be a certain number of bars and spaces detected on a
scan line in order to consider the information valid. This option
restricts data from being placed into memory.
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» Should be at least as long as Start/Stop character. If short Start/Stop
character, use the length of one data character plus the start/stop
character (e.g.;12 of 5)

» Inthis subroutine, any group of elements less than the min trans
setting is discarded or ignored.

Laser /Laser 2 DOF: Near Dist (in)/Far Dist (in)

» These options filter out any transitions beyond the entered values.
Any transition (including bar codes) seen beyond these values are
not placed into memory to be processed by the reader.

This also includes valid bar codes.

* As an example the above view shows the closest a bar code can be
processed is six inches for Laser 1 and 27 inches for laser 2. Any
bar code found closer then these values will be filtered out and the
reader will report a No-Read.

Bar Code Size
*  Min Narrow Element (mils)/Max Narrow Element (mils)/Maximum Tilt

» These entries are used to identify valid Quite Zones.

DRX Settings
The DRX settings typically will not need to be modified.

Transmit QQ

The Minimum QQ is the smallest allowable QQ value for a code to be
transmitted.

The Maximum QQ forces the transmission of a code after the maximum QQ
value is reached.

See also: Modify Settings > Advanced in Appendix C.
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Modify Settings > Raster

Use Modify Settings > Raster to define the laser sweep area of an AL5010
with the optional adjustable raster feature. It also allows you to set the
oscillating frequency (speed) of the vibrating mirror.

The sweep of the laser is determined by the amount of coverage your
application requires (possible label position) and the distance of the laser
scanner from the object being scanned. The laser sweep is adjustable from
20-degrees above 0 (the center laser position) or -20-degrees below 0.

Examples:

» Ifthe Upper Sweep is set to 15-degrees and the Lower Sweep is
set to 10-degrees, the total coverage will be 25-degree
encompassing 0.

» Ifthe Upper Sweep is set to -5-degrees and the Lower Sweep is
set to -15-degrees, the total coverage will be 10-degrees, but below
the 0 position.

» If the Upper Sweep and Lower Sweep are both set to -10 degrees,
the laser will remain static at 10-degrees below the 0 position.

To Set the Sweep of the Laser:

1. Enter a value in the Upper Sweep text field between -20 and 20.
2. Enter a value in the Lower Sweep text field between -20 and 20.
3. Click Update.

To Set the Oscillating Frequency:

1. Enter a value in the Oscillating Frequency text field between 0 and 4. A
value of 0 will stop oscillation, while values above 0 will increase the
speed of the oscillation up to the fastest at a value of 4.

2. Click Update.
See also: Chapter 3: Mechanical Installation > Raster Setup.
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Save / Retrieve

Use Save/Retrieve to save all the settings to the scan head and backup the
settings to the mounting base and/or file.

To use the save/retrieve functions:

1. Select an Action.
Based on the action selected, either the From or To drop-down list
becomes available.

2. Select the required location (either From or To).

Follow any additional prompts.
For example: If Retrieve from File is selected, use the Browse function
provided to locate the file.

4. Click OK.

Default

Use to return the reader’s parameters to the hard-coded "default" values built
into the reader software.

USEFUL TIP: Selecting Default will return your reader to the
default factory settings. Since your reader may already be
configured for your application, it is recommended that you
ALWAYS Save to Disk before using the default function.

Retrieve from Base

Use to retrieve the parameters stored in the reader’'s mounting base. This is
especially useful when it becomes necessary to load the correct parameters
to a replacement reader module.

Retrieve from File

Use to retrieve a parameters set from a specific file name and location on
your computer.

Save to Base

Use to save the current set of parameters to the mounting base as a backup
copy.

Save to File

Use to specify a file name and location to store the current parameter
settings on your computer.

Save to Reader

Use to save the current set of parameters to the reader. Parameters saved in
the reader are the parameters used during normal operations.

Reboot AL5010

Click Reboot to reinitialize the scanner.

See also: Save / Retrieve in Appendix C.
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Diagnostics
The AL5010 includes comprehensive diagnostic that enable you to monitor:
» Status LEDs
* Read Quality
» Messages
*  Box Information
e Message Monitor
 Read Rate Log
» Counters Log
* Message Log

e Upload Firmware
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Diagnostics > Monitor

Use the Diagnostics > Monitor as the primary tool to monitor the reader's
operation and bar code readability in real-time. Status indicators and vital
statistics appear on a single screen, enabling you to effectively and efficiently
detect and troubleshoot any problems that may occur.

The Monitor is a Java application and requires Java and the

‘@ appropriate browser plug-in.

See also: Diagnostics > Monitor in Appendix C.
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Diagnostics > Log Viewer

The Diagnostics > Log Viewer lets you review the performance logs saved
by the reader. The three most commonly viewed logs are available by
selecting one of the three buttons:

* Read Rate
e System Counters
* Message Log

You can also enter a log request in the Command field.
For example: DISPENET will provide Ethernet data.

The log view field remains empty until you select a button or enter a
command.

To determine which log is currently being shown in the log viewer, the log's
name is shown just below the words log view in the window.

For additional information and field descriptions, see Diagnostics > Log
Viewer in Appendix C.

To use commands to view a log:

1. Enter a command in the Log Viewer Command field without using
spaces (i.e., DISPCOUNTERS, DISPMSGLOG, etc.)

2. Click Send Command.

Log Viewer displays the most current information for the log you
requested.

4. Click Clear to empty the Log Viewer.
Read Rate Log View

Use the Read Rate Log View to see a summary of the reader’s overall
performance.

To open the Read Rate Log View:

1. Click Read Rate, or

2. Enter DISPREADRATE in the command field. Click Send Command.
3. The Read Rate log is shown in the viewer.

4. Click Clear to empty the viewer and display another log.

Overall Read Rate Statistics

The Read Rate Log Viewer provides information on the overall read rate.
Total Boxes Total number of triggers.

Good Boxes A good box is a box with all required codes. This counter is the
number of good boxes along with the percentage of the total
boxes that were good.

Partial Boxes A partial box is a box were some, but not all required codes were
read. This only applies when the reader is configured to read
multiple codes each trigger.

Bad Boxes A bad box is a box where no codes were read.
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Read Rate Counters by Laser

The Read Rate Log Viewer also provides performance information on each
laser. In order to provide diagnostics on the performance of each laser, the
percentage references here are the percentage of the total codes read by

the particular laser, NOT the percentage of the total packages read by that

laser.
Total Codes Total number of bar codes read.
Laser#x Total number of bar codes read by the particular laser

For a reader configured as a Controller in a multi-reader network, this
command also provides counters for the number of bar codes read, by laser,
for each reader client. The clients are identified by their reader name as
assigned in Modify > Configuration.

I! REMEMBER: Not every reader is configured with two lasers.
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Counters Log View

Use the Counters Log View to display a number of values and counters that
indicate whether the reader is configured and operating properly.

To open the System Counters Log View:

1. Click Counters, or

2. Enter DISPCOUNTS in the command field. Click Send Command.
3. The system counters log is shown in the viewer.
4

Click Clear to empty the viewer and display another log.

Scan Rate and Belt Speed System Counters

Scan Rate This is the total number of scans/second that the reader is
reading. Note the this number does NOT take into account
“laser toggling” if it is enabled. If “laser toggling” is enabled,
the effective scan rate for any laser is half of this value.

Belt Speed Speed of the belt (in ft/min) as measured by the tachometer.
(Tracking)

Bar Code System Counters

Triggers Total number of packages based on the trigger signal. In self-
trigger mode, this will match the number of good reads.

Good Reads Total number of bar codes read and transmitted. If the reader
is set up to read multiple bar codes each trigger, this counter is
incremented for each bar code read.

No Reads Total number of bar codes that were not read.

Mult Codes Total number of instances where more bar codes of a specific
type were read than expected. This counter will also
increment, regardless of whether the reader is configured to
report “multiple codes” as an error.

Match Codes Total number of bar codes that matched any of the Match
Code criteria.

Bad ModChk Total number of bar codes that were rejected due to an invalid
Mod Check.
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Error Counters

Xfter Ovrflw Transfer Overflow. This counts the number of codes that were
lost due to an overflow in the transfer buffer between the
Decode/DSP processor and the reader/ARM processor.

Xfer BadLen Transfer Bad Length. Number of codes in the transfer buffer
than contained an invalid length, indicating some sort of
memory corruption.

QData@TX Queue Data at Transmit (non-tracking). This counter indicates
that the reader had not completed processing all of the scan
data at the user-specified transmit time. This will only happen
if the “transmit time” parameter is set to a value other than
zero. This does not necessarily indicate an error, but does
indicate that either the transmit time is too short or the reader
is seeing a lot of data which may be the result of too much
background noise.

QData@Trig Queue Data at Trigger (non-tracking). This counter indicates
that the reader had not completed processing all of the scan
data prior to the start of the next trigger. This typically can only
happen when the "transmit time” parameter is set to zero;
although it can also happen in conjunction with a Force
Transmit. As with the Queue Data at Transmit counter, this
does not necessarily indicate an error, but it likely indicates
that the reader is seeing a lot of data which may be the result
of too much background noise.

ForcedTx Forced Transmit (non-tracking). A forced transmit indicates
that the start of trigger occurred before the specified transmit
delay time had expired.

Lost Codes Lost Codes (tracking). If a bar code cannot be placed onto
any package while in tracking, the code is “lost” and this
counter is incremented. Lost codes are also reported in the
Monitor message window. Lost code occurrences typically
indicate tracking parameters need to be adjusted.

Missed Tx Missed Transmit (tracking). If a bar code is decoded after the
message for that package has been transmitted, the Missed
Transmit counter is incremented.
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Decode/DSP Counters

DSP Codes Count of the number of bar codes decoded, per laser, by the
DSP.

Scan Ints Number of scan interrupts detected by the DSP.

Queue Size Current size of the scan data queue within the DSP. This

value changes dynamically.

Num Cluster Current number of DRX clusters in use by the DSP. This
value changes dynamically.

Bad Scan Count of the number of scans in which the data contained
formatting errors.

Pipe Error Count of internal errors on the transfer of scan data from the
scan data buffer.

Full Scans Number of times a scan could not be added to the scan data
buffer because the maximum number of scans was exceeded.

Mem Full Number of times a scan could not be added to the scan data
buffer because the memory was full.

ScanToolong Number of times a scan was skipped because it contained too
many transitions.

Max Clusters Number of times, the maximum number of DRX clusters was
exceeded.

ARM and DSP Restarts Counters

ARM Restarts Number of times the ARM processor has restarted. This
typically means the hardware watchdog timer expired causing
the ARM processor to restart.

DSP Restarts Number of times the DSP processor has been restarted.
Typically, this happens if the ARM suspects the DSP has
“locked up” for any reason.

Message Log View

The Message Log View contains various text messages that have been
logged by the reader software.
The messages contained in this log typically reflect significant events.

To open the Message Log View:

1. Click Message Log, or

2. Enter DISPMSGLOG in the command field. Click Send Command.
3. The message log is shown in the viewer.
4

Click Clear to empty the viewer and display another log.
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Command

There are several commands that you can use to display reader parameters
and diagnostic information.

Commands can be sent from the Command field on the Log Viewer.

Commands may also be sent from a terminal interface, such as a TELNET
connection to the reader.

Log Viewer Definition
Commands
CLEAR ALL Clears all information from the Message Monitor.

DISP COUNTERS Display the System Counter log view.

DISP ENET Display the Ethernet interface status, including MAC address.

DISP MSGLOG Display the Message log view.

DISP READRATE Display the Read Rate log view.
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Setup

AcculLazr™ AL5010 Product Line Manual

Diagnostics > Update Firmware

Use Diagnostics > Update Firmware to reload the reader firmware. For
additional information and field descriptions, see Diagnostics > Update
Firmware in Appendix C.

CAUTION: This function should only be performed under the
& guidance of Accu-Sort Technical Support.

To Extract Image
1. Click Extract Image.

2. In Save as window, save the image (*.as) files to your computer.
The graphic on-screen indicates Extract Image is in-process.

3. A message will appear when Extract Image is complete.

To Burn Flash
1. Click Burn Flash.

2. In Open window, open an image file (*.as) to burn to flash.
The graphic on-screen indicates Burn Flash is in-process.

3. A message will appear when Burn Flash is complete.
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6 Operations

This chapter provides details on how the AL5010 bar code scanning
solutions function during normal operation. It also outlines how you can verify
optimal performance through several methods:

= Become more familiar with your application
= Step-by-step start-up operations checklist
= Status Indicator LEDs

= AL5010 Reader

= AL5010 Interface Module
= Diagnostics to confirm normal operations

After configuring your AL5010 reader using the browser-based setup
application, use the operations checklist to verify normal operations.

First-time Startup

On initial power-up, the AL5010 performs a series of self-diagnostic and LED
tests. The complete power-up sequence takes less than 20 seconds.

When the STATUS LED flashes and turns a steady green the power-up
sequence is complete. The AL5010 is now operational.

NOTE: When an application uses multiple AL5010 readers, you can
provide each reader with a unique reader name using the browser-based

setup application. This makes it easier to keep track of reader parameter

changes when working with several readers on a network. (See Chapter 5.)

Default Parameters

The reader is shipped from the factory with these defaults:
= Connection Mode: Setup Cable

= Reader Name: AL5010

= Control Panel Buttons Enabled

= Code 128 (10-30 characters)

= |P address 192.168.3.100

Perform the following setup procedure using these defaults or configure your
AL5010 with your application’s parameters using the browser-based setup
application.

Phone: 800.894.0412 - Fax: 888.723.4773 - Web: www.ctiautomation.net - Email: info@ctiautomation.net



First-time Setup

Every application is unique. AL5010 is designed for ease-of-setup, allowing
you to program the reader to fit your application seamlessly.

A browser-based setup application on your laptop/desktop computer is the
tool you will use to define operating parameters, set bar code type / length,
and construct output messages, including filtering, stripping and padding
capabilities. AccuLazr’'s user interface enables you to easily configure, fine-
tune, and monitor your AL5010’s operations.

AL5010 provides ease-of-use regardless of your experience with bar code
readers. A beginner follows basic setup procedures for a standard
configuration. If you are more experienced, use the advanced setup features
that allow access to more complex options.

First-time Setup Procedure
To setup your AL5010 bar code reader:

1. Connect an RJ45 Ethernet cable to the AL5010.

2. Connect the other end of the cable to your laptop/desktop computer.
3. Apply power to AL5010.
4

Set configuration parameters for bar code symbologies, trigger,
tracking, and communications (serial, Ethernet, and 1/O).

5. Check operations using the Test Mode.

Check Operations using Test Mode

NOTE: Perform the following test using a bar code that matches the
default parameters. Or you may wish to perform this test after configuring

the AL5010 to your specifications. If the default parameters have been

changed, you must enable the control panel buttons and the other

parameters listed on page 96. See Chapter 5, Modify > Configuration and
Modify > Bar Code Setup.

To quickly check the operation of an AL5010:
1. Apply power to the AL5010.

2. Position a test bar code symbol approximately 20 inches (0.5 meter)
from the reader. Skew the bar code symbol slightly.

Press the Test/Diagnostics button on the control panel to initiate test.

The laser(s) should be scanning continuously during normal operations.
(Observe the laser safety warnings in Chapter 2. If it becomes necessary
to shutoff the laser(s), follow procedure outlined in Chapter 6.)

5. Observe the bar graph LEDs on the AL5010 control panel. The read LED
will blink GREEN if it reads a bar code, or RED if it doesn'’t.

6. Connect your PC via the network.
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7. Run the browser-based setup application and establish a connection
with the reader.

8. Go to the Diagnostics > AL5010 Monitor.

During operations, use the AL5010 Monitor to confirm the reader’s
status, read quality, code quality, and messages via the on-screen
indicators. (See Chapter 8, Diagnostics.)

10. Close the connection to the reader.

11. Disconnect setup cable.

Operations Checklist
= Check trigger photoeye LED for proper operation.

= Test parameters to assure optimal operation.

= Observe the reader’s Status Indicator LEDs during power-up.
(What to watch for is outlined on page 95.)

= Select Diagnostics > AL5010 Monitor.

= Pass test label in scanning beam.

= Adjust mounting as needed for optimal performance.

= Modify AL5010 parameters as needed for optimal performance.
= Save parameters to scan head.

= Backup parameters from scan head to mounting base.

= Backup parameters to disk (optional, but recommended).
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Control Panel Indicators

There are several control panel indications on the AccuLazr AL5010
Readers and AcculLazr Interface Modules.

CLASS 1 LASER PRODUCT
(JEC-60825-1:2001)
COMPLIES WITH 21CFR1040.10 AND
21CFRI040.11 WITH DEVIATIONS

PURSUAN

IRSUANT TO LASER NOTICE 50
DATED JULY 26,2001
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The LEDs provide the following indications during normal operations.

Using LED Indicators to Check Normal Operations

LED Description
STATUS to indicate the overall "health" of the reader.
(If RED, see Chapter 8, Troubleshooting.)
TRIGGER Indicates the trigger input. The LED is activated upon trigger input
regardless of trigger source (incl. software trigger).
READ Flashes red or green based upon the software criteria.
RXITX LED for serial port 1. = Transmitting data
RED = Receiving data
NETWORK Flashes red or green to indicate connection status.

=  For a Single TCP/IP connection, it indicates that a "host"
connection has been made to the reader.

=  For EtherNet/IP connection, it indicates "network" connection
status. This LED is software controlled.

=  For a Controller/Client multi-reader connection, it indicates
that all inter-reader communications (connections between
readers) are correctly functioning.

LINK This LED is LINK indicator for Ethernet.
Flashes when connected to a network.

Bar Graph =  Scan quality indicator.

(LED 1-5) =  Flashes when parameters copied to/from mounting base.

= LEDs stay on when Test/Diagnostic button C is pressed during
the laser shutoff procedure.
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NETWORK LED during Normal Operations

Mode Description

Single TCP/IP Solid — AL5010 connected to a host.
NOTE: If both Host 1 and Host 2 are used, the LED will be
solid if either port is connected.

Off — No host connection.
NOTE: If UDP messaging is used (unconnected messages)
the Network LED will be off.

EtherNet/IP Solid — AL5010 made a connection to the PLC
Flashing — No connection made with the network
Flashing RED — Lost network connection

Controller/Client  Controller
Solid — The correct number of client(s) with the
same group number have been found.
Flashing RED — All the client(s) with the same group
number have NOT been found

Client

Solid — Connected to a controller with the same
group number.
Off — Not connected to a controller with the same group
number.

NOTE: The mode indicated by the Network LED is dependent on the AL5010
configuration you are using. Ethernet/IP is the highest priority, Single TCP/IP mode
operation is the lowest.

Using Control Panel Buttons to Check Normal Operations
Ref Button Description

Restore to Scan Restores parameters from Mounting base to Scan
Head Head

= Button must be pressed twice to initiate action.
= See page 99 for procedure.

u Backup to Downloads parameters from Scan Head to Mounting
Mounting Base base

= Button must be pressed twice to initiate action.
= See page 99 for procedure.

m Test /Diagnostic = Enables the AL5010 test mode.
(Test mode can also be selected remotely using
(Laser Shutoff) Tools > Commands > Test Mode.)

= Use to perform laser shutoff. (See page 107.)

REMEMBER: AL5010’s control panel buttons can be enabled / disabled
through the use of the browser-based setup application.

(See Modify > AL5010 Configuration, Enable AL5010 Control Panel

Buttons.)
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Interface Module Status Indicators
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LEDs on Enhanced Interface Modules
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FieldBus LED Status Indicators

DEVICENET
Module Status Off - No power
FB1 Green Normal operation
FB1 Green, flashing Auto Baud in progress
FB2 Red Unrecoverable Fault(s) detected
FB2 Red, flashing Recoverable Fault(s) detected

Alternating Red/Green Self test in progress

Network Status Off - Not online - or - no power

FB3 Green On-line, one or more connections established
FB3 Green, flashing On-line, no connections established
FB4 Red Critical link failure

FB4 Red, flashing Connection timeout

Alternating Red/Green Self test in progress

PROFIBUS

LED State Color Description

FB1 Clear (0) Off Node Off-Line or Power not supplied
Set (1) Green Node in Data Exchange Mode
Toggling (1Hz)  Green, flashing Node in Clear Mode

FB2 Clear (0) Off No Error or Power not supplied
Set (1) Red Error in initialization of PROFIBUS

ASIC

Toggling (1Hz)  Red, flashing Error in configuration data and/or User
Parameterization Data
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Backup / Restore Procedures

To backup parameters from scan head to mounting base:

1.
2.

Press the backup button for about 1 second.

Release button. The bar graph LEDs continuously flash to indicate the
button has been pressed long enough. If the LEDs flash only once, the
button was not pressed long enough.

Press button a second time while LEDs are flashing. Hold for about 1
second.

Release button. The bar graph LEDs strobe from 5 to 1 indicating
parameters are being backed up from scan head to mounting base.

When the LEDs stop strobing, the backup is complete.

To restore parameters from mounting base to scan head:

NOTE: The restore parameters function can cause the
ﬁ scanner to reboot.

Press the restore button for about 1 second.

Release button. The bar graph LEDs continuously flash to indicate the
button has been pressed long enough. If the LEDs flash only once, the
button was not pressed long enough.

Press button a second time while LEDs are flashing. Hold for about 1
second.

Release button. The bar graph LEDs strobe from 1 to 5 indicating
parameters are being uploaded from mounting base to scan head.

When the LEDs stop strobing, the upload is complete.

‘EACCU-SORTG AL5010

Restore

o STATUS

CLASS 1 LASER PRODUCT
(IEC-60825-1:2001)

®ThlooER oy 1@
® READ " s .

© RX/MX

@ NETWORK 2@
® LINK 1@

ACCU-SORT SYSTEMS, INC PAT PEND.

Button and LEDs involved with Backup / Restore
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Checking Operations with User Interface

The Diagnostics > Monitor enables you to evaluate the operational
performance of your AL5010 by providing vital statistics via status indicators,
real-time read quality monitoring, and box information. Outgoing and
incoming messages are also monitored.

Status LEDs Read Quality

——
Status Il Network ea € “

Code Quality (QQ)
Trigger W 101 Scans/Code _

Good/No Read o2 Laser1 W
u Code Postion : 2619 .

Muttiple codes [l 103 Laser 2 n
Match B o4 b L R

Messages Box Information

3037477262 Qa0 010y =
303TATTEZ Qa0 (0n0y
303T4TY262 QG0 (00

R Belt Speed (fpm) _
3037477262 QQ1D (D0 Belt Length (in,) _
303747262 QG0 (00

S037ATT262 Q@10 (0M10) Code Postion (in.) _
=NOREAD=
S0374TT262 Q@10 (0M0) Scans/Trigger -

|4

Stop

\023037477 26200104

W023037477 262000004
\023037477 262000004
\023037477 26200004

023037477 2EA0D0A

® None ) Serial Port 1 ) Serial Port 2 ) Net Port 1 ' Net Port 2

Start Test Mode

Diagnostics > Monitor Window
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Checking Multi-Reader Network

From the AL5010 Controller, check Diagnostics > Log Viewer > Read
Rate. This simple diagnostic allows you to check bar codes read, by laser,
for each AL5010 Client in the network. Each client is identified in the Read
Rate Log by the unique name and IP address assigned to it.

See Chapter 5 and online help for more information.
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Standalone Operation

In a typical standalone setup, a single AL5010 scans bar codes on one side
of packages as they move down a conveyor. A photoeye is used to trigger
the AL5010 to begin searching for valid bar codes. Bar code data is
transmitted to a host device.

AL5010
| . Scan Head/Base

Optional Serial Port(s)

Basic Interface Module

To Power
Supply

EtherNet
(or Setup PC)

Typical Single-Unit AL5010 Applications
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Tracking Operation

By utilizing the tracking capabilities of the AL5010, you can configure your
application to monitor the progress of packages on the conveyance system.
Tracking enables the AL5010 to track bar codes and the packages to which
they belong. Your reader may scan more than one package with more than
one code at a time within its read zone. Tracking allows the reader to
accurately associate the correct bar code(s) with the correct packages.

Typical tracking configurations use a tachometer to monitor conveyor speed.
A simplified diagram of the required items for a tracking application is shown
below:

- Sy

Serial
Host

gy Ay

AL5010 AL5010 AL5010 AL5010

Enhanced
Interface
Module

Basic
Interface
Module

Basic
Interface
Module

Basic
Interface
Module

Ethernet
Switch

Setup Functions for AL5010 Tracking Operation
= Modify > Tracking — Tachometer (define tach type)

= Modify > Tracking — AL5010 Mounting

= Modify > Tracking — Transmit

= Modify > Tracking — Track Config

Basic Tracking Setup Procedure
To assure tracking accuracy, the distance from the Trigger Photoeye to the
“X” scanning pattern must be measured and entered in the user interface.

1. To properly track-in the AL5010, drop a plumb bob from the center of the
AS logo on the scan head.

2. Measure the distance (in inches) from the plumb bob to Trigger
Photoeye.

3. Establish a connection with the AL5010.

4. Enter the value (in inches) into the Modify > Tracking > AL5010
Mounting > Trigger Reference Point field.

tracking procedure provided in the Modify > Tracking section. The Tracking
> Trigger Reference Point, Closest Read Point and Furthest Read Point
parameters must be properly set. (See Chapter 5.)

f IMPORTANT: After completing the basic tracking setup, see the advanced
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Dual X-Scanning Operation

In dual X-scanning applications, four AL5010 readers mounted side-by-side
are used to create a dual “X” scanning patterns across the entire width of a
conveyor. Four UMB brackets and four AL5010 readers can be used to
create a dual-X scanning pattern.

Dual X-pattern can be
created by four AL5010
readers

Dual X-Scanning Application

A simple illustration of the required items for a double X-scanning
configuration is shown below:

AL5010 AL5010

Enhanced
Interface Module
(Controller) Basic Interface
Module (Client)

Basic Interface
Module (Client)

Optional
Serial
Port(s)

Ethernet
Switch

Photoeye
Tachometer

HOST

Setup Functions for AL5010 Controller

= Modify > AL5010 Configuration - Reader Name (Controller)

= Network Settings - # of Client Readers, IP address, and Group #
Setup Functions for AL5010 Clients

= Modify > AL5010 Configuration - Reader Name (Client 1,2,3)

= Network Settings — IP address and Group #

See Chapter 5 and online help for details on setting up a multi-reader
network.
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Multiple-Reader Network Operation

In multiple-reader applications, from 2 to 14 AL5010s can be networked
together. A single AL5010 is configured as a Controller for a multiple-reader
network. The AL5010 Controller gathers data from other AL5010s (up to 13,
configured as clients) over an Ethernet network. The AL5010 Controller then
collects and transfers the collected data over a serial communications or
network link to the host.

A simplified schematic diagram of the required items for a multiple-reader
configuration is shown below:

ALS5010

ALS5010

ALS5010

Enhanced
Interface Module
(Controller)

Basic Interface
Module (Client)

Basic Interface
Module (Client)

Ethernet
Switch

Photoeye
Tachometer

Setup Functions for AL5010 Controller
= Modify > AL5010 Configuration - Reader Name (Controller)
= Network Settings - # of Client Readers, IP address, and Group #

Setup Functions for AL5010 Clients
= Modify > AL5010 Configuration - Reader Name (Client 1,2,3)
= Network Settings — IP address and Group #

See Chapter 5 and the online help for details on setting up a multi-reader
network.
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Scanning Array / Tunnel Operations

The AL5010 can be set up with 1 controller and up to 13 clients in a single
system and functioning in the same scanning area, the entire application is
called a scanning array or tunnel.

NOTICE: Due to the complexity of these applications, tunnel arrays are
typically custom-engineered to your specifications.

Setup Functions for AL5010 Controller
= Modify > AL5010 Configuration - Reader Name (Controller)
= Network Settings - # of Client Readers, IP address, and Group #

Setup Functions for AL5010 Clients
=  Modify > AL5010 Configuration - Reader Name (Client 1,2,3,4,5)
= Network Settings — IP address and Group #

See Chapter 5 and the online help for details

Phone: 800.894.0412 - Fax: 888.723.4773 - Web: www.ctiautomation.net - Email: info@ctiautomation.net



7 Maintenance

This chapter provides instructions for maintaining optimum performance and
life for your AL5010. It provides specific information on:

= Maintenance Procedures
= Exterior Cleaning
=  Mounting Hardware Checks

=  Wiring Connection Checks

Tools and Materials Required

Item Description
Soft-bristle brush For cleaning the reader’s exterior
Clean soft cloths For cleaning the reader’s exterior

Cleaning solutions Mild detergent solution for cleaning the reader’s exterior.

70% denatured alcohol, 30% de-ionized water solution for
cleaning exit window

Soft cotton swabs Use to clean reader’s exit window
or lint-free cloth

Laser Shutoff Procedure

In order to perform certain maintenance and service tasks, the reader’s
lasers must be shut off in order to comply with all laser safety requirements.

To shutoff the lasers:

1. Press the Test/Diagnostics button (! ) for 5 seconds.

2. The bar graph LEDs will light for the 5 second duration and then go out.
3. The lasers will then shut off.
4

After maintenance or service is complete, repeat the process to turn the
lasers back on.

AEACCU-SORT“ AL5010

.\' p STATUS CLASS 1 LASER PRODUCT 5 .
(IEC-60825-1 2007)
. TRIGGER COMPLIES WITH 21CFR1040.10 AND 4 .
21CFR1040.11 WITH DEVIATIONS
'_' ] R EAD PURSUANT TO LASER NOTICE 50

DATED JUNE 24, 2007 3

O RX/TX

& NETWORK 2@
@ LINK 1@
ACCU-SORT SYSTEMS, INC WWW.ACCUSORT.COM 1-800-BARCODE  PAT. PEND.

AL5010 Button and LEDs involved with Laser Shutoff
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Maintenance Tasks

Perform the maintenance tasks on an “as needed” basis to assure proper
operation of the AL5010. Task schedule frequency depends upon the
application environment conditions. It only requires a few minutes to
complete each maintenance task.

Exterior Cleaning

WARNING: Shut down the reader before performing this maintenance
task. Do not stare into the reader’s exit window at the laser light. Avoid
direct eye exposure. The laser light level does not constitute a health
hazard, however staring at the laser light for prolonged periods could result
in eye damage.

internal components of the AL5010 are field replaceable units (FRUSs).
Opening the unit will potentially expose the user to emitted laser radiation,
high voltage, and could reduce the effectiveness of the device’s IP rating.
DO NOT REMOVE the faceplate from the scan head enclosure. Opening
the AL5010 will also void the factory warranty.

g WARNING: There are no user serviceable parts inside the AL5010. No

CAUTION: CLASS 3R LASER RADIATION. WHEN OPEN AVOID
& DIRECT EYE EXPOSURE. See warning above.

CAUTION: Do not use any chemical on the reader that is unsafe for
plastics, such as benzene, acetone, or similar products. Before performing
this maintenance task, be sure to shutdown the reader.

The exterior cleaning procedure may be performed without removing the
reader from the mounting structure.

1. Turn off the reader’s lasers.

2. Clean the exterior (except the exit window) with a clean, soft-bristle
brush. Be sure not to brush any dust, dirt, or debris onto the exit window.

Carefully remove any debris in or around the exit window.

Wipe the exterior (except the exit window) with a clean, soft cloth
dampened slightly with a mild detergent solution.

5. The exit window should be cleaned after this task is completed.
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Cleaning the Exit Window

WARNING: Shut down the reader before performing this maintenance
task. Do not stare into the reader’s exit window at the laser light. Avoid
direct eye exposure. The laser light level does not constitute a health
hazard, however staring at the laser light for prolonged periods could result
in eye damage.

WARNING: There are no user serviceable parts inside the AL5010. No
internal components of the AL5010 are field replaceable units (FRUSs).
Opening the unit will potentially expose the user to emitted Class 3 laser
radiation, high voltage, and could reduce the effectiveness of the device’s
IP rating. DO NOT REMOVE the faceplate from the scan head enclosure.
Opening the AL5010 will also void the factory warranty.

CAUTION: CLASS 3R LASER RADIATION. WHEN OPEN AVOID
DIRECT EYE EXPOSURE. See warning above.

CAUTION: Never apply cleaning solution directly to the exit window.
Always apply the solution to a cloth, and then the cloth to the window. Do
not use any chemical on the reader that is unsafe for plastics, such as
benzene, acetone, or similar products.

>p B B

The exit window cleaning procedure may be performed without removing the
reader from the mounting structure if it is possible to do so.

1. Turn off the reader’s lasers.
2. Follow the exterior cleaning procedure before cleaning the exit window.

3. Check the exit window surface for any dust, dirt, or smudges. If the
window needs to be cleaned, proceed to Step 4.

4. Make a solution of seven parts denatured alcohol and three parts water.

5. Apply the cleaning solution to a cotton swab or lint-free cloth.

6. Apply the cleaning solution to the exit window.

7. Remove any streaks or remaining moisture from the exit window with a
dry, soft, lint-free cloth or lens paper.

8. Turn the reader’s lasers back on.

Verify reader operation. Follow the Operations Checklist procedure in
Chapter 5.
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Cleaning the Trigger Photoeye

If your application uses the photoeye option as a hardware trigger, be sure to
clean the photoeye periodically as outlined below.

1. Turn off the product transport.
2. Turn off the reader’s lasers.

3. Clean the photoeye’s lens using the denatured alcohol solution and a
cotton swab or lens paper. Check the reflector on the opposite side of
the transport.

Clean as necessary.

4. Verify photoeye operation.

SOR1* SYS1ENS

‘l ACCY

B30y
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Cleaning the Tachometer

If your application uses the tachometer option for tracking purposes, be sure
to clean the tachometer wheels periodically as outlined below.

1. Turn off the product transport.
2. Turn off the reader’s lasers.

3. Using a clean, soft cloth, wipe the wheels of the tachometer clean using
a mild detergent solution.

4. Before restarting the system, be sure the tachometer is making good
contact with the product transport.

5. Verify tachometer operation.

Tighten Mounting Hardware

1. Check all reader mounting hardware.
Tighten as necessary. Do not over-tighten.
Be sure not to disturb the reader’s alignment as it relates to the product
transport.

2. Check the mounting hardware of the photoeye and tachometer (if these
options are being used). Tighten as necessary. Do not over-tighten.

Checking Interface Module Connections

All wiring connections are typically made to an interface module.
(See Chapter 3, Installation.)

1. Check all cord grips.
Tighten as necessary. Do not over-tighten.

2. If a cord seems loose, also check the wiring connections to the terminal
blocks. Tighten as necessary. Do not over-tighten.

3. Check all cabling/conduit for signs of wear/damage.
Repair/replace any damaged cable connections as necessary.
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Verify Reader Operation
Follow the Operations Checklist procedure defined in Chapter 5.

If the reader parameters were changed to read bar codes other than the
factory defaults, simply use a good quality bar code to assist in verifying
proper operations. There is no need to return the reader to the default
parameters to perform this test.

Verify Photoeye Operation

1. Block the photoeye beam to confirm it is aligned properly with the
reflector.

2. Ifthe LED on the photoeye changes status, the photoeye is functioning
properly.

Trigger Photoeye — Status LED Location

3. Verify that the Trigger LED on reader is green when photoeye beam is
blocked.

4. If the photoeye’s LED does not change status, adjust the photoeye so
that it is properly aligned with the reflector.

5. If the Trigger LED on the reader is not green when the photoeye’s beam
is blocked, check the cabling between the photoeye and reader
mounting base for damage.

Verify Tachometer Operation

There are two ways to verify tachometer operations.

Use Acculazr User Interface
1. Establish a connection with the reader.
2. Go to Diagnostics > Monitor.

3. Verify the Belt Speed is accurate when the conveyor is running.

Use Tach LED in Enhanced Interface Module
1. Locate the Tach LED.
2. Slowly spin the tachometer wheel.

3. Verifying the tach LED in the mounting base is flashing.

Phone: 800.894.0412 - Fax: 888.723.4773 - Web: www.ctiautomation.net - Email: info@ctiautomation.net



8 Troubleshooting

This chapter provides instructions for diagnosing, troubleshooting and
correcting AccuLazr AL5010 performance issues. It provides specific
information on:

= Test Mode
= |ndicators
= Diagnostics

= Troubleshooting (Problem/Cause/Solution)

Test Mode

In test mode, the AL5010 displays the read rate on the AL5010 control
panel’s bar graph LEDs. The Diagnostics > Monitor window also provides a
read quality bar graph that enables you to monitor the test mode remotely
from a PC connected to your network. Additional details can be obtained by
monitoring from this diagnostic window while the reader is in test mode.

NOTE: Test mode will continue running until you click Stop Test Mode on
A the Monitor screen or press the N button on the back of the reader.

Status Indicators

The AcculLazr AL5010 provides several status indicators that you can use to
troubleshooting performance during operations. They are found at two
locations:

= Control Panel

= Diagnostics > Monitor screen
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Control Panel Indicators

There are several control panel indications on the AccuLazr AL5010
Readers and AL5010 Interface Module.

AEACCU-SORT“ AL5010

@ STATUS et} 5@
® TRIGGER G0 0 40

PURSUANT TO LASER NOTICE 50
. READ DATED JUNE 24, 2007 3
& RX/TX '

@ NETWORK 2@
® LINK 1@

ACCU-SORT SYSTEMS, ING WWWACCUSORTCOM 1-B00-BARCODE  PAT PEND.

AL5010 Reader Control Panel
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AL5010 Interface Module Status Indicator LEDs
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Control Panel LED Fault Detect Descriptions

LED Description

STATUS RED indicates a problem regarding the overall "health" of the
reader.

TRIGGER Indicates the trigger input.

The LED is controlled through software no matter the trigger
source (including software trigger).

READ RED identifies a No Read condition.
Check bar code print quality, trigger configuration, and bar code
parameters.

RX/ITX If bar codes are being read, but the LED is NOT illuminated, data

is not being transmitted on serial port 1.

NETWORK (See Network LED — Fault Detection.)
LINK If the LED is not flashing, there is no network connection.
Bar Graph Read quality indicator (5 = Good, 1 = Poor).
(LED 1 -5) 5=81-100%
4 =61-80%
3=41-60%
2 =21-40%
1 =00-20%

NOTES: Also flashes during parameter upload/backup.

(Laser Shutoff)y  LEDs stay on when Test/Diagnostic button C is pressed during
the laser shutoff procedure.
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NETWORK LED - Fault Detection Only
Mode Description
Single TCP/IP LED is Off — No host connection or UDP messaging is used.
NOTE: If UDP messaging is used (unconnected messages)
the Network LED will be off.
EtherNet/IP Flashing — No connection made with the network
Flashing RED — Lost network connection
Controller/Client  Controller
Flashing RED — All the client(s) with the same group
number have NOT been found or a client’s tracking does
not match the controller.
Client
Off — Not connected to a controller with the same group
number. Match the client to the controller’'s group number.
Solid RED — Client’s tracking does not match the controller.
NOTE: The mode indicated by the Network LED is dependent on the AL5010
configuration you are using. Ethernet/IP is the highest priority, Single TCP/IP mode
operation is the lowest.
NOTE: See Network LED during Normal Operations.

Control Panel Buttons — Uses during Troubleshooting
Ref. Button Description

n Restore to Scan Use to restore a set of parameters from the wiring
Head base to a replacement scan head.
NOTE: This only works if the Backup to Base button
has been used earlier to assure the correct parameters
are stored in the wiring base.

u Backup to Base When it becomes necessary to replace a scan head,
be sure to use this button to download a backup set of
parameters from the scan head to the wiring base. By
doing this, it is easy to configure your replacement
scan head by using the Upload to AL5010 button.

m Test /Diagnostic  Enables the AL5010 test mode.

(Laser Shutoff) (Test mode can also be selected remotely using
Tools > Commands > Test Mode On.)

Use to perform laser shutoff.

NOTE: Keep in mind that the buttons on the reader’s control panel can be
A enabled/disabled through the use of the AcculLazr user interface.

(For details, see Chapter 5.)
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Diagnostics

The Acculazr User Interface includes comprehensive diagnostic
capabilities that monitor reader operation, triggering, conveyor speed,
package and label dimensions, bar code readability, scan rates and
message output.

The Diagnostics > Monitor window is the primary tool used to monitor the
reader's operation and bar code readability in real-time.

The Diagnostics > Log Viewer lets you review the performance logs saved
by the AL5010. The log view field remains empty until you select one of the
three buttons (Read Rate, System Counters, or Message Log).

Update Firmware is used to reload the reader firmware.

Monitor

Status indicators and vital statistics appear on a single screen, enabling you
to effectively and efficiently detect and troubleshoot any problems that may
occur in high-speed laser bar code scanning.

Status LEDs Read Quality
« Bty seitings reni e N RN
B Status Il Network Code Quality (QQ)
_sﬂ\‘ Bfﬂ.ﬂtﬂ Bve W Trigger W o1 Scans/Code -
== B GoodNoRead W 102 Code Postion: 2610 taser1 W [
= Diagnostics B Muitiple codes [l 103 ode Fostion '_ laser? M -
Match 104 .
Monitor L u
Log Yiewer Messag Box Information
3037477262 QQ10 (0A0) B
I.Ipt[ata Firmware 2037477262 Q10 (0M10)
3037477262 QA0 (0A0) Belt Speed (fpm
Wararias peed (om) (TR
3037477262 QG0 (04 0) gettLengtn in)  [EHIR
3037477262 QQ10 (0A0)
3037477262 Q10 (0/10) | coepostonn) (R
<NOREAD> .
3037477262 QG0 (0A0) || Scans/Trigger -
=
[ st [ stop |
M Monitor
023037477 26200104 B
02777727777 A0DI0A
023037477 26200104
023037477 26100104
023037477 2E200M04
02727727277 A0DI0A L
023037477 26 A00M04 =
i@ None 1 Serial Port 1 1 Serial Port 2 i Net Port 1 ) Net Port 2
Start Test Mode

Diagnostics > Monitor (Active)
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Status LEDs
The Monitor status indicators reflect the AL5010 control panel LEDs
functionality as well as additional LEDs such as the Match and I/O LEDs.

Status LED Definitions

LED Definition of Conditions

Conditions

Status

Green Indicates the overall “health” of the reader.

Red Fault condition: Troubleshooting is required.

Trigger

Green Indicates the trigger input. The LED is activated upon trigger

input regardless of trigger source (including software trigger).

Good/No read

Green Indicates a good (valid) bar code has been decoded.
Red Indicates a no-read (or incomplete decode).
Multiple codes

Red Indicates more codes than desired were read.
Match

Green Indicates a code matches the Match Code criteria.
Network

Flashes green or red to indicate connection status. Example: A red Network LED

upon power up could indicate the MAC address was not set at the factory).

= For a Single TCP/IP connection, it indicates that a "host" connection has been
made to the reader.

=  For EtherNet/IP connection, it indicates "network" connection status. This LED
is software controlled.

=  For Controller/Client multi-reader connections, it indicates all inter-reader
communications (i.e., connections between readers) are correctly functioning.

1/0 #1 through 1/O #4
Green Indicates the status of the programmable I/O lines.

Network LED during Normal Operations

Mode Description

Single TCP/IP Solid green — AL5010 connected to a host.
NOTE: If both Host 1 and Host 2 are used, the LED will be solid
green if either port is connected.
Off — No host connection.
NOTE: If UDP messaging is used (unconnected messages) the
Network LED will be off.

EtherNet/IP Solid green — AL5010 made a connection to the PLC
Flashing green — No connection made with the network
Flashing red — Lost network connection

Controller/Client  Controller
Solid green — The correct number of client(s) with the same
group number have been found.
Flashes red — All client(s) with the same group number have
NOT been found
Client
Solid green — Connected to controller with same group number.
Off — Not connected to controller with same group number.

NOTE: The mode indicated by the Network LED is dependent on the AL5010
configuration you are using. Ethernet/IP is the highest priority, Single TCP/IP mode
operation is the lowest.

Phone: 800.894.0412 - Fax: 888.723.4773 - Web: www.ctiautomation.net - Email: info@ctiautomation.net



Read Quality
The Read Quality indicators provide information regarding the bar code that
was read.

Read Quality Definitions
Read Quality Definition
Graph 0-100 The large percentage bar maps to the values
displayed on the reader bargraph. Itis a measure of
“how well” the bar code was read.

Scans/Code Indicates how many passes of the laser (scan lines)
contributed to the reading of the code.
Code Position Indicates the bar code’s position in the AL5010’s scan
(slider) line (from zero to 4095).
Code Quality (QQ) Indicates the QQ (code quality) value for each laser
Laser 1 through 4 that read the bar code.

Box Information

The availability of diagnostic information within these fields depends on
whether tracking is enabled or not. The first three are only available in
tracking and the last one only in triggered, non-tracking modes.

These items are only updated when a trigger occurs. To monitor belt speed
more accurately, it can also be viewed as part of the System Counters in the
log viewer.

Box Information Definitions

Box Information Definition

Belt Speed (FPM) Belt/conveyance speed in feet per minute

Box Length (inch) Box/package length in inches

Code Position (inch) Bar code position on the box in inches

Scans/Trigger Number of scans per trigger cycle
Messages

Diagnostic messages from the reader are displayed here. This is primarily
information on each bar code read.

Message Monitor

The message monitor can be used to monitor the messages being sent from
any of the reader host ports (either serial or network). As with messages,
options for clearing, starting, stopping and logging this information are made
available by right clicking.

Message Monitor Definitions

Message Monitor Definition

(Display Field) Displays the message transmitted

None Select the port to be monitored.

Com Port #1 The AL5010 will not attempt to send messages out
Com Port #2 Net Host ports unless a connection is already

Net Host #1 established.

Net Host #2 Note: Nothing is displayed on Net Host #1 if

EtherNet/IP communications are being used.
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Log Viewer

The Diagnostics > Log Viewer lets you review the performance logs saved
by the AL5010. The log view field remains empty until you select one of the
three most common logs (Read Rate, System Counters, or Message Log)
via the buttons or enter a log request in the Command field.

Log Viewer Commands

There are several commands that you can use to display AL5010
parameters and diagnostic information. Commands can be sent from the
Command field on the log viewer. Commands may also be sent from a
terminal interface, such as a TELNET connection to the AL5010.

Log Viewer Command Descriptions

Display Description

Commands

DISP COUNTERS  Display the System Counter log view.

DISP ENET Display the Ethernet interface status including MAC address.
DISP LASERS Display ALL Lasers log view.

DISP LASERX Display one Laser log view, where Xis 1 — 2.

DISP MSGLOG Display the Message log view.

DISP READRATE Display the Read Rate log view.
Other Commands Description
CLEAR ALL Clears all information from the Message Monitor.

NOTE: All commands can be issued from the Command field. However,
when entering a command in the field, spaces are NOT permitted. As a
result, the display commands need to be entered without a space (i.e.,
DISPCOUNTERS, DISPMSGLOG, etc.)

NOTE: Right-click on log view provides two options: Save LogView to File
(also available from Tools) and Copy to Clipboard.

> P
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Read Rate Log View

For a summary of the AL5010’s overall performance, click the Read Rate
button. You can also enter DISPREADRATE in the command field and click
Send.

ALS010 Log Viewer

DISPENET=18 J
Liak: Active (100mbpz-Full Duplex|

MAC Address: O0:0e:13:03:00:1b

Etiernst MAC 3tats
Tk Ocretcs: 10875897 R¥ Octets: 11543748
Ne: Octets: 39452089

Ethernet MAC Erroras

Rx Align Errors: 0 RE CRC Errocs: u}
Rx Undersized Errors: 0 RE Owversjzed Frames: u}
Bx Jabber Count: 0 BRX No Nec Buffers: 573637612
Rx SOF Owerrun Errors: 0 RX Fragmenta: 0
Ex HOF Owverrun Count: 0 BRY¥ DMA Overruns: o
Tx Carrier Lossas: 0 Tx Collismions: u}
Tx Zingle Coll Errore: 0 TE Hule Coll: o
Tx Excessive Coll: 0 TX Late Collisions: o]
Tx Underrun Errora: o
=H
Read Rate Counters | Messane Log | Ciﬂarl

Command

IDISF' EMET Serd Command |

Use this field to enter and send commands (example: DISP ENET)

Diagnostics > Log Viewer (Read Rate selected)

The Read Rate Log Viewer provides information on the overall read rate.

Overall Read Rate Counters

Read Rate Description

Total Boxes Total number of triggers.

Good Boxes A good box is a box with all required codes. This counter is the
number of good boxes along with the percentage of the total
boxes that were good.

Partial Boxes A partial box is a box were some, but not all required codes were
read. This obviously only applies when the AL5010 is configured
to read multiple codes each trigger.

Bad Boxes A bad box is a box where no codes were read.
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The Read Rate Log Viewer also provides performance information on each
laser. In order to provide diagnostics on the performance of each laser, the

percentages reference here are the percentage of the total codes read by

the particular laser, NOT the percentage of the total packages read by that
laser.

Read Rate Counters per Laser

Read Rate Description
Total Codes Total number of bar codes read.
Laser#x Total number of bar codes read by the particular laser.

For an AL5010 configured as a Controller in a multi-reader network, this
command also provides counters for the number of bar codes read, by laser,
for each AL5010 client. The clients are identified by their reader name as
assigned in Modify > Configuration. (See Chapter 5.)

.E REMEMBER: Not every AL5010 is configured with two lasers.
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System Counters Log View

You can display a number of values and counters that indicate whether the
AL5010 is configured and operating properly by clicking the System
Counters button. You can also enter DISPCOUNTERS in the command field
and click Send.

Scan Rate and Belt Speed System Counters

Description

Scan Rate This is the total number of scans/second that the AL5010 is reading.
Note the this number does NOT take into account “laser toggling” if
it is enabled. If “laser toggling” is enabled, the effective scan rate for
any laser is half of this value.

Belt (tracking) Speed of the belt (in ft/min) as measured by the

Speed tachometer.

Bar Code Counters

Bar Code Description

Counters

Triggers Total number of packages based on the trigger signal. In
self-trigger mode, this will match the number of good reads.

Good Reads Total number of bar codes read and transmitted. If the

AL5010 is set up to read multiple bar codes each trigger,
this counter is incremented for each bar code read.

No Reads Total number of bar codes that were not read.

Mult Codes Total number of instances where more bar codes of a
specific type were read than expected. This counter will also
increment, regardless of whether the AL5010 is configured
to report “multiple codes” as an error.

Match Codes Total number of bar codes that matched any of the Match
Code criteria.
Bad ModChk Total number of bar codes that were rejected due to an

invalid Mod Check.

Error Counters

Error Counters Description

Xfter Ovrflw Transfer Overflow. This counts the number of codes that
were lost due to an overflow in the transfer buffer between
the Decode/DSP processor and the AL5010/ARM
processor.

Xfer BadLen Transfer Bad Length. Number of codes in the transfer buffer
than contained an invalid length, indicating some sort of
memory corruption.

QData@TX Queue Data at Transmit (non-tracking). This counter
indicates that the AL5010 had not completed processing all
of the scan data at the user specified transmit time. This will
only happen if the “transmit time” parameter is set to a value
other than zero. This does not necessarily indicate an error,
but does indicate that either the transmit time is too short or
the AL5010 is seeing a lot of data which may be the result of
too much background noise.

QData@Trig Queue Data at Trigger (non-tracking). This counter
indicates that the AL5010 had not completed processing all
of the scan data prior to the start of the next trigger. This
typically can only happen when the “transmit time”
parameter is set to zero; although it can also happen in
conjunction with a Force Transmit. As with the Queue Data
at Transmit counter, this does not necessarily indicate an
error, but it likely indicates that the AL5010 is seeing a lot of
data which may be the result of too much background noise.
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ForcedTx Forced Transmit (non-tracking). A forced transmit indicates
that the start of trigger occurred before the specified transmit
delay time had expired.

Lost Codes Lost Codes (tracking). If a bar code cannot be placed onto
any package while in tracking, the code is “lost” and this
counter is incremented. Lost codes are also reported in the
AL5010 Monitor message window. Lost code occurances
typically indicate tracking parameters need to be adjusted.

Missed Tx Missed Transmit (tracking). If a bar code is decoded after
the message for that package has been transmitted, the
Missed Transmit counter is incremented.

Decode/DSP Counters
Decode/DSP  Description

Counters

DSP Codes Count of the number of barcodes decoded, per laser, by the DSP.
Scan Ints Number of scan interupts detected by the DSP.

Queue Size Current size of the scan data queue within the DSP. This value

changes dynamically.
Num Cluster Current number of DRX clusters in use by the DSP. This value
changes dynamically.

Bad Scan Count of the number of scans in which the data contained
formatting errors.

Pipe Error Count of internal errors on the transfer of scan data from the scan
data buffer.

Full Scans Number of times a scan could not be added to the scan data
buffer because the maximum number of scans was exceeded.

Mem Full Number of times a scan could not be added to the scan data

buffer because the memory was full.

ScanTooLong Number of times a scan was skipped because it contained too
many ftransitions.

Max Clusters Number of times, the maximum number of DRX clusters was
exceeded.

ARM and DSP Restarts Counters

Description

ARM Restarts  Number of times the ARM processor has restarted. This typically
means the hardware watchdog timer expired causing the ARM
processor to restart.

DSP Restarts  Number of times the DSP processor has been restarted.
Typically, this happens if the ARM suspects the DSP has “locked
up” for any reason.
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Message Log View

The Message Log contains various text messages that have been logged by
the AL5010 software. You can view these messages by clicking the
Message Log button. You can also enter DISPMSGLOG in the command

field and click Send.

The messages contained in this log typically reflect significant events.

Update Firmware

only be performed under the guidance of Accu-Sort Technical Support.

f CAUTION: Used to reload AL5010 reader firmware. This function should

Technical Support.

To Extract Image

1. Click Extract Image

2. In Save as window, save the image
{*.az) files to your computer. The
graphic on-screen indicates Extract
Image is in-process.

3. A message will appear when Extract
Irmage is complete.

Extract Image |

Use Update Firmware to reload the reader firmware.
CAUTION: This function should only be performed under the guidance of Accu-Saort

To Burn Flash

i,
2,

Click Browse button.

In Open window, open an image file
{*.as) to burn to flash, Click Burn
Flash button. The graphic on-screen
indicates Burn Flash is in-process.

& message will appear when Burn
Flash is complete.

Feboot (cycle power) ALS010.

Browse... |
Burn Flash |

Diagnostics > Update Firmware

Extracting an Image:
1. Click the Extract Image button.

2. The Save As window enables you to save image (*.as) files.

Burning an Image to Flash:
1. Click the Burn Flash button.

2. The Open window enables you to open an image file (*.as*)

3. Burn the image file to flash.
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Troubleshooting

The following PCS (problem/cause/solution) tables are designed to assist
you in troubleshooting the more common events that may occur during
installation and operation of your AccuLazr AL5010.

PCS Troubleshooting

Problem The POLARITY LED in the wiring base is RED.

Cause(s) Wiring from the power supply to the INPUT POWER terminal
block is incorrectly wired.

Solution(s) IMPORTANT: DO NOT install the scan head if polarity LED is
RED.
1. Correct the polarity problem by swapping the wires at the
INPUT POWER terminal block.

2. Confirm power polarity is correct ( LED).
3. Install the scan head. (See Chapter 3.)

Problem There is no laser light exiting from the AL5010 when power
is activated.
Cause(s) Have the laser(s) been shut off?
No power is provided to the AL5010.
Solution(s) 1. Check to ensure power is properly connected.
Check to see if AL5010 Status LED turns ON.
Confirm power supply functioning.
Remove AL5010 scan head from wiring base.
Verify Power LED in wiring base is .
If Power LED is RED, polarity is swapped.
If Power LED is OFF, check wiring at the INPUT POWER
terminal block.
Replace the power supply if wiring was correct.
Reassemble AL5010 scan head to wiring base.

Noakrwd

©ox

Problem The AL5010 is not reading bar codes.
Cause(s) Code type is not enabled or wrong code length.
Code passes by at too large an angle (tilt, pitch, skew).
All codes have very poor print quality.
Solution(s) 1. Enable code type or correct code length.
Make sure laser beam is ON when code passes by.
Verify correct bar code parameters are enabled.
Enable TEST MODE. (Use the AL5010 control panel button)
Hold code in the scan line.
Verify the AL5010 is reading the code.
Correct any tilt, pitch, or skew problems.
Remedy bar code printing problems.

ONoOoORLDN
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PCS Troubleshooting (continued)

Problem The AL5010 is experiencing poor read rate.
Cause(s) Poorly printed bar codes.
Scan head window is dirty.
Codes passing by at too large an angle (tilt, pitch, skew).
Solution(s) 1. Confirm the quality of bar code printing is good enough to read.
Correct any print quality issues.
Clean scan head window as defined Chapter 7.
Check reading distance with a known good quality sample bar
code.
Enable TEST MODE. (Use the AL5010 control panel button.)
Hold code in the scan line.
Verify the AL5010 is reading the code.
Correct any tilt, pitch, or skew problems.

wn

No ok

Problem The AL5010 is experiencing poor read rate in hardware trigger.
Cause(s) Photoeye is not adjusted properly or requires alignment.
Solution(s) 1. Verify that the photoeye is blocked the entire time the reader’s
laser is scanning the bar code.
2. Adjust the photoeye as necessary.
(See Verify Photoeye Operation in Chapter 7.)
NOTE: For non-tracking applications only.

Problem HOST is not receiving serial host message.
Cause(s) Improper wiring between host and reader.
Incorrect configuration settings.
Solution(s) 1. Isthe AL5010’s RX/TX LED flashing GREEN?
2. If yes, check the serial cable wiring at the wiring base’s SERIAL
COM terminal block and at the HOST.
3. If no, verify AL5010 trigger input and trigger configuration.
4. View the Message Monitor to verify the AL5010 is transmitting
data from the SERIAL COM port.
(See Diagnostics > Monitor.)

Problem AL5010 reads bar codes, but transmits a NO READ message.
(Tracking Applications Only)
Cause(s) Improper tracking configuration
Solution(s) 1. Check for “Code Lost” messages using diagnostics.
2. If “Code Lost” messages are present, check the tracking
configuration. (See Tracking.)
3. Correct as needed.

Problem Cannot connect configuration PC running to the AL5010’s
Ethernet port.
Cause(s) Improperly configured Ethernet port on configuration PC
Solution(s) 1. Verify network port configuration on PC.
2. Port on PC must be configured for a static IP address.
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Discovering the IP Address

If you don’t know the IP address for the AL5010 unit, it can be found in two
ways.

To Discover the IP Address Using Recovery Mode:
1. Unplug the power to the AL5010 system.

2. Hold down the “I” button on the back of the reader while you restore
power.

3. Release the button. The LEDs should strobe from 5 to 1 and the status
LED will be RED indicating that the unit is in Recovery Mode.

Open a browser and type 192.168.3.100 in the address bar.

The AL5010 recovery screen opens. The screen displays the IP address
for the unit as well as the user name and password for the User

Interface.

Acculazr™

Boctloader Vernon

Syrtem Username 15

Syrem Purwerd o

System [P Address

Clear Parameters m FLASH ¢
Tes CDE RAM

Bebool starmer

Eemel to Upoad

Uphand Hermel

6. Note the IP address for the unit and click REBOOT. The AL5010 reboots
and the AL5010 Login screen opens.

To Discover the IP Address Using a Terminal Emulation Program:

1. Connect a laptop computer to one of the serial blocks in the interface
module (Basic or Enhance) using a serial cable with flying leads (See the
Electrical Installation section of this manual).

NOTE: Make sure the baud rate, stop bits, etc match the serial

port to which you are connected.

2. Launch a terminal emulation program on your laptop computer (i.e.:
HyperTerminal, Tera Term, etc.)

3. Type IpAdDr in the terminal emulation program. If everything is set up
correctly, the IP address will be displayed.

NOTE: Since these processes are performed with a direct
I connection to the individual reader, there are no security
% issues.
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9 Service

There are a limited number of field-replaceable units (FRUs) that are part of
the AL5010. In most cases, components should be replaced with a matching
recommended spare part (RSP).

Service procedures are divided into two skill levels:
= Customer technicians (with some training from Accu-Sort)
= Accu-Sort Trained and Authorized Service Technicians only

All AL5010 accessories and options are considered customer technician
field-replaceable units (FRUSs).

The field-replaceable units (FRUs) are identified in this chapter.

Replacement Procedures

involving, either a dangerous level of voltage, or to warn against an action
that could result in damage to devices or electrical shock. Please follow
necessary procedures as outlined in Chapter 2, Safety.

i CAUTION: This symbol indicates you are about to perform an action

‘ ESD CAUTION: This symbol identifies a procedure that requires you take
‘I o measures to prevent Electrostatic Discharge (ESD) e.g., use an ESD wrist
strap. Circuit boards are most at risk. Please follow ESD procedures as
outlined in Chapter 2, Safety.

External Devices

To replace any external devices, reference the installation procedures
provided in Chapter 3 and Chapter 4.

Field Replaceable Units (FRUs)

Replacement procedures for field-replaceable units (FRUs) that may be
performed by customer technicians are provided with the replacement part.

CAUTION: An end user or systems integrator with basic

A electromechanical and technical skills may perform the removal and
replacement of the field replaceable units (FRUSs) listed below. However,
Accu-Sort training is recommended. Contact Customer Service at 1-800-
BAR-CODE to schedule training that fits your needs.
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FRU Guide Spare Part
Number

Replacement Assembly Descriptions

AL5010 Bar Code Reader

(1) 1000070389 1000067750

Scan Head (1L-SD) 1-laser, standard density

1000067751

Scan Head (1L-HD) 1-laser, high density

1000067752

Scan Head (1L-NHD)  1-laser, near focus, high density

1000067753

Scan Head (2L-SD) 2-laser, standard density

1000067754

Scan Head (2L-HD) 2-laser, high density

A\

NOTE: For Adjustable Raster versions or units with custom
software installed, please contact Customer Service at 1-800-BAR-
CODE to obtain your correct field replaceable units. Please have the
unit serial number or order E-number available when you contact
Accu-Sort.

(2] 1000070388 0111623001

Mounting Base 1-meter cable

0111623002

Mounting Base 3-meter cable
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FRU Guide Spare Part Number  Replacement Assembly Descriptions

AL5010 Interface Module

(3] 1000070391 0111631001 Basic Interface Module
Trig, Ethernet, (1) serial port (RS232/422 selectable)
(4] 1000070384 0111633001 Enhanced Interface Module with DeviceNet
Tach, Trig, Ethernet, (2) serial port (RS232/422 selectable), (4) I/O
0111633002 Enhanced Interface Module with DeviceNet
Tach, Trig, Ethernet, (2) serial port (RS232/422 selectable), (4) I/0
0111633003 Enhanced Interface Module with Profibus
Tach, Trig, Ethernet, (2) serial port (RS232/422 selectable), (4) I/O
1000070385 1000068248 DeviceNet Replacement Module (Anybus-IC 32-pin)
1000068247 Profibus Replacement Module (Anybus-IC 32-pin)
1000070386 1000056135 DC Input Module (White): 3.3-32 VDC (32 mA)
1000056136 DC Output Module (Red): 3-60 VDC (3 A max.)
1000056137 AC Output Module (Black): 12-42 VACPeak (3 A max.)
Other FRUs
1000070387 1000020569 Trigger Photoeye, flying leads
1000070390 1000066479 Tachometer, programmable, 8-30 VDC
N/A 0111628001 Power Supply 40 Watt, 12 VDC

Phone: 800.894.0412 - Fax: 888.723.4773 - Web: www.ctiautomation.net - Email: info@ctiautomation.net



132 Service AcculLazr™ AL5010 Product Line Manual

Notes:

Phone: 800.894.0412 - Fax: 888.723.4773 - Web: www.ctiautomation.net - Email: info@ctiautomation.net



Specifications

AcculLazr™ AL5010 Technical Specifications

ASEE

Characteristic

Description

Name

Mid Range Laser Bar Code Reader, AccuLazr™ AL5010

(1) Scan Head* Line Scan Min Bar (mil) Depth of Field mm [inch] Scans/ Second
Part Number
1 Laser, Standard Density 1000067750 14-20 279.4[117] 700-1200
1 Laser, High Density 1000067751 7-13 228.6 [97] 700-1200
1L, High Density, Near 1000067757 7-13 127.0 [57] 700-1200
Focus
2L, Low Density, High Pitch 1000067753 20+ 838.2 [33"] 600/laser
2 Laser, High Density 1000067754 7-13 838.2 [33"] 600/laser
Optional Adjustable Raster 1000071308 Adjustable 20° above and below 0° (center); oscillating mirror

(2) Mounting Base/Cable
Size
Weight

Enclosure
Temperature

Relative Humidity
Laser Type
Power Requirement
Power Consumption
Visual Indicators (LEDs)
Bar Code Types
Connectors (Mounting Base)
Communications

Options

Reliability
Service Options
Warranty
Compliance

1 meter cable (0111623001); 3 meter cable (0111623002)

H 104 mm [4.10"] x W 130.8 mm [5.15"] x D 49.9 mm [1.96"]

Scan Head: 0.45 kg [1.0 Ib] Mounting Bracket: 0.14 kg [0.3 Ib]
Mounting Base: 0.25-0.34 kg [0.56-0.75 Ib]

Powder-coated cast aluminum, high-impact plastic, rated for IP65

Operating: 0° to +40° C [+32° to +104° F]
Storage: -20° to +70° C [-4° to +158° F]

10% - 90% non-condensing

Visible laser diode 650 nm (Class 1)

12-28 VDC (power supplies available from Accu-Sort)

< 25W

Status, Trigger, Read, RX/TX, Network, Link; read quality (5 LEDs)

All standard 1D symbologies

15-pin “D” Scanner connector, RJ45 connector for Ethernet

On-board EtherNet/IP, Ethernet TCP/IP, Serial RS232/RS422,
4 programmable /O relays, DeviceNet, Profibus
(see Acculazr Basic and Enhanced Interface Module datasheets)

Universal Mounting Bracket (0111620001)
Basic and Enhanced Interface Modules (see datasheets)

> 50,000 hours MTBF @ 25° C [77° F]

Installation assistance and on-site training

1-year limited, parts and labor

UL, cUL, FCC (Class A), 21CFR1040, IEC-60825-1,CE, C-TICK

Accu-Sort reserves the right to change product specifications without notice.
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Acculazr™ Basic Interface Module Technical
Specifications

Characteristic Description
Name _AcculLazr™ Basic Interface Module (0111631001)
Size H92.5 mm [3.64"] x W 136.4 mm [5.37”] x D 65.0 mm [2.56"]
Weight Basic Interface Module: 0.317 kg [0.7 Ibs]
Power Supply: 0.498 kg [1.1 Ibs]
Temperature Operating: 0° to +40° C [+32° to +104° F]
Storage: -20° to +70° C [-4° to +158° F]
Relative Humidity 10-90% non-condensing
Enclosure High-impact plastic, rated for IP54
Power Requirements 12-28 VDC (power supplies available from Accu-Sort)
Power Consumption <25 W (max.)
Power Supply 12-28 VDC (< 25W) (0111628001)
Power Cord: 125V, 10A, 2.3 meter [7.6 ft] long (0102414001)
230V, 10A, 2.4 meter [8.0 ft] long (0102713001)
Visual Indicators LEDs — Power, Trigger
Connections Terminal Blocks rated for 16-24 AWG wire
Standard RJ45 and 15-pin ‘D’ connections from mounting base
Communications _ Ethernet, Serial RS232/RS422 (selectable)
Reliability > 50,000 hours MTBF @ 25° C [77° F]
Service Options Installation assistance and on-site training
Warranty  1-year limited, part and labor
Compliance UL, cUL, FCC (Class A), 21CFR1040, IEC-60825-1, CE, C-TICK
(See Compliance table in this appendix.)
Accu-Sort reserves the right to change product specifications without notice.

Acculazr™ Enhanced Interface Module Technical
Specifications

Characteristic Description
Name AcculLazr™ Enhanced Interface Module
Size 133.6 mm [5.26"] H x 191.4 mm [7.54"] W x 67.0 mm [2.64“] D
Weight Enhanced Interface Module: 0.589 kg [1.3 Ibs] (no 1/0 modules)
Power Supply: 0.498 kg [1.1 Ibs]
Temperature Operating: 0° to +40° C [+32° to +104° F]
Storage: -20° to +70° C [-4° to +158° F]
Relative Humidity  10-90% non-condensing
Enclosure High-impact plastic, rated for IP65
Power Requirements Input: 12-28 VDC (power supplies available from Accu-Sort)
Power Consumption <25 W (max.)
Power Supply 12-28 VDC (< 25W) (0111628001)
Power Cord: 125V, 10A, 2.3 meter [7.6 ft] long (0102414001)
230V, 10A, 2.4 meter [8.0 ft] long (0102713001)
Visual Indicators _ LEDs — Power, Trigger, Tach, RX/TX1-2, DeviceNet, Profibus, 1/0 1-4
Connections  Terminal Blocks rated for 20-24 AWG wire (power is 16-24 AWG)
Standard RJ45 and 15-pin ‘D’ connections from mounting base
Communications Serial RS232/RS422 (2), Ethernet TCP/IP, DeviceNet, Profibus and
up to 4 programmable I/O relay modules
Options Tachometer: Programmable, 8-30VDC, 20 ft. cable (1000066479)
General Mounting (1000020567)
Extrusion Mounting (1000020568)
Photoeye: incl. hardware/reflector (1000020569)
I/0 Modules: Input 3.3-32VDC (1000056135)
Output 3-60VDC (1000056136)
Output 12-42VACPeak (1000056137)
Reliability > 50,000 hours MTBF @ 25° C [77° F]
Service Options _ Installation assistance and on-site training
Warranty 1-year limited, part and labor
Compliance UL, cUL, FCC (Class A), 21CFR1040, IEC-60825-1, CE, C-TICK
(See Compliance table in this appendix.)
Accu-Sort reserves the right to change product specifications without notice.
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Power Supply for AL5010

Characteristic

Description

Dimensions

L 4.65" [118 mm] x W 1.36” [34.5 mm] x H 2.05” [52 mm]

Weight

0.6 Ibs. [0.275 Kkg]

Temperature

Operating: 0° to +70° C
Storage: -40° to +85° C

Relative Humidity

5-95% non-condensing

Enclosure

ABS plastic, Rated for IP40

Power Requirements

Input: 90-264 VAC / 0.5A typical, 1.0A max. @ 120 VAC
Output: Max. 250mA Load

Power Consumption

<40W

Connections

Male IEC (available with either domestic or international power cord)

Compliance

UL, cUL, CE, FCC (Class A)  (See Compliance table.)

Output Modules

Part Number 1000056136 1000056137
Maximum Line Voltage 60 VDC 42 VAC
Minimum Line Voltage 3.0 VDC 12 VAC
Maximum Peak Off State Voltage 60 VDC 42 VAC peak
Maximum Peak Off State Leakage 1.0 mA 2.5 mA RMS
Static off-state dv/dt - 200 Vl/usec
Maximum On-State Current 0.5ADC 0.5 ARMS
Minimum On-State Current 10 mA DC 50mA RMS
Maximum 1 Cycle Surge -- 4 A peak
Maximum 1 Second Surge 1.5ADC --
Peak On-State Voltage 1.5V DC 1.6 V peak

A\

*NOTE: Relay modules are only for connection to SELV, LPS power source and shall also meet
the requirements for Class 2.

Input Module

Part Number 1000056135 *
Maximum Input Voltage 32 VDC
Minimum Input Voltage 3.3VDC

Input Resistance 1 k ohm
Maximum Input Current 32mA DC@ 32 VDC
Drop Out Current 1.0mADC
Allowable Off—State Input Current 1.0mADC
Allowable Off-State Input Voltage 2.0 VDC

* NOTE: Compatible with TTL level voltages.
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Certifications

UL Listing
M

UL Listed
UL Listed to Canadian safety standards
Standard to which conformity is declared:

EN60950: Test Spec: IEC 60950 3RD Edition / (2000) (Information
Technology Equipment (I.T.E.), Including Electrical Business Equipment

Standards to which conformity is declared:

FCC 47 CFR, Part 15, subpart B, “Unintentional Radiators”
CLASS A Radiated Emissions and CLASS B Conducted Emissions

Standards to which conformity is declared:

1 Emissions

EN 61000-6-4: 2001
CISPR 11:1999 Radiated Emissions — Class A
CISPR 11:1999 Conducted Emissions — Class A

2 Immunity

EN 61000-6-2: 2001 Electromagnetic Compatibility - Generic Standards -
Immunity for industrial environments

EN 61000-4-2:1995, Electromagnetic compatibility (EMC), Electrostatic
discharge immunity test

EN 61000-4-3: 2001, (EMC), Part 4 - Section 3: Radiated, radio-frequency
electromagnetic field test

EN 61000-4-4:2004, (EMC), Electrical fast transient/burst immunity test
EN 61000-4-5:1995, (EMC), Part 4 - Section 5 Surge immunity test

EN 61000-4-6:2003, (EMC), Part 4 - Section 6 Immunity to conducted
disturbances, induced by radio-frequencies

IEC 61000-4-11: 2003, (EMC), Part 4 - Section 11 Voltage dips, short
interruptions & variations immunity

IEC 61000-3-2 A14, 3/2000 and 61000-3-3: Harmonic current emissions
Fluctuating and Steady State Harmonics)

ENV 50204: 1995, "(EMC), Radiated, Electromagnetic Field From Digital
Radio Telephones-Immunity Test"

V)

C-TICK: N2468, DATALOGIC AUTOMATION PTY, Australia / New
Zealand

Phone: 800.894.0412 - Fax: 888.723.4773
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Read Charts

How to identify the scan head model:

The model type is shown on the serial label.

AEACCU-SORT' AL5010

STATUS
TRIGGER
READ
RX/TX

3
NETWORK . '

LINK 1

AC SYS T AUt

1L — Indicates a scan head that is using one laser.

2L - Indicates a scan head that is using two lasers.

SD - Identifies a standard density scan head for reading bar codes with
minimum bar/space widths of 15 mil+.

HD - Identifies a high density scan head for reading bar codes with
minimum bar/space widths of 10 mil+.

NHD - Identifies a near focus, high density scan head for reading bar
codes with minimum bar/space widths of 10 mil+.

IMPORTANT: All read charts are subject to change without notice.

from 4 to 20 inches. Please contact Accu-Sort Systems for details relating
to your application.

'I NOTE: An Ultra-Near Focus model is also available with a depth of field
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Combo Read Chart /| Table

Inches Millimeters

[100]

[200]

[300]

[400]

[500]

[600]

[700]

[800]

[900]

[1000]

[1100]

-~ [1200]

50 i 1 1 |
15 10 5 0  [100] [200] [300]

1,200 scans per second (standard) throughout DOF Pitch not greater than +/- 15 °
ANSI Contrast Grade 84% or greater Skew not greater than +/- 15 °
ANSI “Grade A” Print Quality Tilt not greater than +/- 45 °
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AL5010-1L NHD: 1 Laser, Near Focus High-Density
Scan Head Part Number 1000067752

10 mil code

Inches Millimeters
4
101.6
5 LR k2]
5] f 5 b —[152.4
7 (1224} - [177.8]
8 P [203.2]
[101.6]
™,
3 2 0 [508][76.2]
1,200 scans per second (standard) throughout DOF Pitch not greater than +/- 15 °
ANSI Contrast Grade 84% or greater Skew not greater than +/- 15 °
ANSI “Grade A” Print Quality Tilt not greater than +/- 45 °
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AL5010-1L HD: 1 Laser, High-Density
Scan Head Part Number 1000067751

10 mil code

Inches Millimeters
<]
i [524] SEE
10 # 121;5&] - i [234]
12 6 ES{M.B
13 - (152.4] 330.2
] 3 0 [76.2] [127]

1,200 scans per second (standard) throughout DOF
ANSI Contrast Grade 84% or greater
ANSI “Grade A” Print Quality

Phone: 800.894.0412 - Fax: 888.723.4773 - Web: www.ctiautomation.net - Email: info@ctiautomation.net

Pitch not greater than +/- 15 °
Skew not greater than +/- 15 °
Tilt not greater than +/- 45 °



AL5010-1L HD: 1 Laser, High-Density

Scan Head Part Number 1000067751

14 mil code
Inches Millimeters
6— —[152.4]
12— — [304.8]
14 [355.6]
16 2052 - [406.4]
- | | h-\-""\-\.
6 43 0 [76.2][101.6][152.4)
1,200 scans per second (standard) throughout DOF Pitch not greater than +/- 15 °
ANSI Contrast Grade 84% or greater Skew not greater than +/- 15 °
ANSI “Grade A” Print Quality Tilt not greater than +/- 45 °
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AL5010-1L HD: 1 Laser, High-Density

Scan Head Part Number 1000067751

20 mil code

Inches Millimeters
i
4 —[101.6]
|
12— ~—[304.8]
15— — [381]
17— [431.8]
[
{
< | B I N
6 4 1 0[254][101.6][152.4]
1,200 scans per second (standard) throughout DOF Pitch not greater than +/- 15 °
ANSI Contrast Grade 84% or greater Skew not greater than +/- 15 °
ANSI “Grade A” Print Quality Tilt not greater than +/- 45 °
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AL5010-1L SD: 1 Laser, Standard Density

Scan Head Part Number 1000067750

15 mil code
Inches : Millimeters
9 — [228.6]
15— —  [381
16 | [406.4
1
20— — [508]
1
g | I ™
8 4 0 [101.6]  [203.2)
1,200 scans per second (standard) throughout DOF Pitch not greater than +/- 15 °
ANSI Contrast Grade 84% or greater Skew not greater than +/- 15 °
ANSI “Grade A” Print Quality Tilt not greater than +/- 45 °
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AL5010-1L SD: 1 Laser, Standard Density

Scan Head Part Number 1000067750

20 mil code
Inches . Millimeters
7~ - [177.8]
17 431.8
18 — 457.2
23— -[584.2)
i
i ¥
2 1 ! L | 1
| |
D R I R N
10 6 3 0 ([76.2] [127) [228.6]
1,200 scans per second (standard) throughout DOF Pitch not greater than +/- 15 °
ANSI Contrast Grade 84% or greater Skew not greater than +/- 15 °
ANSI “Grade A” Print Quality Tilt not greater than +/- 45 °
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AL5010-2L HD: 2 Lasers, High Density

Scan Head Part Number 1000067754

10 mil code
Inches - . Millimeters
7— [177.8]
18— — [457.2)
21 533.4
22— — |558.
I I . | | ™
9 6 3 0 [76.2] [1524] [228.6)

1,200 scans per second (standard) throughout DOF Pitch not greater than +/- 15 °

ANSI Contrast Grade 84% or greater Skew not greater than +/- 15 °

ANSI “Grade A” Print Quality Tilt not greater than +/- 45 °
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AL5010-2L SD: 2 Lasers, Standard Density

Scan Head Part Number 1000067753

15 mil code
ety % Millmeters
7 [177.8]
24 ~ [609.6]
40 — J99%0.
41— — [10186.
i
|
z [ | | %
12 10 3 0 [762) [254] [304.8)
1,200 scans per second (standard) throughout DOF Pitch not greater than +/- 15 °
ANSI Contrast Grade 84% or greater Skew not greater than +/- 15 °
ANSI “Grade A” Print Quality Tilt not greater than +/- 45 °
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AL5010-2L SD: 2 Lasers, Standard Density

Scan Head Part Number 1000067753

20 mil code

Millimeters
~ [152.4]
= [711.2]
— [1143.0)
| | =08 0l | —[1219.2)
Fd I I I N
14 10 3 0 [762) [254.0]  [355.6]
1,200 scans per second (standard) throughout DOF Pitch not greater than +/- 15 °
ANSI Contrast Grade 84% or greater Skew not greater than +/- 15 °
ANSI “Grade A” Print Quality Tilt not greater than +/- 45 °
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AcculLazrm User Interface

This appendix provides tables of parameter definitions and descriptions for
each screen provided in the AcculLazr User Interface.

Acculazr™ —re—

ALS010 Login

User 1D
Password
Language | ENGLISH "I

Log O

ACCU-SORT

Acculazr User Interface Login Screen (current version 6.0)

AL5010

Acculazr™ — uo e

Hodify Settings
Canlfiguratinn
Bar Codes
Modula Checks
Siripping dding
Match Codes
Serlal Communications
Serial Part 1
Serial Part 7
Metwork
Trigger
Relay
Tracking
FAST Monitor
Advanced
Save/Retricve
Diagrostics
Fanitor

Log Viewer

Update Firmware

ACCU-SORT

Acculazr User Interface Homepage

j IMPORTANT: Step-by-step procedures are provided in Chapter 5.
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Modify Settings

Lse the Modify Settings menu tree selections during initial setup to
configure your ALE010 Mid-Range Laser Bar Code Reader. If necessary,
vwou can later make modifications to the reader's configuration using the
same menu selections, including:

s Bar Codes / Bar Code Groups
+ Modulo Checks

s Stripping and Padding

+ Match Codes

e Serial Communications

e Metwork Communications
» Iessage Definitions

e Trigger

» Relay

e Tracking

» FAST Monitor Setup

*» Advanced Settings

For additional information, click the 2 button

Modify Settings

The Modify Settings main page describes the items available in its menu
tree.
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Modify Settings > Configuration

Readar Information
Reader Name

Software Name/Revision

I AL=010 [ AL5010 [ 1261
Reader Modal Decode Software Name/Revision
| 2L Standard Density | DRASTD | 1.4{z9)
Sernal Number FEGA Device Id/Ravision
I 27 [ 0:3c40 BECEE
Configuration Options Control Panel Options
Scan Rate (600-1200) W W Enable Cantral Panel Buttons
Field of Wiew (2-54 degrees) R [Use Button | For Test Mode =l
NOTE: Modifying the scan rate from the iacmr_v Network Access Options

setting gan adversely affect the ALS010

performance. Usernarme Ff-—
™ Enabled Trigger/Track Controlled Laser B A ] =
Units [EncLISH =] | Confirm Password -

Update Reset

Modify > Configuration Descriptions

Selection Definition
Reader Reader Name — User-defined reader name (up to 15 characters).
Information Useful when it is necessary to identify multiple AL5010 readers

within the same building or application.

Reader Model — Displays the model of the reader (AL5010-IL,
AL5010-2L, etc.).

Serial Number — Displays the serial number of the reader.

Software Name/Revision — Displays the installed software name
and revision number.

Decode Software Name/Revision — Displays the installed decode
software name and revision number.

FPGA Device Id/Revision — Displays the FPGA (field-
programmable gate array) device name and revision number.

Configuration
Options

Scan Rate (600-1200) — Allows you to change the scan rate.

WARNING: Modifying the scan rate from the
& factory setting can adversely affect the AL5010
performance.
NOTE: Changing scan rate and then saving
A parameters causes the AL5010 to reboot.
Field of View (2-54 degrees) — The field of view may be defined
within stated parameters.

Enabled Trigger/Track Controlled Laser — Enabling this function
results in the following:

» Non-Tracking: Lasers turn off whenever "trigger" is not
active.

» Tracking: Lasers turn off whenever the belt speed is zero or
a package has not been detected for two minutes.
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Units — Drop-down list allows the units of measure to be set as
either English or Metric.

Control Panel Enable Control Panel Buttons — When enabled, select one of the
Options following modes from the drop-down list:
* Use ! Button For Test Mode: Activate the test mode by
pressing the "!" button.
» Use ! Button to Learn Match Code: Unit operates in Test
Mode, but the last code read is also stored in the match
code table.
» Use ! Button for Sleep Mode: Holding the ! button down
for seven (7) seconds will put the AL5010 into sleep mode.

NOTE: The “! Button” refers to the button on the
A back of the AcculLazr bar code reader.

Network Username — Enter the username
Access
Options Password — Enter the password

Confirm Password — Re-enter the password to confirm and set
the new password.
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Modify Settings > Bar Codes

Bar Code s
Salactad Bymbologias
| Symbilagy Cuide Labint | Hin Lepth Man Lenpth | oo Quattity | ran Quantity
r|Code 122 [Cede 128 3 B 0 fi
F e E s s [0FC E (12 Chrarsctrs) | 12 [z I fi
r [ ndabar 12 hz " I
Strip Function Characters [
MaowUp | MoeDown | Remow
Learn Bar Code
Chck Loarn and then hold the bar code in the scan line to add to the Selected Symbologies list Leam
Bymbology Type
cCode Typa  |Codabe =l Code Lsbel |Codabar 1
n Minimum Langth |22 Minimum Cuantity |l |
‘l ‘ I H | ‘ ‘ H| Mawmum Length 12 Marimum Cuantity |l
01313056707 Filker | Modulo Check  [Hone v
| Add
Upclata |  Resat ||

Modify > Bar Codes Descriptions (Bar Code Tab)

Selection Definition
Selected Symbology Grid — Displays added bar codes with columns for
Symbologies Symbology, Code Label, Min Length, Max Length, Min Quantity,

and Max Quantity.

Strip Function Characters — Select to enable. When enabled,
function characters are stripped out of the bar code.

Learn Bar Code Click Learn and then hold the bar code in the scan line to add to
the Selected Symbology to the Symbologies listed.

Symbology Type Code Type — Select a code type from the drop-down list

Minimum Length — User-defined minimum bar code character
length.

\ NOTE: Some bar codes have a fixed character
ﬂ length that may not be modified.

Maximum Length — User-defined maximum bar code character
length.

\ NOTE: Some bar codes have a fixed character
ﬂ length that may not be modified.

Filter — User-defined bar code filter. This allows a “match
pattern” to be specified for a bar code definition. This restricts
this code definition to only bar codes that match this pattern.

* Example: Setting “9*” as a filter defines that only bar
codes that start with a nine will be accepted. Only one ™'
may be entered in the Filter field.

Code Label — User-defined name for the selected bar code.

Minimum Quantity — User-defined minimum quantity for the bar
code.
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Maximum Quantity — User-defined maximum quantity for the
bar code.

Modulo Check — Select the Modulo check digit setup from the
drop-down list. Selections include Modulo 10, Standard Mode
43, and User Defined.

Filters
Coda Fllters
[ Gadniabe | Pilker
-Cndu 128 I—
UPC E (12 Gharactersy ||
Codabar N

Lipdate Mi

Modify > Bar Codes Descriptions (Filters Tab)
Selection Definition
Code Filters Displays user-defined bar code filters added on the Bar Code
tab in a grid. The Code Filters grid displays columns for Code
Label and associated Filter (if applicable).

Bar Code Group

R o L com

5

C-RE- RENE. B RS SRR

=
)

AT NCH TR T TR

T o
.|

HOCH O T TR R T T T

ral
Bl

Modify > Bar Codes Descriptions (Bar Code Group Tab)
Selection Definition
Grid View Displays the defined bar codes along with a column for Groups
No. Select check boxes to define bar codes included in a
number group.

When more than one bar code type is defined in Bar Code
Setup, the Bar Code Groups selection becomes available.
This enables you to define the valid “groups” of bar codes that
are to be transmitted together.
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Modify Settings > Modulo Checks

user Defined 1
Factors
a1

User Defined 2

Factors

User Defined 3

Factors

User Defined 4

Factors

User Defined 5

Factors

Divisor {1-255)

10 ™ Remain ™ Right ™ Wrap I Add
Divisar (1-255)
1 [ Ramain " Right I Wrap [ Add
Divisor {1-255)
1 ™ Reman I Right I~ Wrap " Add
Divisor {1-255)
1 [~ Remain I" Right I Wrap I add
Divisor {(1-255)
1 ™ Remain I™ Right ™ Wrap ™ Add

Updlate RBeset

Selection

Definition

User Defined n

Factors — Define weighting factors for determining mod check
value.

« Example: Enter 31 for a 3-to-1 weight.

Divisor (1-255) — Defines a divisor (i.e., number from 1-255) that
is divided into the mod check sum.

Remain —
» Checkmark = check digit is remainder of the divided
amount.
* No checkmark = the number that must be added to the
remainder to get the divisor

Right —

» Checkmark = Weight string begins from the right
* No Checkmark = Weight string begins from the left

Wrap — If the remainder of the check digit is calculated to be 0:

« No checkmark = accept 0 as check character
e Checkmark = replace the 0 with a 1

Add - Select to add the most significant digit to the mod check.
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Modify Settings > Stripping/Padding

Bar Codes

Available Bar Codes ICnrﬂe 128 vI Code Position=1
Min Length=8
Max Length=8
Character Stripping

€ Transmit All

@ Strip Selected Character |

Specify the numbers of the characters to be removed (E can be used to specify
the end). To remove the first or last characters, an F or L can also be specified
along with the number of characters to remova.

For example: F3,5,7-12,L5 will remove the first 3 characters,character 5,character
7 through 12 and the last § characters of the bar code. 4-E will strip off evary
charcter from position 4 to the end of the bar code.

Characters Padding Before and/or After The Bar Code
* No Padding

C Add Padding "I”I]m“l l

" Pad before bar code by repeating a ﬁ
single character to a fized length Bar Code Length 0

" Pad after bar code by repeating a . ﬁ
single character to a fixed length Bar Code Length g

Update | Reset

Selection Definition

Bar Codes Available Bar Codes — Select a bar code from the drop-down
list. The Code Position, Min Length, and Max Length are
displayed for the selected bar code.

Character Transmits all — Select this option and no characters are
Stripping stripped.

Strip Selected Characters — Select this option to strip our
selected characters.

« Example: To strip the first and last character of a code
(such as for Codabar w/o start and end) specify F1,L1 for
the character stripping.

Characters No Padding — Select this option if no padding is required.
Padding Before

and/or After The Add Padding — Select this option to add a fixed string of

Bar Code characters to the beginning and/or end of the bar code. The
character(s) to be added as padding must be entered in the
field next to the Add Padding option group button.

Padding Before bar code by repeating a character for a fixed
length — Select this option to repeat a specified character before
the bar code to create a string of the length specified in the Bar
Code Length field.

Padding After bar code by repeating a character for a fixed
length — Select this option to repeat a specified character after
the bar code to create a string of the length specified in the Bar
Code Length field.
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Modify Settings > Match Code Pattern

Match Code Pattern
Match Code Pattern 1 |

Match Code Pattern 2 |

Match Code Pattern 3 |

Match Code Pattern 4 |

Match Code Pattern 5 |

Match Code Pattern 6 |

Match Code Pattern 7 |

Match Code Pattern 8 |

Match Code Pattern 9 |

Match Code Pattern 10 |

String matching pattern explanation : "*" represents a string with arbitrary length, "?*
represents a single character. Example: ABC™® ,ABCT7FG,77123 and etc...

Update | Reset I

Selection Definition
Match Code Match Code Pattern n — Enter match code patterns in the space
Pattern provided.

All bar codes are compared to the complete list of Match
Codes. If a bar code matches ANY of the codes defined in
Match Code settings, it is considered a MATCH. When a match
code is read, you can setup your reader to:

« fire a relay output (Example: Activate a diverter)

» send a user-defined message (Example: Acknowledge
match code found)

b USEFUL TIP: If ANY match code pattern is set to
A “** ALL codes will match it
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Example Match Code using a 6 character code 39
selected in Modify Settings>Bar Codes:

Fadify Setmnge far Coils ]
Ll i i
B Lo
mediie theits [} wmbeber el e e et R Guastity | e Quaniy

Bt aidding | 'E“ﬁ___ r-;;_‘ i'____ E'.__ "'______ F___

Fndith fadrs T —

Arrial Lunmuni stinns

Serial Pert | Lonsw Bar Codo

Revinl Purd 2 Click Leam and then bold the bar onde in the scen bne 1o add fo the Selected Sp=bologes It L I
:._‘ Hymhobogy Tyme
‘.T Code Typs  [interemved2mn = Code Lsbel frtedsavedsofs |
Trazking Miisilan Lamgeh 10| Mg QUantity L |
e LT —— e —

1234367899 Finsr [ Mecus Cheet [lore =]
e There will be two bar codes used:

Lay Viewer AZTEST A I
Mpilabe ¥

el BZTEST F Updste | Gt |

- | The match condition will be set to
the AZTEST code

Without any match code enabled the host message data will consist of the
data found in the bar code.

In this example the data in the host message will be “AZTEST".

Serial Part 2 | MBSLERE Fas Wafad il b
Fertmark | etaried
Tregger | Teesd Wode Endares
| REadRste= 1% O0 300200 Bcena 1 2717 Distance: 28 Code AZTEST Belt 5 ’ -
Belay Mo L I -
Trmikimg g
FAST Mupriar Coile Posifion fi) -
Advanzel SeameTrigger -
Savr Etrieve m
e - Monitor Dt s e ]
:llllll;:l' Sta I"l'E‘ﬂ
gkl Wevnagie Motiies
Update Firmmars | Btaried HITE ST
| azTEET
' Moma o Raris Port 1 Sarigharl 2 et Pt Nt Pt ¥

This example is set to match any bar code that begins with AZ. The *
indicates that any data after the AZ will be accepted.

= Modify Settings

Match Code Pattern
Match Code Pattern 1

Configuration

Bar Codes
Modulo Checks

Match Code Pattern 2
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| = Modily Settings

Configuration
Bar Codes
Madulo Checks
Btripping S Fadding
Hatch Codes

| . Serial Commanications

Seral Port 1

| Soral Port 2
tietwork

| Trigger

: Relay
Tracking
FAST Manitor
Advanced

Sawve fRotricve

| Diwgrnstics

i Mbnikir

|

Log ¥iewer

Hodity Settings
Ewnfrperatinn
Har Cosles
Maduln Cheths
Stripping/Padding
Hatch Cndes
- Serial Comisunicslasmn
Berial Purt §
Serial Pore T
Hatimark

Trigger

Beliy

+ Enter the following options in the Message Definition —Port # 1 field
- Serial Port # 1 Messages

* Read
- Setto “No Message”
+ Match
- Enter appropriate option
»  This example will send the bar code
data
- Set match to “Send Barcode”
*  No Match
- Set to send “!” when the bar code doesn’t

match

S G message Definitions - Port 1 |

Serlal Port 1 Framing
Header |

Sequence [No Sequence No =]
Check Digits [None =]

L

Read message set to
“No Message"

Trader [

F Inciude all Bar Codes In One Messags

—

Power Up/Connect Message

Serial Port 1 Messages

Bead Maone -i
Mo Read mﬂhﬁ L

Mudtipl= Bar Code  [Mone -]

Match message set to

g

Match Send Bar Code 7] *“Send Barcode”
Ho Match [Repeat Charscier =] |

Mo Match Read

[ Mne

No Match message set
tn ll-!'!l

The AL5010 with the relay options can also be set to react to the Match or

Relay #1 set to
*Match Output”

No Match condition.
Dutput Hlignal Duratien (ms)

:1||nm = Boo

140 1 Configuration
[U!rﬂ a8 oulput =] |Mlbl:|'l Oiutput

10 2 Configuratbon
[u-:-u s output :—[ [Nu Mlaich Cutpot

Gutput ignal Dural en (s}
- Imm H:"r.ﬂ Fal:ll:l

|'hlul‘ i use -

140 4 Contiguration
Mot in use bl

Relay #2 set to
“No match Output”
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- Madity Saitings

Canfiguratian

Bar Cailes

Madola Checks

Strtpping S Padding

Flatch Codes

= Seral Communicataons

Serial Port §
Serial Port 2

rigtwnrk

Trigyer

Hielny

Trme kring

FAST Mandtar

Advanced

Save/Relrieve

» BHagrasiics

Planiial ar

Loy ¥iewer

lipdate Firmeare

Fandesr Hamar &L%

Livivliguiratinn

Har Laides

HModuln Checks

Stripping S Padaing

Btateh Cndes

= Serial Communications

Kwital Dot |
Serial Port 7

setwnrk

Triguer

Helay

Trakkbng

FAST Maonilnr

Advanced

Save fliletrimve

= Dlagnestics

*enitor

Log Viewes
Update Firmware

Reader Marai &LIELE

MATCH Results

AL5010 identifies the data as a
MATCH

Code Posfiod (.}

scanstonger (I

Statis LEDs Relay #1 fired
mem
B Stabus K .
W Trigger 1 Seans Coile - . o
B GoodMo Read 2 Loseri -
B Mutpiecoses W 103 Code Position : 23710 B
B Match T — i 2
Staried
..i.ﬂl.'-.Ef QAT B1E M PAp—— -
oty

estance -
1] __:. Slajy |
Wil i
Elared
AITEST
Host message with bar code
data
- Hons il Nut Port 2
NO MATCH Results
Status LEDs
n - Relay #2 fired 100 | T
W gy scamcode [N y
B GoodMs Resil 2 P o st w [
B Wultiphs codes (L] =
.u-rmn W o T Hasck. W -
Haned
BITEST Q10 (B1026) Hel Speed Fpmid -
soxtengnis (D
AL5010 does not post the Match message | “*™"""™ =
Scames T g
to the bar code data e I
=it E S'Inp
No Match host message equals !!!!!
. Hone " Serial Port 1 - Serial Porn 2 .. Net Port 1 .| Het Porn 2
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Modify Settings > Serial Communications

Use the Serial Communications menu tree selections to set the serial port
connection parameters including:

e Baud Rate

s Data Bits

s Stop Bits

e Parity

s Flow Control

s Message Format

For additional information, click the © button

The Modify > Serial Communications main page describes the
items available in its menu tree.
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Modify Settings > Serial Communications >
Serial Port n

Serial Port 1
Baud Rates Data Bits Stop Bits
600 * 19200 " 7 Bits 1 Bits
T 1200 " 38400 g Bits ™ 2 Bits
T 2400 ( 57600 Parity Flow Gontrol
C 400 © 115200 & None & None
" 9600 " Even " HOMN/®OFF

" Cdd  ACKMNAK

Message Format

Uzer Defined Massage = Usa the Message Definition form to spacify your message format,

Custom Message
Standard Message
IEE

Lser Defined Message
MUK (ADPF) Message
Direct A0P Massage

Update I Reset

Modify > Serial Communications > Serial Port n (Serial Port Tab)

Selection Definition

Baud Rates Select a baud rate from the options provided.

Data Bits Select the number of data bits from the options provided.
Parity Select a parity option of None, Even, or Odd.

Stop Bits Select the number of stop bits from the options provided.

Flow Control Select a flow control option of None, XON/XOFF, or ACK/NAK.

Message Format Select a message format from the drop-down list:

» Custom Message: Custom messaging is enabled here if
your application uses custom software.

» Standard Message: The standard message format
begins with a (STX) character and ends with a (CR)(LF).

» User-Defined Message: Use the Message Definition form
to specify your message format.

* MUX (ADP) Message: MUX message format (also known
as ADP message format) is for compatibility with other
Accu-Sort products.

* Direct ADP Message: ADP message format.

NOTE: When DeviceNet or Profibus is installed in an
A Enhanced Interface Module, the Serial Port screen

displays configuration information for that device as well.

Phone: 800.894.0412 - Fax: 888.723.4773 - Web: www.ctiautomation.net - Email: info@ctiautomation.net



Message Definitions - Port 1 ]

Serial Port 1 Framing

Header [ Seguence I:‘ Digit Sequence Mo j
Traier | Check Digits INDI‘IE z|
¥ Include All Bar Codes In Ohe Messade Bar Code Separator |,

Power Up/Connect Messags [

Serial Port 1 Messages
Read IUsar Disfined j I

Mo Read |Repeat Character =] [7

Multiple Bar Code  [Repeat Character x| |

Match |User Defined = |

Mo Match [Usar Definad j I

Mo Match Read  [User Defined =]
F sppend QQ (code quality) to message Saparator |
F 4ppend Distance to message Separator |

Heart Beat Message |

Heart Baat Time COut (0-30,000 ms) jD

Update | Reset

Modify > Serial Communications > Serial Port n
(Message Definitions Tab)

Selection Definition
Serial Port n Header — Character string specified for the header. Sent at
Framing beginning of every message.

Trailer — Character string specified for the trailer. Use to
terminate every message.

Sequence — Select a sequence specification from the drop-
down list. When enabled, a sequence number consisting of the
specified number of digits is inserted just after the header.

Check Digits — Select BCC or CRC from the drop-down list.
When enabled, a two-character hexadecimal check character is
inserted just prior to the trailer.

Include All Bar Codes In One Message — Affects how the reader
handles multiple bar code transmissions. If enabled, the bar
codes are sent in one message (between one header and
trailer) and each bar code is separated by the specified
“separator.” If disabled, all bar codes are always sent as a
complete message (with a header and trailer).

Bar Code Separator — Enter a string to use to separate multiple
bar codes.

Power Up/Connect Message — Enter a string that will always be
sent on reader initialization. Note that for a Network
connection, this string is always sent when the socket
connection is made.
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Serial Port n Read — Select None, Send Bar Code, or User Defined from
Messages the drop-down list.

* None: Nothing is sent for a valid read.
« Send Bar Code: The bar code is sent.
» User Defined: A user specified message.

No Read — Select None, Repeat Character, or User Defined
from the drop-down list.

* None: Nothing is sent for a no-read

« Repeat Character: Tthe specified “repeated character” is
sent.

« User Defined: A user specified message is sent.

Multiple Bar Code — Select None, Repeat Character, or User
Defined from the drop-down list.

« None: A multiple bar code condition will be reported as a
“Read” of the first bar code reported.

» Repeat Character: The specified “repeated character” is
sent.

» User Defined: A user specified message.

Match - Select None, Send Bar Code, or User Defined from
the drop-down list.

* None: If the bar code matches any of the match codes, no
message is sent.

* Send Bar Code: The bar code is sent.

« User Defined: A user specified message is sent.

No Match — Select None, Repeat Character, or User Defined
from the drop-down list.

< None: If the bar code does not match any of the match
codes (or was a no-read), no message is sent.

« Repeat Character: The specified “repeated character” is
sent.

« User Defined: A user specified message.

No Match Read — Select None, Send Bar Code, or User
Defined from the drop-down list.

* None: if a valid bar code was read but it does not match
any of the match codes, no message is sent.

« Send Bar Code: The bar code is sent.

« User Defined: A user specified message is sent.

Append QQ (code quality) to message — When enabled, a two
digit “code quality” indication (number from 00 to 99) is
appended to the bar code message. The code quality value is
separated from the message with the specified separator.

Append Distance to message — When enabled, the approximate
distance to the bar code can be appended to the bar code
message. The distance data is separated from the message
with the specified separator.
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Heart Beat Message — When enabled, if no other message is
sent for the time period specified in Heart Beat Time Out, the
specified heart beat message string is sent. A time-out of zero
(0) disables the heart beat message.

Heart Beat Time Out (0-30,000 ms) — 0 = Disable Heart Beat
Message, 1-30,000 = Delay before sending Heart Beat
Message
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Modify Settings > Network
MNetwork Settings

P Adidross
Nt Mask
Gateway 1P Address

Controller JClient Configuration

Net Host Port 1
Connection Type

[TCPAP Cliem

H
Message Format |Sla|1da-:| Message 1]
Port  |3001 Reconnect Twna |5

Remote P Addrass [0 i (1] o o

Net Host Port 2
Connection Type

[TEPAP Client =l
|.1-:landa'-:| R ] _:J
Port |3002 peconnect Time [5
Remate [P Address fﬁ_ | |f__ ' f'J_ i |E__

Ethernat Link

Message Format

Mo, af Client Readers zroup Na
o—
Redundant Controfler Configuration
|H-.'r e j

Primary Head Number |f1

Backup Head Number ’ﬁi

Any reader can be configured to initiate a
natwork connection with a8 number of
client readers. All readers, both controller
and clienti{s), must ba sat to the same

|r’-kuto Diatect ;J
Controller Multicast IP Address
=30 255 ;|0 il:'

Telnet Port

(rmon-zera) group number,

Updata Resat

Selection

Definition

IP Address

An |IP address specifies a unique host ID for the reader on a
particular TCP/IP network. Consult your network administrator
for a valid IP address for the reader.

Net Mask

A netmask modifies a standard IP address into subnets. A
default class C net mask should be valid in most cases (either
255.255.255.0 or 255.255.240.0).Consult your network
administrator for the net mask value.

Gateway IP
Address

A gateway allows the reader to reach other systems not on the
local network and remote systems to reach the reader. If the
reader requires external connectivity, consult your network
administrator for a valid gateway address.

Net Host Port n

Select a connection types from the drop-down list:

¢ TCPI/IP Server: As a TCP/IP server, a Port # must be
specified. In this case it is the TCP/IP client’s
responsibility to initiate an reader connection.

* TCP/IP Client: As a TCP/IP client, aside from the Port #,
the Remote IP Address of the TCP/IP server which is to
receive the bar code messages must be specified. The
Reconnect Time specifies the interval (in seconds) at
which the reader attempts to establish a connection.

« UDP Messaging: In some instances, it may be desirable
to use a connectionless UDP message to send bar code
data. In this case, only the Port # and Remote IP Address
of the receiver need to be specified.

Phone: 800.894.0412 - Fax: 888.723.4773 - Web: www.ctiautomation.net - Email: info@ctiautomation.net




e EtherNet/IP (Net Host Port 1 only): This enables use of
the EtherNet/IP protocol on the reader.

Message Format — Select one of four message format options
from the drop-down list:

e Custom Message

» Standard Message

« User Defined Message
* MUX (ADP) Message.

Controller /Client  Number of Client Readers — The number of client readers in a

Configuration multi-reader network must be defined on the reader acting as
the Controller. Select the number of client readers from the
drop-down list (up to 14).

Group Number — All readers in a Controller/Client group (both
the Controller and ALL Clients) must be set to the same
controller group number. The default of zero (0) disables a
reader from listening for messages to become a client.

Redundant Controller Configuration — Select None, Primary
Controller, or Backup Controller from the drop-down list.

¢ None: This reader will act only as a client

< Primary Controller: This reader will act as the primary
controller

» Backup Controller: This reader will act as a backup
controller if the primary controller fails

Ethernet Link Select AutoDetect, 100 Mbps/Full Duplex, 100 Mbps/Half
Duplex, 10 Mbps/Full Duplex, or 10 Mbps/Half Duplex from
the drop-down list.

Controller Enter an IP address for multicast.
Multicast IP

Address

Telnet Port Enter a Telnet port ID.
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Modify Settings > Network (Message

Defi

nition Tab)

: |

i

L

=

Metwork 1 Framing

15 | Message Definition - Net 1 |

Header [\02

Sequence an Seguence ko -

Trajler [odina

Metwork 1 Messages

¥ Include ali Bar Codes [n One Message

Powar .JFI_.-JCI_'ll nect M-:\-:S-]'Jl} |

Check Digits ENUnB 2

Bar Code Separator |

Raad |Usa| Diefined L’ |
No Read [Regeat Character =] [7
Multipla Bar Code |User Diefined ;I |
Match [User Defined Bl
o Match [User Defined =
Mo Match Read [User Defined Bl

Haart Beat Messaga

W Append QO (code quality) to message

F  sppend Distance to message

Heart Beat Time Out (0-30,000 ms)

Separator |

Separator [

|

Ideate Resat

Selection

Definition

Network 1
Framing

Header - Character string specified for the header. Sent at
beginning of every message.

Trailer - Character string specified for the trailer. Use to
terminate every message.

Sequence - When enabled, a sequence number consisting of
the specified number of digits is inserted just after the header.

Check Digits - When enabled, a two-character hexadecimal
check character is inserted just prior to the trailer.

Include All Bar Codes In One Message (checkbox) - Affects
how the reader handles multiple bar code transmissions. If
enabled, the bar codes are sent in one message (between one
header and trailer) and each bar code is separated by the
specified “separator.” If disabled, all bar codes are always sent
as a complete message (with a header and trailer).

Bar Code Separator - String used to separate multiple bar
codes (see above).

Power Up Message - String that is always sent on reader
initialization. Note that for a Network connection, this string is
always sent when the socket connection is made.

Network 1
Messages

Read — Select None, Send Bar Code, or User Defined from
the drop-down list.

* None: Nothing is sent for a valid read.
» Send Bar Code: The bar code is sent.
User Defined: A user specified message.

No Read — Select None, Repeat Character, or User Defined
from the drop-down list.
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* None: Nothing is sent for a no-read

* Repeat Character: Tthe specified “repeated character” is
sent.

« User Defined: A user specified message is sent.

Multiple Bar Code — Select None, Repeat Character, or User
Defined from the drop-down list.

* None: A multiple bar code condition will be reported as a
“Read” of the first bar code reported.

* Repeat Character: The specified “repeated character” is
sent.

» User Defined: A user specified message.

Match - Select None, Send Bar Code, or User Defined from
the drop-down list.

« None: If the bar code matches any of the match codes, no
message is sent.

» Send Bar Code: The bar code is sent.

« User Defined: A user specified message is sent.

No Match — Select None, Repeat Character, or User Defined
from the drop-down list.

* None: If the bar code does not match any of the match
codes (or was a no-read), no message is sent.

« Repeat Character: The specified “repeated character” is
sent.

« User Defined: A user specified message.

No Match Read — Select None, Send Bar Code, or User
Defined from the drop-down list.

* None: if a valid bar code was read but it does not match
any of the match codes, no message is sent.

» Send Bar Code: The bar code is sent.

« User Defined: A user specified message is sent.

Append QQ (code quality) to message — When enabled, a two
digit “code quality” indication (number from 00 to 99) is
appended to the bar code message. The code quality value is
separated from the message with the specified separator.

Append Distance to message — When enabled, the approximate
distance to the bar code can be appended to the bar code
message. The distance data is separated from the message
with the specified separator.

Heart Beat Message — When enabled, if no other message is
sent for the time period specified in Heart Beat Time Out, the
specified heart beat message string is sent. A time-out of zero
(0) disables the heart beat message.

Heart Beat Time Out (0-30,000 ms) — 0 = Disable Heart Beat
Message, 1-30,000 = Delay before sending Heart Beat
Message.

Modify Settings > Trigger

There are three options for trigger source:
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« Hardware Trigger
¢ Software Trigger
¢ Continuous Trigger

Trigger Source Hardware Trigger
|HarL+war& Trigger j

Debounce Duration (ms) i':'-

Update Reset

Trigger Source = Hardware Trigger

Selection Definition
Hardware Trigger  Select Active Low or Active High from the drop-down list.

«_Active Low: The frigger is active when the input signal is

. low.
Trigger Source . Active ngﬁl ftmar?rTré Is activewhen the it — -
| Software Trigger hlgﬁJ Trigger e Host -

Start Char S End Char [e

Debounce Duration — Defines the minimum time required for
detection of a change in the hardware trigger statuggate | Reset

Trigger Source = Software Trigger

Trigger Source Software Trigger

ISuﬂware Trigger ﬂ Trigger Source |HDS’[— 1 j

Start Char IS End Char E
Update | Reset

Selection Definition
Software Trigger  Select a Host n or Net n trigger source from the drop-down list.

The software trigger can be any “host port” either serial or

T network based.

r

I Start Char — Define the ASCII characters that, when received,
will start trigger for the reader.

g

g End Char — Define the ASCII characters that, when received,

will end trigger for the reader.
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Trigger Source = Continuous Trigger

Trigger Source Continuous Trigger Type
ICDntinuDus Trigger j ICun‘rinu:-us EI
Update Reset
Trigger Source Continuous Trigger Type
|Cuntinl.|0us Trigger | |Timed =]
Trigger Off-Time
IU msec
Update Reset
Trigger Source Continuous Trigger Type
|Continl.|0l.|s Trigger | |0nce =]
Bar Code Time-Out
[o msec
Update Reset
Selection Definition
Continuous Select a Continuous, Timed, or Once from the drop-down list.
Trigger Type

« Continuous: Reader is always in trigger and transmits
any bar codes that are seen.

« Timed: Whenever a code is transmitted, trigger is
removed for the period of time specified in Trigger Off-
Time.

* Once: Same as continuous, but the same bar code will
not be sent a second time until the Bar Code Timeout
value has expired.

Bar Code Time-Out — When Continuous Trigger Type is set to
Once, the same bar code will not be sent a second time until
the Bar Code Timeout value has expired.
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Modify Settings > Relay

1/0 1 Configuration

]Usaa‘ as Input j |Il

ustom Input |»’«:lh-9 v-I;gh:J

X

1/0 2 Configuratiofl aam Match Coda

Mot in use =| [H

eight Tracking Photoeye

1/0 3 Configuration
Mot im use '[

1/0 4 Cconflguration

-

Mot in use

Update Reset I

1/0 1 Configuration = Used as input

Selection

Definition

Custom Input

Select this for use with applications involving custom software
to select a customized input option.

Learn Match

CO% 1 Configuration
Ugad as output =

When this input is selected, the AL5010 is placed into Test

Mode in order to "learn” a match code. When the lng, iian (ms)
d . When this optiopds enabled,

i

cuzthenlast code read iss ored in the first entry of the Match Table.

Life Light

1/0 2 Configuration
W use

End Trigger —
1/0 3 Configuratior

Nt i use

Height, Trz
Photoeye

I RGfve as end of trigd

Good Read

N t .
M;Sﬁfgﬂ;ﬁ? Available onl

to htardware Start/End
.'-‘ WBpHE‘éﬁom

er signal.

y at I/O#1 if the Trigger Source is set to
Trigger.

that require Height Tracking Photoeyes.

| s may be used to divide the reader's depth
of fleld |nto up to four zones. The Distance from reader (in

inches) must also be set. m Reset |

If an error message is displayed when saving or retrieving
parameters, be sure that the proper dimensions are entered in
the Reader Mounting (near/far) and 1/0 Configuration (distance
from scanner).

For installation details, reference the AL5010 Product Manual,
Chapter 3, Mounting the Height Tracking Photoeyes.

Active Low/
Active High

Select Active Low or Active High from the drop-down list.

« Active Low: The trigger is active when the input signal is
low.

¢ Active High: The trigger is active when the input signal is
high.
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1/0 1 Configuration = Used as output

1/0 1 Conflguration

||.Jse:| as output ﬂ |Mull|ple ar No Read

Output Slgnal Duration {ms)

ﬂ |.-‘5u.'!?h'|= nghll ’,—

[Custom Cutput

/02 Unnflgurallm{um Light

Mot in usa w| |Tngger Cutput
Error Light
Gaood Read
Mo Read Output
Match Output
o Match Cutput
o0d Read & Nomatch Output

.hﬂuillEIE ':Iu‘lim

1/0 3 Configuratio
Mot in use =

1/0 4 Canfiguratio
[l\jut in yse -

Update Resat I

Selection

Definition

Custom Output

Used for applications involving custom software to select a
customized output option.

Life Light

Always on while the reader is operating.

Trigger Output

Echoes the status of the trigger signal.

Error Light

Active in the event of an error condition (see later section on
errors currently detected).

Good Read
Output

Active if all expected codes are read.

No-Read Output

Active if not all expected codes are read.

Match Output

Active if any code matches the match code criteria.

No Match Output

Active if no codes match the match code criteria (includes no-
reads).

Good Read and
No Match Output

Active if a code was read but did not match the match code
criteria.

Multiple Output

Active if too many codes were read.

Multiple or No- Active if too many codes were read or a no-read occurred.
Read Output
Active Low/ Select Active Low or Active High from the drop-down list.
Active High
» Active Low: The trigger is active when the input signal is
low.
< Active High: The trigger is active when the input signal is
high.

Output Signal
Duration (ms)

Enter a duration in milliseconds for the output signal.
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Modify Settings > Tracking

W Tracking Enabled
Tachometer (Encoder) Reader Mounting
Tach Source ICGmpuled Tach j Closest Read Foint 11.5 in.
. e
Tack Compite [Stan Trigger - End Trigger ;I Farthest Read Point 37.5 in,
Trigger Reference Point 0.0 i,
Pulse Per Inch 2.00
Reader Rotation 0 deq.
Length 10.0 in.
Transmit Tracking Configuration
Transmit Edge Trailling Edge = Extend Front 0.0 in,
Transmit Point 20.0 in. Extend Back iD.E in.
Taolerance i':l.[. in,
Update Reset

Tachometer (Encoder) Selections (drop-down list)

Selection Definition
Hardware/ Used for external hardware tachometer. When this tachometer
External mode is used, you must also set the number of pulses per inch

nly available with  (PPI) generated by the tachometer.
the Enhanced
laterface Module)
C
ﬁonstantllnternal Specify the tach rate to be used (from 25 - 600 ft/min). No
external hardware is used.

o)

Gemputed Tach There are two options available: Start-End and Start-Start. In
both cases, you specify the Length (from 1-200 inches)

e between either a start and end trigger (Start-End) or between

t one start trigger and the next (Start-Start). From this
information the reader will compute the belt speed and generate
an internal tach signal.
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Selection Definition
Reader Mounting  Closest Read Point — Specify the nearest distance from the
reader where the reader is expected to read a bar code.

Farthest Read Point — Specify the furthest distance from the
reader where the reader is expected to read a bar code.

Trigger Reference Point — Specify the distance from the trigger
signal to the center point of the scan line.

Reader Rotation — Specify any rotation of the scan line with
respect to the motion of the belt.
Set a rotation direction from —180 to 180 degrees.

Transmit Transmit Edge — Specifies which edge of the package (leading
or trailing) is used to reference the transmit point.

Transmit Point — The point at which bar code data is
transmitted. Defines the number of inches after the specified
edge of the package passes the trigger before data
transmission occurs.

Tracking Extend Front (in.) — Use to increase the virtual size of the
Configuration package by increasing the leading edge (front) of the package.

Extend Back (in.) — Use to increase the virtual size of the
package by increasing the trailing edge (back) of the package.

Tolerance — Specify the tolerance (in inches) for associating a
label with a box.
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Modify Settings > FAST Monitor-

15 Tunnel Information
Tunnel Nama

ITUNNE LO1

8 reader Postion
20 - Top (Lef) =l

Select the FPeader
Position fram the drop- 4 f,‘
down menu, Reference 5 5‘
the illustration for
relative positions

IMPORTANT: Ba sure to
usE a umgue position
that relates to the
reader's location in the
scanning tunnel,

FAST Monitor Port

Port Mo, 0290 Reconnect Tima 5 Remata IP Addr. IE_ : IE_ . IIZI_ : ,EI_

NOTE: Connection parameters are only applicable for controllers and standalone units

Updata I Rasat I
g NOTE: For more information on FAST Monitor functionality,

see the FAST Monitor Product CD, online help or contact us at
1-800-BAR-CODE.

Selection Definition

Tunnel Tunnel Name — Assign a name for the tunnel/array.
Information

Reader Position — Select the Reader Position from the drop-
down menu. Reference the illustration for relative positions.

FAST Monitor Port No. — If the reader is a standalone unit or controller in a
Port scanning tunnel, set the FAST Monitor Port information. The
port number is always 9899.

Reconnect Time — Enter a reconnect time for this port.

Remote IP Addr. — Enter the IP Address for the FAST Monitor
Server.
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Modify Settings > Advanced

Data Filtering

Laser 1 DOF:
MNear Dist {in)
Laser 2 DOF:
Mear Dist (in)

Bar Code Size
Scan Rate

Maximurm Tilt

DRX Setting

Overlay Ratio
Wi,
Pairs

Change

Transmit QQ
Minimum QQ

W DRx Enabled

Search (0.0-3.0)

Scan Filtering (Skip Scan) 0 Minimum Transitions 1!3
10.0 Far Dist {ir}) 45.0
20.0 Far Dist {in} 42.0
1000 Figld of View 54
Mirn Marrow Element (mils) 1] Max Marrow Element (mils) 20
45
a3 Radio M Factor 14
4 Max Becurse 1L
[+ kil Limit s |
600 Overlay 12

0.50 W owverlay Recover Enabled
Default DRX

3 Mastimum Q0 200
Update I Reset

CAUTION: Changing the Advanced settings can adversely
ﬁ affect reader performance. These settings are to be modified

only under the guidance of Accu-Sort Technical Support.

Selection

Definition

Data Filtering

Scan Filtering (Skip Scan) —

Laser n DOF: Near/Far Dist (in) — Enter near and far distance
depth of field for the laser.

Minimum Transitions — Enter the minimum transitions allowed.

Bar Code Size

Scan Rate — Displays the scan rate.

Field of View — Displays the filed of view.

Min Narrow Element (mils) — Enter the minimum width of the
barcode’s narrowest element in thousandths of an inch.

Max Narrow Element (mils) — Enter the maximum width of the
barcode’s narrowest element in thousandths of an inch.

Maximum Tilt — Enter the maximum bar code tilt.

DRX Setting

DRX Enabled — Select to enable DRX

NOTE: The DRX settings typically will not need
to be modified. Contact Accu-Sort Support for
details (1-800-BAR-CODE).

Transmit QQ

Minimum QQ — Enter the smallest allowable QQ value for a
code to be transmitted.

Maximum QQ — Enter the maximum QQ value. This forces the
transmission of a code after the maximum QQ value is reached.
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Modify Settings > Raster

Raster Scanline

Upper Sweep (-20 to +20 degrees) 120
Lower Sweep (-20 to 420 degrees) |-20 |
Oscillating Frequency (Hz) |5.0
o +20° +20° = -
o e e
e : uﬂ 1E!|E:1 ‘! ] u‘
= RS J{ l. -10®

‘zﬂa "w

[ Update ] {Resei]

\ NOTE: The Modify Settings > Raster selection is only
ﬂ available on the menu tree when an AL5010 unit with the

raster option.

Selection Definition
Upper Sweep Specify the upper limit of the laser from -20-degrees to +20
degrees from 0-degrees.

Lower Sweep Specify the lower limit of the laser from -20-degrees to +20
degrees from 0-degrees.

b NOTE: The laser will sweep between the
A specified upper and lower values.
Example 1: If the upper value is set at -5-

degrees and the lower value is set at -10-
degrees, the laser will sweep the 5-degree range
specified below 0-degrees.

Example 2: If both the upper and lower values
are set at the same value, the laser will stay on
that fixed value without sweeping.

Oscillating Specify the frequency at which the vibrating vane (mirror) will

Frequency (Hz)  oscillate between 0 and 10 Hz. This is the speed of the mirror
oscillation with 0 being effectively stopped and 10 oscillating the
fastest.
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Save / Retrieve

Save/Retrieve

Action To
Save > Reader = OK

Save to Reader - Use to save the current set of parameters to the reader's flash, Parameters saved
in the reader's flash are the parameters used during normal operations.

Selection Definition
Save / Retrieve:  To — Select File, Reader, or Base from the drop-down list.
Action = Save

* File: Use to specify a file name and location to store the
current parameter settings on your computer.

» Reader: Use to save the current set of parameters to the
reader. Parameters saved in the reader are the
parameters used during normal operations.

» Base: Use to save the current set of parameters to the
mounting base as a backup copy.

Save/Relrieve

Action From
Retrieve - File - CK
[ Browse.. f
Retrieve from File - Use to retrieve & parameters set from a specific file name and location on your
computar
Selection Definition
Save / Retrieve:  From — Select File or Base from the drop-down list.
Action =
Retrieve  File: Use to retrieve a parameters set from a specific file

name and location on your computer.

» Base: Use to retrieve the parameters stored in the
reader’'s mounting base. This is especially useful when it
becomes necessary to load the correct parameters to a
replacement reader module.

Save/Retrieve

Action
l Drafault r Ok

Default - Usa fo return the reader's parameters to the hard-coded ‘default’ values built into the
reader software.

Selection Definition
Save / Retrieve:  Use to return the reader’s parameters to the hard-coded
Action = Default "default" values built into the reader software.
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Reboot ALS010

Use this function to reboot the reasder Reboot

Selection Definition
Reboot AL5010 Click to reboot the bar code scanner.
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Diagnostics

Comprehensive diagnostic are available that enable wou to monitor:

e Status LED=

« Read Quality

s Messages

&« Box Informatian
s IMessage Monitor
+ Read Rate Log

« Counters Lag

« Message Log

s Upload Firmware

For additional information, click the o button

Diagnostics

The Diagnostics main page describes the items available in its menu tree.
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Diagnostics > Monitor

Status LEDs Read Quality

——
Status Il Network ea € “

Code Quality (QQ)
Trigger W 101 Scans/Code _

Good/No Read o2 Laser1 W
u Code Postion : 2619 .

Muttiple codes [l 103 Laser 2 n
Match B o4 b L R

Messages Box Information

3037477262 Qa0 010y =
303TATTEZ Qa0 (0n0y
303T4TY262 QG0 (00

<NOREAD> Belt Speed (fpm) _
3037477262 QQ1D (D0 Belt Length (in,) _
303747262 QG0 (00

30374TTEEZ Qa0 (010) Code Postion (in.) _
=NOREAD=
S0374TT262 Q@10 (0M0) Scans/Trigger -

|4

Stop

\023037477 26200104

W023037477 262000004
\023037477 262000004
\023037477 26200004

023037477 2EA0D0A

® None ) Serial Port 1 ) Serial Port 2 ) Net Port 1 ' Net Port 2

NOTE: The Monitor is a Java application and requires Java
‘@ and the appropriate browser plugin.

Selection Definition
Status LEDs Status — GREEN to indicate the overall "health" of the reader.
(If RED, troubleshooting is required.)

Trigger — GREEN indicates the trigger input. The LED is
activated upon trigger input regardless of trigger source
(including software trigger).

Good/No Read — GREEN indicates a good (valid) bar code has
been decoded. RED indicates a no-read (or incomplete
decode).

Multiple codes — RED indicates more codes than desired were
read.

Match — GREEN indicates a code matches the Match Code
criteria.

Network — GREEN indicates a network host connection has
been made. RED indicates a problem with the reader network.

» Example: A red Network LED upon power up could
indicate the MAC address was not set at the factory.

Network (multi-reader networks only) — GREEN indicates a valid
connection to a Controller or Client. Flashing RED on a
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Controller indicates a problem with a Client connection.
RED indicates a Controller with incompatible settings tried to
initiate a Client connection.

I/O 1 through I/O 4 — Indicates the status of the programmable
relay /O lines.
Read Read Quality — Graph 0-100) The large percentage bar maps to
Performance the values displayed on the reader bar graph. The graph is a
dynamic measure of "how well” the bar code was read.

Scans/Code — Indicates how many passes of the laser (scan
lines) contributed to the reading of the code.

Code Position — Indicates the bar code's position in the reader's
scan line (from zero to 4095).

Code Quality (QQ) — Laser 1/ Laser 2 - Indicates the QQ (code
quality) value for each laser that read the bar code.

Messages Diagnostic messages from the reader are displayed here. This
is primarily information on each bar code read.

Use the buttons below the Messages area to start and stop
(freeze) the messages being displayed for better diagnostics.

To copy text, highlight the text and then perform a copy function.
Paste the text into an external text program.

Box Information Belt Speed (FPM) — Displays the belt speed in feet per minute.

Box Length (inch) — Displays the box length in inches.

The box length is influenced by the extend front or extend back
option in the Tracking screen.

Example:
If the extend front is set to 2 and a 10 inch box is sent through
the system, then the Box Length is reported as 12 inches

Code Position (inch) — Displays the code position on the box in
inches.

Scans/Trigger — Displays the number of scans per trigger cycle.

Distance (in) — Displays the approximate distance from the
scanner to the bar code in inches.
Message Use the Message Monitor to view the messages being sent
Monitor from any of the reader host ports (either serial or network).

Select the communication port you want to monitor from the
option group below the message monitor.

Start Test Mode

Click Start Test Mode to put the scanner in timed test mode. The scanner
will then read any readable bar code place in its beam.
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Diagnostics > Log Viewer

DI
Li

Et
Tx
Ne

Et
Rx
B
B
R
Rx

Tx
Tx
Tx
Tx

NAC Addre=s:

ALS010 Log Viewer

SPENET=18

nk: Active (100mbps-Full Duplex
00:0e:13:03:00:1b

hernet MAC Stats
Ocrecs:
t Cotets:

hernet MAC Errors
Align Erroras:
Undersized Errors:
Jabber Count:
S0F Overrun Errors:
HOF COwverrun Count:

Carrier Losses:
Jingle Coll Errors:
Excessive Coll:
Underrun Errors:

Command

10875897
39452099

[ [ R ot R o |

L o R o |

RE
RX
RX

X

Tx

TX
TX

RX Octets: 11543748
CRC Errors: o
Oversized Frames: o
No Net Buffers: 573637612
Fragments: o
DML Crrerruns: o
Collisions: o
Mule Coll: o
Lace Collisions: o
- |
Read Rate | Counters | Message Log | Ciaarl

[pise ENET

Use this field to enter and send commands (example: DISP ENET)

| Send Command |

Use this screen to review the performance logs saved by the reader. The
three most commonly viewed logs are available by selecting one of the three
buttons:

o Read Rate
o System Counters
e Message Log

You can also enter a log request in the Command field.
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Diagnostics > Update Firmware

i
2,

To Extract Image

Click Extract Image

In Sawe as window, save the image
{*.az) files to your computer. The
graphic on-screen indicates Extract
Image is in-process.

A message will appear when Extract
Irmage is complete.

Extract Image |

Use Update Firmware to reload the reader firmware.
CAUTION: This function should only be performed under the guidance of Accu-Saort

Technical Support.

To Burn Flash

Click Browse button.

In Open window, open an image file
{*.as) to burn to flash, Click Burn
Flash button. The graphic on-screen
indicates Burn Flash is in-process.

& message will appear when Burn
Flash is complete.

Feboot (cycle power) ALS010.

Browse... |
Burn Flash |

Use Update Firmware to reload the reader firmware.

A\

CAUTION: This function should only be performed under the
guidance of Accu-Sort Technical Support.
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Notes:
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AL5010 Networking Guide

Introduction

The AL5010 bar code reader includes a built-in Ethernet interface that can
be used both for receiving bar code data from the AL5010 as well as
monitoring and configuring the AL5010.

AL5010 Ethernet Hardware Configuration
The AL5010 Ethernet hardware supports a 10/100mbps full or half-duplex
Ethernet link. (Wiring information is provided in Chapter 4 and Appendix F.)

Use the AcculLazr User Interface Log Viewer's DISP ENET command to
monitor for Ethernet errors.

The AL5010 hardware will detect the swapping of the Transmit and Receive
lines and configure appropriately. This allows a straight cable to be used to
connect two AL5010s.

AL5010 Network Software Configuration

The AL5010 browser-based user interface makes it possible to connect to
the AL5010 over the network.

Currently, the AL5010 only supports static IP addresses. The defaults for the
AL5010 network settings are listed below:

Parameter Default Value
IP Address 192.168.3.100
Net Mask 255.255.255.0
Gateway 0.0.0.0

If you are adding your AL5010 to a larger network, you must obtain an IP
addresses (as well as the other parameters) from your network
administrator. If the AL5010s are to operate on a closed network, you may
assign your own IP addresses. This is typically by just incrementing the last
number from the default (192.168.3.101, 192.168.3.102, etc.).
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Controller/Client Communications

Up to fourteen (14) AL5010s can be configured to operate together as a
single unit. All communications between readers is accomplished over an
Ethernet network.

In this configuration, one AL5010 must be set up as a Controller. The
Controller initiates connections with the remaining readers, configuring them
to operate as Clients. The trigger input (such as a photoeye) is only
connected to the Controller.

Setting up AL5010s for a Multi-Reader Network

Wiring
If only two readers are to be communicating, and the Ethernet network is not
needed for diagnostics or host communications, the readers can be
connected directly with a CAT6 network cable. However, it is recommended
to use an network switch when connecting any combination of scanners, so
that diagnostics can be performed while the system is running.

Tachometer and trigger are connected to the controller AL5010. The
controller AL5010 transmits speed and trigger messages to the Clients over
the network.

Configuration
1. All readers should be operating on the network with unique 1P
addresses.

2. Al AL5010s that are to communicate together should be assigned the
same Group Number. A Group Number of zero (which is the default)
disables the Controller/Client capability.

3. The Number of Client Readers should be changed from zero on the
Controller in order to identify this unit as the Controller. After being
configured as a Controller, it will broadcast messages onto the network
to discover the specified number of Clients.

Modify > Network HO
“Network Settings |
IP Address Net Host Port 1
,E o ,ﬁ o |3_ B m Connection Type |TCF’fIF' Server L‘
Net Mask Message Format |Slandard Message j
IE,EIEIU_ Port |3001
Gateway IP Address Net Host Port 2
,D_ - s Connection Type |TCPrIF' Server Ll
Controller /Client Configuration Message Format [ standard Message =
< Mo. of Client Readers Group Mo port [3002

Ethernet Link

RedO |f-\_ulc Detect ﬂ
[Mone E Controller Multicast IP Address

Primary Head Number 0 Iﬁ . IE . Icu_ . IO_

Backup Head Number iU_ Telnet Port

Any reader can be configured to initiate a 23

network connection with a number of
client readers. All readers, both controller
and client{s), must be set to the same
(non-zero) group number.
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When using Controller/Client configuration, the client Tach Source must be
set to Constant/Internal. The Clients will rely on a speed message sent from
the Controller eliminating the need to provide a tachometer input to the
clients.

In an AL5010 multi-reader network, bar codes are sent from the clients to the
controller as soon as they are read. The Controller AL5010 is responsible for
transmitting the bar code data to the host.

Restrictions

= [f a controller is configured with tracking enabled, all clients must also
have tracking enabled.

= All units must have the same bar code types enabled, in the same order.

= Clients do not transmit data messages through their serial or network
host ports.

Multi-Reader Network LED and Troubleshooting

The main AL5010 diagnosis tool is the Network LED. An AL5010 controller
will FLASH the LED red once a second if it cannot locate the specified
number of Clients. When all connections are made, the Network LED
becomes a solid green.

For a client, the Network LED remains off until a Controller initiates a
connection. Once a connection is made, the LED becomes a solid green.

Network Administrator Information

All communications from a Controller to the Clients is done using TCP/IP
Multicasting. The default multicast IP address used is 239.255.0.x, where x is
called the Controller Group Number (value from 0 to 255). If multiple
Controller/Client Groups are on the same network, it is important that they be
assigned unique group numbers so that each group is using a unique
Multicast IP address.

It is important that the network be configured so that Multicast network traffic
will be transmitted between these readers. The AL5010 multicast messages
are configured with a Time-To-Live of 1, so they will not pass through a
router. Additionally, an Ethernet Switch which supports IGMP snooping may
be utilized to restrict the multi-cast traffic seen by the AL5010s as well as any
other items on the same network.

All communications from the Clients back to the Controller uses standard
UDP messaging.
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Network Host Communications

The AL5010 provides a number of options for transmitted bar code to
another computer (typically referred to as the “host”). Additionally, two host
network connections are supported each with different message definition
and formatting. These connections use ports 3001 and 3002 by default, but
these values are modifiable.

TCP/IP Server

Operation as a TCP/IP server is the default configuration for the AL5010. In
this case, for an application to communicate with an AL5010 from a "host
computer”, the application should just initiate a simple TCP/IP socket
connection. When a socket connection to the AL5010 is established, the
green AL5010 network LED will be illuminated (unless client/controller mode
is in use in which the LED indicates the status of the inter-AL5010 network
connections).

One issue should be considered when designing such an application: As
with any socket connection, if one side or the other terminates the
connection without properly closing it - the connection can be left open.

For example, if a host computer has initiated a connection to an AL5010 and
the host computer "crashes" - the connection on the AL5010 will remain
open until the AL5010 attempts to send the next message (normally the next
bar code). At this point, the AL5010 will detect the connection from the host
computer has been terminated and clear the connection allowing the host
computer to reconnect.

However, it is possible that the AL5010 might be powered off while a host
connection is active (or if the power is cycled on an intermediate piece of
network equipment such as a hub or a switch). In this case, the AL5010
socket connection will be closed but the host computer may not be aware of
this change. To handle this situation, it may be desirable to implement a
means by which the host computer can test the state of the network
connection.

One option is to periodically send a simple message (e.g., just a null
character or just a single STX character) to the AL5010 verifying the link is
still active.

Another option is for a heartbeat message to be enabled on the AL5010.
This both provides the host computer with a means for determining if the link
has been lost (by lost of the heartbeat) and provides the AL5010 with quicker
determination of lost of communications with the host computer. This is the
recommended approach.
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TCP/IP Client

It is also possible to configure the AL5010 to operate as a TCP/IP Client. In
this case, you must also specify the IP address of the computer to which the
AL5010 is to attempt to initiate a connection. If a connection cannot be
established, the AL5010 will reattempt the connection after the specified
number of seconds (default is 5 seconds).

Network Settings
1P Address Net Host Port 1
F W A ’3_ |1._1 Connection Tye iTL}FIIP Client
Net Mask Message Format = rd Message
F ,F F Ir_ Port [T Reconnect Tima I'-i
Gateway IP Address pemote tPaddress 10 @ i @
I LT T s

Similar issues exist regarding improper closing of connections as described
in the TCP/IP Server section. As a result, it is also recommended that a
heartbeat message be enabled for TCP/IP Client connections.

UDP Messaging

For UDP messaging, only the destination IP address and port need to be
specified. Since this is a connectionless means of transfer, there are no
issues with checking for loss of connection.
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EtherNet/IP

The AL5010 supports the EtherNet/IP™ Industrial Networking protocol.
EtherNet/IP ~ simplifies the communication of bar code and input/output data
with other EtherNet/IP enabled devices, such as a programmable controller.

EtherNet/IP is not enabled by default on the AL5010. To enable, select
EtherNet/IP as the Connect Type for Net Host Port 1 on the Network
Settings page of the user interface. When EtherNet/IP is enabled, all of the
other network capabilities of the AL5010 remain active. For example, an
AL5010 controller can be configured for EtherNet/IP communications with a
programmable controller while still communication with one or more AL5010
clients.

Once enabled, EtherNet/IP allows the AL5010 to communicate with other
EtherNet/IP enabled devices. This can be done using:

= Explicit Messaging,

= /O Messaging, and

= On-Demand Messaging (a special AL5010 protocol for ControlLogix
Controllers only)

All of the AL5010 EtherNet/IP Object definitions are defined later in this
appendix. Refer to this appendix when setting up the interface to your
device.

Explicit Messaging is used when a peer-to-peer network is needed for
communication. For example: In order to read parameters from the AL5010,
a PLC (Programmable Logic Controller) must issue a Peer-To-Peer Read
command to the AL5010. In order to write parameters to the AL5010,

the PLC must issue a Peer-To-Peer Write Command to the AL5010.

I/0 messaging can be used to monitor and set AL5010 I/O bits as well as to
obtain bar code data from the AL5010. The disadvantage is the 1/O
messages are always sent at scheduled intervals creating a lot of network
traffic.

On-Demand Messaging only works with ControlLogix Controllers. This
option uses standard EtherNet/IP messaging, but allows bar code data to be
sent to the Controller only when a bar code is read. It can be used in
conjunction with 1/0 messaging.
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EtherNet/IP Options

When EtherNet/IP is enabled, a new tab become available within AcculLazr
user interface that allow you to configure some additional options.

Modify > Network H® &

ings |  EtherNet/IP Settings |

Bar Code Data
ASCIl Message 'I [T Byte Swap ASCII Data

" Enable ControlLogix OnDemand Messaging

Reader Inputs Reader Qutputs

" Enable Trigger Inputs Duration (msec)
Output 1 |Trigger0utpul j 500
Output 2 IGood Read Output j !50137
Output 3 II'ID Read Qutput ;] ISGO—
Output 4 llv'lultiple Output j 500
Output & II'u']ﬂtEh Output ;l 500
Output & II‘ID WMatch Qutput L‘ ISGG—
Output 7 |Error Light 4| o
Output 8 |Life Light = o ]

These parameters are described in more detail earlier in this manual, but a
quick overview provides some context here. (See Chapter 5.)

The Bar Code Data parameters allow you to manipulate the format of the
bar code data. Most notable if your bar codes only contain numeric digits,
you can configure the AL5010 to convert the bar codes to a numeric value
instead of transmitting them as ASCII text.

Additionally, you can enable the On-Demand Messaging Option for
ControlLogix Processors. This is described in more detail later in this
document.

If the EtherNet/IP Trigger Input is enabled, the AL5010 Trigger settings are
ignored and the AL5010 is triggered solely by manipulating the Trigger Bit in
the Output Word (contained in the AL5010 Assembly and Output Objects).

The AL5010 Outputs function the same as AL5010 relay outputs, but they
manipulate bits within the AL5010 Input Word (contained in the AL5010
Assembly and Input Objects).

The AL5010 can relinquish control of the internal AL5010 relays to another
EtherNet/IP device. When this has been done, these relays are controlled by
bits within the Output Word.
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Explicit Messaging Example
Used for communication between AL5010 and a Programmable Logic
Controller (PLC).

Contact Accu-Sort support at 1-800-BAR-CODE (1-800-227-2633) for help
with your specific application.
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I/0 Messaging Example

The following example illustrates how an AL5010 can be configured to

communicate with a ControlLogix processor using I/O messaging. Ultilizing
this information along with the AL5010 Obiject definitions (on page B-19), it
should be possible to adapt these directions for other EtherNet/IP devices.

When EtherNet/IP is enabled on the AL5010, EtherNet/IP /0O Messaging is
automatically enabled. No further configuration is needed to setup I/O
messaging.

Since the ControlLogix processor will treat the AL5010 as an 1/O device, to
setup an EtherNet/IP /O message transfer between an AL5010 and a
ControlLogix processor, you need to configure your AL5010 as a Generic
Ethernet Module in the ControlLogix RSLogix 5000 interface 1/O tree.

To add a module:

1. Under the I/O Configuration Tree, right-click on the entry for your
Ethernet module (e.g., 1756-ENET/A) and select New Module.

2. You will be presented with a list of options similar to what is shown
below. From this list select ETHERNET-MODULE for the Generic
Ethernet Module.

3. Specify the Module Properties for your AL5010.

a. The most important step is that you must first set the Comm
Format to Data-INT. This must be done first since it cannot be
changed later.

b. After this you can specify the Name, Description and IP
Address of the AL5010.

4. The Connection Parameters must be specified as follows:

Assembly Instance Size
Input 100 68
Output 112 2
Configuration 128 0

Il Module Properties - Networkl (ETHERMET-MODULE I'.Ii-}:f x|

Gieneral | Connection | Module Infa |

Type: ETHERMET-MODIILE Generic Ethernet Module
Wendar: Allen-Bradley
Parent: Fetwork] :
Name: I!-’-‘«LEEH 0 TopRead i Connection Parameters
Azzembly )
Dezcription: i! Instance: Size;
Input: |1EIEI IEB j [16bit]
o g 12 [z = nesi
I E | Data - IMT ™ ‘ ;
e I e —i Configuration: |'|2E IU j [8-hit]
Address /# Host Mame
& |P pddess: | 192 . 0 . 0 . B0 Statis |rput: | |
€ Host Name: | Status Dutput: I

Statuz: Offline 0K l Cancel | Anply | Help
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_ NOTE: You can only “schedule” I/O message transfers to the AL5010 at a
fixed interval. The Connection Tab allows you to specify this interval. The
AL5010 will handle intervals down to 10 milliseconds. However, intervals this

small may affect the overall AL5010 performance.

Il Module Properties - Networkl (ETHERNET-MODULE 1.1} i!

Gemeral  Connection |M0du|e Info'l

Requested Packet Interval [RFI): I HD.DE: me  [1.0-3200.0 ms]
[ Inhibit Module

[~ Major Fault On Contraller If Connection Fails Whils in Fun Mode

—Muodule Fault

Statuz: Offline ok I Carcel | Al I Help |

After this module definition for the AL5010 has been completed, tags will be
created in the controller based on the name you specified for this AL5010 on
the properties page for the module. These tags will consist of the name
followed either by the letter ‘C’ (Configuration), the letter ‘O’ (Outputs) or the
letter ‘I’ (Inputs). These tags are based on the AL5010 assembly objects.
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AL5010:C Configuration Data
This data is not used.

AL5010:1 Input Data

Tag Name Value Description
AL5010:1.Data[0] Discrete Input Word See bit definitions.
AL5010:1.Data[1] Bar Code Sequence Number | This field is updated every time the bar code

data is updated. However, the bar code data
will only be updated when the “Last Bar Code
Sequence Number” (see Output Data) is set
equal to this value.

AL5010:1.Data[2]

Bar Code Status

Not currently used.

AL5010:1.Data[3]

Bar Code Size (words)

Number of words which contain the bar code
data

AL5010:1.Data[4-67]

Bar Code Data

Discrete Input Word

o
-

AL5010 Programmable Output #1
AL5010 Programmable Output #2
AL5010 Programmable Output #3
AL5010 Programmable Output #4
AL5010 Programmable Output #5
AL5010 Programmable Output #6
AL5010 Programmable Output #7
AL5010 Programmable Output #8

O|IN|O[O|A~|WIN|=|O

-15 Unused

AL5010:0 Output Data

Tag Name

Value

Description

AL5010:0.Data[0]

Discrete Output Word

See bit definitions.

AL5010:0.Data[1]

Last Bar code Sequence
Number Received

This field must be updated to match the Bar Code
Sequence Number each time the bar code data
has been processed.

Discrete Output Word

Bit Bit=0 Bit =1

0 Trigger Off Trigger On

1-7 Unused Unused

8* AL5010 Relay #1 Off AL5010 Relay #1 On
9* AL5010 Relay #2 Off AL5010 Relay #2 On
10* AL5010 Relay #3 Off AL5010 Relay #3 On
11* AL5010 Relay #4 Off AL5010 Relay #4 On
12-15 Unused Unused

* If enabled on AL5010
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On-Demand Messaging (ControlLogix)

On-Demand messaging provides another option for transferring bar code
data to your ControlLogix processor. With on-demand messaging, the data
transfer occurs as soon as the bar code data is available, not as the result of
constant messaging at a schedule interval.

Typically, On-Demand messaging is used in conjunction with I/O messaging.
For applications requiring only the transfer of bar code data, using On-
Demand Messaging allows the 1/0O packet interval to be increased (just to
provide a heartbeat with the AL5010) reducing overall network utilization.

On-Demand messaging can be enabled on the AL5010 from the EtherNet/IP
tab on the network page within the user interface. When enabled, you need

to specify the IP address and slot for the ControlLogix processor, along with

the name of the Tag to contain the bar code data.

™
ccu Lazr Modify > Network E @_ @

- Modify Settings (FTNeEwWorkSettings\)| EtherNet/IP Settings [IMessageDefnition=meeds
nfiguration
Bar Codes Bar Gode Data
ek ASClMessage v I Byte Swap 45CI Data
_ Stripping/Padding
Match Codes ¥ Enable ControlLogix OnDemand Messaging
Serial Communications controller 1P gddress [132 . o . [ [53 sotfo Tag Name [ALS010CodeTag
al Port 2 Reader Inputs Reader Outputs
e ST W Enable Trigger Inputs Duration {msec)
- Trigger Output 1 | Trigger Output =l [1000
Control of Reader Relays Output 2 | Good Read Output = [1000
F output 1 Output 2 | No Read Output = |500
o ¥ output 2 Output 4 | Multiple Output = |500
S need ¥ output 3 output & [Match Output = |s00
SavefRetrieve P output «
Output & | Mo Match Output = [s00
tHUEES utput 7 [Eror Light =] @
output & [Lite Light E [0

Once this is complete, you need to define a new Tag on the ControlLogix
using its RSLogix 5000 interface. The new tag should have a type of INT and
a dimension of 67 words. The name must match the name specified on the

AL5010.
5 &
Data Types: Hame: [ALB010CodeT 2
INT[EY ak. I
I - Description: _ﬂ Cancel |
FLIFP_FLOP_JK - Earee |
FUMCTION_GEMERATOR _I Help |
HL_LIMIT -
INT Heb | . LIJ
INTEGRATOR
LEAD_LAG Tag Type: = Base
LEAD_LaG_SEC_ORDER — & i
mé?lshl%hg_mpTUHE  Produced |1 ﬂ CONSUTIES:
MINIMUM_CAPTURE LI £~ Consumed
WIATIOLL FRALIA
Data Type: =
~furay Dimension: SGEELD I _I Confiaure..
Bl Dirn 1 Dir 2 Scape: IAxmmEnellP[cnntrn\ler] j
= N — 1 —- . =

These tags will be updated every time a bar code is read. The following
table defines the format of the data within this tag.
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On-Demand Tag

Tag Name Value Description
AL5010Tag.Data[0] Bar Code Sequence This field is updated every time the bar code
Number data is updated. However, the bar code data

will only be updated when the “Last Bar Code
Sequence Number” (see Output Data) is set
equal to this value.

AL5010Tag.Data[1] Bar Code Status Not currently used.
AL5010Tag.Data[2] Bar Code Size (words) Number of words which contain the bar code
data

AL5010Tag.Data[3-66] Bar Code Data
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EtherNet/IP Object Models

Glossary
This is a description of the different data types that are used in the
documentation of the object model. These are standard definitions of the
Open DeviceNet Vendor Association (ODVA). For additional information, visit
their web site: http://www.odva.org/.

Summary of Objects
The following standard objects are supported. More details than provided in
this appendix can be found in the EtherNet/IP™ Specification available from
the Open DeviceNet Vendors Association (ODVA).

Identity Object (01pex)

Message Router Object (021ex)
Assembly Object (04ex)
Connection Manager Object (06 yex)
TCP Object (F54ex)

Ethernet Link Object (F6 xex)

The following Vendor Specific Objects have been defined to support the
AL5010 Bar Code Reader.

= Bar code Data Object (70 pex)
= Discrete Input Data Object (71 xex)
= Discrete Output Data Object (72 1ex)

Definitions
The following table has a description of all of the data types used.

USINT Unsigned Short Integer (8-bit)

UINT Unsigned Integer (16-bit)

UDINT Unsigned Double Integer (32-bit)
STRING Character String (1 byte per character)
BYTE Bit String (8-bits)

WORD Bit String (16-bits)
DWORD  Bit String (32-bits)
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Standard Objects

Identity Object (01uex-1 Instance)

Class Attributes
Attribute ID | Name Data Type Data Value Access Rule
1 Revision UINT 1 Get
Instance Attributes
Attribute ID | Name Data Type Data Value Access
Rule
1 Vendor Number UINT 25pEC Get
2 Device Type UINT 00HEx Get
0x00 — Generic
3 Product Code Number UINT 01 Get
4 Product Major Revision USINT 03 Get
Product Minor Revision USINT 01
5 Status Word WORD See Below Get
(see below for definition)
6 Product Serial Number UDINT Unique Get
32 Bit Value
7 Product Name Get
Structure of:
Product Name Size UINT 15
Product Name String USINT[0-32] | “Bar Code
Reader”
Status Word
Bit Bit=0 Bit=1
0 No I/O Connection I/0 Connection Allocated
1-15 Unused Unused
Common Services
Service Code Implemented for Service Name
Class Level Instance Level
OEHex Yes Yes Get_Attribute_Single
05HEX No Yes Reset
Reset Service Code
Service Code Class Instance Attribute Description
05HExX 1 1 0 Force software reset
05HEX 1 1 1 Reload factory settings and reset

Message Router Object (021ex)
This object has no supported attributes.
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Assembly Object (04uex — 4 Instances)

Class Attributes
Attribute ID Name Data Type Data Value Access
Rule
1 Revision UINT 1 Get
2 Max Instance UINT 81 Get
Instance 0x64 Attributes (Input Instance 1)
Attribute ID | Name Data Type Default Access
Data Value Rule
3 Input Data Get
Structure of:
Discrete Input Word (see below) UINT 0
Bar code Sequence Number UINT 0
Bar code Status (reserved) UINT 0
Bar code Size Word UINT 0
Bar code Data [UINT] UINT [] varies 0
(up to 64)
Discrete Input Word
Bit
0 AL5010 Programmable Output #1
1 AL5010 Programmable Output #2
2 AL5010 Programmable Output #3
3 AL5010 Programmable Output #4
4 AL5010 Programmable Output #5
5 AL5010 Programmable Output #6
6 AL5010 Programmable Output #7
7 AL5010 Programmable Output #8
8-15 Unused
Instance 0x70 Attributes (Output Instance 1)
Attribute ID | Name Data Type Default Access
Data Value Rule
3 Output Data Get / Set
Structure of:
Discrete Output Word (see below) UINT 0
Last Bar code Seq. Num Received UINT 0
Discrete Output Word
Bit Bit=0 Bit=1
0% Trigger Off Trigger On
1-7 Unused Unused
8* AL5010 Relay #1 Off AL5010 Relay #1 On
9* AL5010 Relay #2 Off AL5010 Relay #2 On
10* AL5010 Relay #3 Off AL5010 Relay #3 On
11* AL5010 Relay #4 Off AL5010 Relay #4 On
12-15 Unused Unused
* If enabled on AL5010
Instance 0x80 Attributes (Configuration Instance)
Most I/O clients include a Configuration path when opening an I/O connection to a server. There is no
Configuration data needed.
Instance 0x81 Attributes (Heartbeat Instance — Input Only)
This instance allows clients to monitor input data without providing output data.
Common Services
Service Code Implemented for Service Name
Class Level Instance Level
OEnex Yes Yes Get_Attribute_Single
10Hex No Yes Set_Attribute_Single
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Connection Manager Object (06 nex)
This object has no attributes.

TCP Object (F5uex-1 Instance)

Class Attributes
Attribute ID Name Data Type Data Value Access
Rule
1 Revision UINT 1 Get
Instance Attributes
Attribute ID Name Data Type Default Access
Data Value Rule
1 Status DWORD 1 Get
2 Configuration Capability DWORD 0 Get
3 Configuration Control DWORD 0 Get
4 Physical Link Object Get
Structure of:
Path Size UINT 2
Path Array Of WORD | 0x20F6
0x2401
5 Interface Configuration Get
Structure of:
IP Address UDINT 0
Network Mask UDINT 0
Gateway Address UDINT 0
Name Server UDINT 0
Name Server 2 UDINT 0
Domain Name Size UINT 0
Domain Name STRING 0
6 Host Name Get
Structure of:
Host Name Size UINT
Host Name STRING 0
Common Services
Service Code Implemented for Service Name
Class Level Instance Level
OEHEex Yes Yes Get_Attribute_Single
Ethernet Link Object (F6 nex - 1 Instance)
Class Attributes
Attribute ID Name Data Type Data Value Access
Rule
1 Revision UINT 1 Get
Instance Attributes
Attribute ID Name Data Type Default Access
Data Value Rule
1 Interface Speed UDINT 100 Get
2 Interface Flags DWORD 3 Get
3 Physical Address USINT Array[6] 0 Get
Common Services
Service Code Implemented for Service Name
Class Level Instance Level
OEHEex Yes Yes Get_Attribute_Single
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Vendor Specific Objects

Bar Code Data Object (70 uex - 1 Instance)

Class Attributes
Attribute ID | Name Data Type Default Data Access
Value Rule
1 Revision UINT 1 Get
Instance Attributes
Attribute ID | Name Data Type Default Access
Data Value Rule
1 Bar Code Sequence Number UINT 0 Get
2 Bar Code Status (reserved) UINT 0 Get
3 Bar Code Data Size UINT 0 Get
4 Bar Code Data UINT[ ] varies 0 Get
(up to 64)
5 Last Bar Code Seg. Num Received UINT 0 Get / Set
Common Services
Service Code Implemented for Service Name
Class Level Instance Level
OEnex Yes Yes Get Attribute Single
10Hex No Yes Set Attribute Single

Discrete Input Data Object (71 vex - 1 Instance)

Class Attributes
Attribute ID Name Data Type Default Access
Data Value Rule
1 Revision UINT 1 Get
Instance Attributes
Attribute ID Name Data Type Default Access
Data Value Rule
3 Discrete Input Word UINT 0 Get
Discrete Input Word
Bit
0 AL5010 Programmable Output #1
1 AL5010 Programmable Output #2
2 AL5010 Programmable Output #3
3 AL5010 Programmable Output #4
4 AL5010 Programmable Output #5
5 AL5010 Programmable Output #6
6 AL5010 Programmable Output #7
7 AL5010 Programmable Output #8
8-15 Unused
Common Services
Service Code Implemented for Service Name
Class Level Instance Level
OEhex Yes Yes Get Attribute Single

Phone: 800.894.0412 - Fax: 888.723.4773 - Web: www.ctiautomation.net - Email: info@ctiautomation.net



Discrete Output Data Object (72 uex — 1 Instance)

Class Attributes
Attribute ID | Name Data Type Data Value Access
Rule
1 Revision UINT 1 Get
Instance Attributes
Attribute ID | Name Data Type Default Access
Data Value Rule
3 Discrete Output Data UINT 0 Get / Set
Discrete Output Word
Bit Bit=0 Bit=1
0% Trigger Off Trigger On
1-7 Unused Unused
8* AL5010 Relay #1 Off AL5010 Relay #1 On
9* AL5010 Relay #2 Off AL5010 Relay #2 On
10* AL5010 Relay #3 Off AL5010 Relay #3 On
11* AL5010 Relay #4 Off AL5010 Relay #4 On
12-15 Unused Unused
* If enabled on AL5010
Common Services
Service Code Implemented for Service Name
Class Level Instance Level
OEnex Yes Yes Get_Attribute_Single
10Hex No Yes Set_Attribute_Single
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FAST Monitor Configuration

FAST Monitor and AL5010

Acculazr’s user interface provides setup compatibility with Accu-Sort
System’s FAST Monitor™.

FAST Monitor is a browser-based application, running on a FAST Monitor
Server, that gives facility managers and maintenance personnel the ability to
monitor multiple Accu-Sort products within their facility or across multiple
facilities from anywhere an internet connection is available. FAST Monitor
provides real time and historical performance data in an easy to use browser
interface as well as automatic status and error condition reporting of all
Accu-Sort products and systems to which it is connected.

Use the FAST Monitor Configuration screen in the user interface to setup
an AL5010 reader for FAST Monitor message format compatibility.

How to Configure an AL5010 for FAST Monitor:

1. Open Modify Settings > Configuration.

Modify > Configuration He @

#der Information
Reader Name
| Inbound Returns
gader Model

Software Name/Revision
| AL5010 | 12041)
Decode Software Mame/Revision

SRSTE | DRXSTD [ 1.429)
Serial Number FPGA Device Id/Revision
27 | 0x3c40 [ 38.0(50)

a. Enter a name for the reader in the Reader Name field. Choose a
unique name that helps identify that readers scan point.

b. Click Update and then click the save icon.

NOTE: This step needs to be performed with every
client scanner in the tunnel.

Phone: 800.894.0412 - Fax: 888.723.4773 - Web: www.ctiautomation.net - Email: info@ctiautomation.net



208 Appendix E: FAST Monitor Configuration

AcculLazr™ AL5010 Product Line Manual

2. Open Modify Settings > FAST Monitor
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Modify > FAST Monitor

He @

Select the Reader

the illustration for
relative positions.

that relates to the

scanning tunnel,

FAST Monitor Port
Port Na. 9859

Position from the drop-
down menu. Reference 3 W

IMPORTANT: Be sure to
use a unique position

reader's location in the

Reconnect Time

15 Tunnel Information -
| Tunnel Name

|FrommELeq]

Reader Postion

13 - Left Side (Bottom) =

4

5 Remote IP Addr.

NOTE: Connection parameters are only applicable for controllers and standalone units

Update Reset

a. Enter a name for the tunnel in the Tunnel Name field.

b. Select a reader position from the Reader Position drop-down list.

c. Enter the FAST Monitor port number in the Port No. field (always
9899) and the FAST Monitor IP address in the Remote IP Addr. field.

d. Click Update and then click the save icon.

Set up FAST Monitor (refer to the FAST Monitor documentation for setup

information.)
% NOTE: If multiple units are being used in a network

connection, see the Controller/Client section for
configuration



Installation Drawings

A\

IMPORTANT: Although AL5010 is easy to install and setup, it is also very

robust in its capabilities. If you are interested in additional information on
product training, please contact us at 1-800-BAR-CODE.

Any application-specific drawings shipped with the equipment may
supersede the drawings provided in this appendix.

AL5010 Installation Drawings

The drawings provided in this appendix are useful when mechanically and
electrically installing the AccuLazr AL5010.

Mechanical Installation Drawings

AL5010 Scanner Mechanical Specification (111584)

AL5010 Mechanical Installation (111585)

= AL5010 Mounting Dimensions (sheet 1)

= AL5010 Mounting with Universal Mounting Bracket (sheet 2)
Kit, Universal Mounting Bracket, AL5010 (111620)

Basic Interface Module Specification (111632)

Enhanced Interface Module Specification (111634)

Photoeye Mounting (for Accu-Sort Structures) (41222)
Photoeye Mounting (24130)

Tachometer Mounting with Anti-Static Brush (102974)

Electrical Installation Drawings
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Interconnect: AL5010 with Enhanced Interface Module (113490)
= Interconnections of AL5010 (sheet 1)

= Power, Trigger and Tachometer Options (sheet 2)

= Start and End Trigger Photoeyes (sheet 3)

= Computed Tach and Trigger (sheet 4)

=  Serial, DeviceNet or Profibus Communications (sheet 5)
AL5010 Controller / Client Interconnections (113492)

AL5010 Connector Pin-Outs Diagram (113493)
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PART NO. 0111584001

THIS IS NOT A CONTROLLED COPY UNLESS
STAMPED “CONTROLLED COPY" IN RED

THIS DOCUMENT IS PROVIDED FOR A
SPECIFIC PURPOSE AND THE DISCLOSED
INFORMATION REMAINS OUR PROPERTY.

[T MAY NOT BE DISCLOSED, COPIED,

OR REPRODUCED, EXCEPT FOR THE
SPECIFIC PURPOSE, WITHOUT ACCU-SORT'S
PRIOR APPROVAL. THIS NOTICE MUST
APPEAR ON ANY COPY OR REPRODUCTION
OF THIS DOCUMENT.

©2007 ACCU-SORT SYSTEMS, INC.

REV

CLASS 1 LASER PRODUCT
(IEC-60825-1 2007)
COMPLIES WITH 21CFR1040.10 AND
21CFR1040.11 WITH DEVIATIONS
PURSUANT TO LASER NOTICE 50
DATED JUNE 24,2007

DISPLAY

METRIC

UNLESS OTHERWISE SPECIFIED DRAWN g DATE
DIMENSIONS ARE IN MILLIMETERS[INCHES]
ALL ANGLES ARE 90°
REMOVE BURRS AND SHARP EDGES CHKD DATE
MM [INCH]  ANGULAR TJB
X+2.500 [.X.1000] X£1.00°
X0.500 [.XX+.0200] X£0.10° DEPT.  MECH ENG

XX£0.130  [.XXX+.0050] XX+0.01°
XXX0.013  [.XXXX+.0005]

E- N/A

CUSTOMER N/A

CONTRACT # N/A

RELEASED

]
REVISION

CHANGE BY DATE
TJIB  110CT2010

ACCU-SORT "SYSTEMS, inc.
TELFORD, PA 18969 USA

MECHANICAL SPECIFICATIONS

AL5010
SIZE CAGE CODE DWG NO.
D 53830 111584
scalE NONE CADSYS. SOLIDWORKS  SHEET ] OF

]



4

2 ]
NOTES: REVISION
LT NI AR ST 28 g
o
2) MOUNTING HARDWARE (INCLUDED WITH UNIVERSAL MOUNTING BRACKET): 2 | ECO 11-65, REVISED AS SHOWN T8
2X M5 SCREW, WASHER AND Z-NUT FOR EXTRUSION MOUNTING (SHOWN))
2X #10 SELF-DRILLING SCREW FOR SURFACE MOUNTING (NOT SHOWN)
1X 5/16-18 T-STUD AND FLANGED BUT FOR EXTRUSION MOUNTING WITH +180° ROTATION
(@]
PITCH +15
D
I |
i — D \
/
|
— % —
-~ 62[2.44] —=
O O O OO OO OO O0O0
O O O OO0 0O 00O O0O0 TILT
OOOOOOOOOOOZ SEE NOTE 1 SKEW
99.5(3.92] 143.3[5.64] +150°/-8°
+ J4| / L
: ,' e
0
e =S E— READ DISTANCE /
REFERENCE POINT—
@[ ]p W H | ' 39.5[1.56]
450 ]| HHE “ [ J
35[1.38
H \ i 17.5[.69] 22 [f” i
(14.8[.58] )|——= < 23.6[.93] —=——»
sz = \MOUNTING SLOTS FOR 28.5(1.12] -
M5[#10] HARDWARE
- 95[374] — = \
~— 110[4.33] ——— = MOUNTING HOLE FOR
5/16 T-STUD
PART NO. -- METRIC
STAMPED ‘CONTROLIED COPY IRED  DIENSIONS AR N LLIETERsincresy ™ TJB o= 01.31.08 ACCU-SORT ‘SYSTEMS, inc.
THIS DOCUMENT IS PROVIDED FOR A REMOVE BURRS AND SHARP EDGES CHKD DATE TELFORD, PA 18969 USA
SPECIFIC PURPOSE AND THE DISCLOSED . DATE
INFORMATION REMAINS OUR PROPERTY. i INCGH]  ANGULAR o TJB 01.31.08 INSTALLATION DRAWING
OR REPRODUCED, EXCEPTFOR THE xase el e o MECH ENG AL5010
REFERENCE DRAWINGS SPECIFIC PURPOSE, WITHOUT ACCU-SORT'S XX£0.130  [XXX£0050] XX0.01° E_ N/A
111584 MECHANICAL SPECIFICATIONS PRIOR APPROVAL. THIS NOTICE MUST OOEROTS 100060008) A el B 111585
111407 EXPLODED PARTS DIAGRAM APPEAR ON ANY COPY OR REPRODUCTION CUSTOMER  N/A C 53830
OF THIS DOCUMENT.
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DATE
10FEB2011
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AL5010 T O T
SCAN HEAD

011 1625xxx\ —

00

AL5010
SCAN BASE
0111623001

UNIVERSAL MOUNTING
BRACKET KIT
P/N 0111620001

MOUNTING EXTRUSION
(SUPPLIED SEPERATELY)

M4 MOUNTING HARDWARE ' g%
SUPPLIED WITH SCAN BASE/@

PART NO. 0111585001 METRIC A

THIS IS NOT A CONTROLLED COPY UNLESS UNLESS OTHERWISE SPECIFIED

R .
STAMPED "CONTROLLED COPY" IN RED DIMENSIONS ARE IN MILLIMETERs{INGHES] A" TJB oate  01.31.08 ACCU-SORT SYSTEMS, inc.
REMOVE BURRS AN o oATE TELFORD, PA 18969 USA
THIS DOCUMENT IS PROVIDED FOR A REMOVE BURRS AND SHARP EDGES .
SPECIFIC PURPOSE AND THE DISCLOSED TOLERANCES: ENGR OATE
INFORMATION REMAINS OUR PROPERTY. VETRIC INCH  ANGULAR TJB 01.31.08 INSTALLATION DRAWING
IT MAY NOT BE DISCLOSED, COPIED, X£2.500 [X£.1000] X1.00° perr. MECH EN
OR REPRODUCED, EXCEPT FOR THE 20500 : )[&éigggg} x>)§i88? C G AL5010
SPECIFIC PURPOSE, WITHOUT ACCU-SORT'S XX20. XXX XX£0.01° | E_
PRIOR APPROVAL. THIS NOTICE MUST KXXE0.013 - [XXXX+.0005] £ N/A SIZE CAGECODE  DWG. NO. 111585
APPEAR ON ANY COPY OR REPRODUCTION CUSTOMER  N/A C 53830
OF THIS DOCUMENT.
CONTRACT # N/A scALE  NONE CADSYs.
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NOTES:
1) ITEM NUMBERS APPLY TO THIS DRAWING ONLY
2) ITEMS 6 THRU 9 TO BE BAGGED SEPARATELY

PART NO. 0111620001 METRIC

THIS IS NOT A CONTROLLED COPY UNLESS UNLESS OTHERWISE SPECIFIED

STAMPED “CONTROLLED COPY” IN RED DIMENSIONS ARE IN MILLIMETERS [INCHES]
ALL ANGLES ARE 90°

THIS DOCUMENT IS PROVIDED FOR A REMOVE BURRS AND SHARP EDGES

SPECIFIC PURPOSE AND THE DISCLOSED TOLERANCES:

INFORMATION REMAINS OUR PROPERTY. MM INCHI  ANGULAR

IT MAY NOT BE DISCLOSED, COPIED, 42,500 [.x:[.1ooo} el 000

OR REPRODUCED, EXCEPT FOR THE 350200 [ XX£.0200] 360100

SPECIFIC PURPOSE, WITHOUT ACCU-SORT'S XXE0.130 [ X0 0050] x20.01°

PRIOR APPROVAL. THIS NOTICE MUST XXXE0.013  [OOXE0005]

APPEAR ON ANY COPY OR REPRODUCTION
OF THIS DOCUMENT.
© 2007 ACCU-SORT SYSTEMS, INC.
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REV

2 ECO 11-65 REVISED AS SHOWN TJB 10FEB2011

CHANGE

]
REVISION

BY DATE

DRAWN TJB DATE  01.31.08
CHKD XXX DATE  XX.XX.XX
ENGR - TgB DPATE  (01.31.08
bEPT. - MECH ENG

E- N/A
CUSTOMER  N/A
éﬁf&@%@lﬁdﬂ{aﬁion.net

SEE NOTE 2/

1 70110361001
2 1000068551
2 71000069351
2 1000068227

2 [ 100069798
2 1000068330
1 70111622001
1 70111621001
ITEM QTY PART NO

|
N WhH OO N O

-

5/16-18 T-STUD AND FLANGED NUT

#10-16 1"LG PAN HD PHIL SELF DRILLING SCREW, S/S

PMHS M5X.8 10MM LG, PHIL, STAINLESS STEEL
Z-NUT, M5X8

HHCS, M6X1.0 10 LG STAINLESS STEEL

WAVE WASHER, 12MM OD X 6.4MM ID X .5MM THK,SS

BRACKET, UMB LOWER
BRACKET, UMB UPPER
DESCRIPTION

ACCU-SORT SYSTEMS, inc.
TELFORD, PA 18969 USA

KIT, UNIVERSAL MOUNTING BRACKET

SIZE CAGE CODE
B 53830

scalE NONE caDsys.

AL5010

DWG. NO. 1 1 1620

SOLIDWORKS ' SHEET 1T OF 1

]

A
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NOTES:

1) WEIGHT: .29KGS [.58LBS]

2) ENVIRONMENTAL RATING: IP65

3) INCLUDED MOUNTING HARDWARE:

2X M5 SCREW AND Z-NUT FOR EXTRUSION MOUNTING (SHOWN)

2X #10 SELF-DRILLING SCREW FOR SURFACE MOUNTING (NOT SHOWN)

4X MOUNTING HOLES

FOR M5 [#10] HARDWARE

925 OA
[3.64]

136.4
[5.37]
6.2 124
[.24] il [4.88] .
1)
[1324} g rom =
83.9 S
[3.30]
U []
WL (L WLl
Egj' A

REFERENCE DRAWINGS
111631 ASSEMBLY, BASIC INTERFACE MODULE

4

PART NO.

THIS DOCUMENT IS PROVIDED FOR A
SPECIFIC PURPOSE AND THE DISCLOSED
INFORMATION REMAINS OUR PROPERTY.

IT MAY NOT BE DISCLOSED, COPIED,

OR REPRODUCED, EXCEPT FOR THE
SPECIFIC PURPOSE, WITHOUT ACCU-SORT'S
PRIOR APPROVAL. THIS NOTICE MUST
APPEAR ON ANY COPY OR REPRODUCTION
OF THIS DOCUMENT.

© 2007 ACCU-SORT SYSTEMS, INC.
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0111632001

THIS IS NOT A CONTROLLED COPY UNLESS
STAMPED “CONTROLLED COPY” IN RED

REV

|

65
[2.56]

i

ALL ANGLES ARE 90°

[

METRIC

UNLESS OTHERWISE SPECIFIED
DIMENSIONS ARE IN MILLIMETERS[INCHES]

REMOVE BURRS AND SHARP EDGES

TOLERANCES:
METRIC [INCH ANGULAR
X+2.500 [.X+.1000] X+1.00°
.X+0.500 [.XX+.0200] X0.10°
XX+0.130 [.XXX+.0050] XXx0.01°
XXX+0.013 [ XXXX+.0005]

1

ACCU-SORT 1.5"X1.5" STRUCTURALJ
EXTRUSION SHOWN FOR

CHANGE
RELEASED 10-263

ILLUSTRATION PURPOSES ONLY

DRAWN TJB DATE  04.04.08

CHKD DATE

ENGR TJB DATE

04.04.08
berT. - MECH ENG

E- N/A
CUSTOMER ~ N/A
i%@%@lﬁdﬂ{ﬁon.net
2

]

REVISION
BY
TJB

DATE
140CT2010

MOUNTING HARDWARE
SEE NOTE 3

ACCU-SORT SYSTEMS, inc.

TELFORD, PA 18969 USA

MECHANICAL SPECIFICATIONS
BASIC INTERFACE MODULE - AL5010

111632

SIZE CAGE CODE
B 53830

scalE NONE caDsys.

DWG. NO.

SOLIDWORKS ' SHEET
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NOTES:

1) WEIGHT: .52KGS [1.14LBS]

4

2) ENVIRONMENTAL RATING: IP65

3) INCLUDED MOUNTING HARDWARE:
4X M5 SCREW AND Z-NUT FOR EXTRUSION MOUNTING (SHOWN)
4X #10 SELF-DRILLING SCREW FOR SURFACE MOUNTING (NOT SHOWN)

6.2
[.24]
45
[1.77] ]
133.6
[5.26 ]
38.1
[1.50]

fy————————————

191.4
[7.54]

179
[7.05]

l

4X MOUNTING HOLES
FOR M5 [#10] HARDWARE

)

REFERENCE DRAWINGS

REV

1

immik

R

@D
4 Do

ACCU-SORT 1.5"X3" STRUCTURAL
EXTRUSION SHOWN FOR —

]
REVISION

CHANGE BY
RELEASED 10-263

DATE
TJB

MOUNTING
HARDWARE
SEE NOTE 3

ILLUSTRATION PURPOSES ONLY

123.9
[4.88]
—- |
© (| 00BO|B :
AN \': — "“ =
© © | @ "B =
PART NO. 0111634001 M ETRI C

111633 ASSEMBLY, ENHANCED INTERFACE MODULE

4

THIS IS NOT A CONTROLLED COPY UNLESS
STAMPED “CONTROLLED COPY” IN RED
ALL ANGLES ARE 90°

THIS DOCUMENT IS PROVIDED FOR A
SPECIFIC PURPOSE AND THE DISCLOSED

INFORMATION REMAINS OUR PROPERTY T e

: METRIC INCH
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OF THIS DOCUMENT.
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UNLESS OTHERWISE SPECIFIED
DIMENSIONS ARE IN MILLIMETERS[INCHES]

REMOVE BURRS AND SHARP EDGES

DRAWN TJB DATE  04.04.08
CHKD DATE
ENGR TJB DATE  04.04.08
ANGULAR
X£1.00°  DEPT.
Xe1.00° MECH ENG
XX0.01°  E- N/A
CUSTOMER  N/A
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ACCU-SORT SYSTEMS, inc.
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MECHANICAL SPECIFICATIONS
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REF. 1.5" X 3.0" EXTRUSION (2)

PART NO. 1000020589

THIS IS NOT A CONTROLLED COPY UNLESS
STAMPED “CONTROLLED COPY” IN RED

THIS DOCUMENT IS PROVIDED FOR A
SPECIFIC PURPOSE AND THE DISCLOSED
INFORMATION REMAINS OUR PROPERTY.

IT MAY NOT BE DISCLOSED, COPIED,

OR REPRODUCED, EXCEPT FOR THE
SPECIFIC PURPOSE, WITHOUT ACCU-SORT'S
PRIOR APPROVAL. THIS NOTICE MUST
APPEAR ON ANY COPY OR REPRODUCTION
OF THIS DOCUMENT.

© 2007 ACCU-SORT SYSTEMS, INC.
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UNLESS OTHERWISE SPECIFIED

DIMENSIONS ARE IN INCHES [MILLIMETERS]

ALL ANGLES ARE 90°

ALL C-CINKS ARE 82° INCLUDED ANGLE

ALL BEND RELIEFS TO SUIT

TOLERANCES:
INCH [METRIC]
X£.1000 [X+2.500]
XX.0200 [.X£0.500]
XXX£.0050  [XX0.130]
XXXX£.0005  [.XXX£0.013]
FRACTIONS +1/4
FTLN 1"

ANGULAR
X+1.00°
X+0.10°
XX£0.01°

]

REVISION
REV CHANGE BY DATE
ECO 10-3 AS 02/17/10

80 1 1000012429 |BAG,5X7X.002,POLY (NOT SHOWN)
70 1 1000016771 |WASHER,#10,LOCK,INTERNAL TOOTH,,
60 1 1000013792 |REFLECTOR,3 INCH
50 1 1000022099 |WASHER #10,FLAT
40 1 1000005781 |SCREW,10-32,3/4, HEX CAP,BUTTON HEAD,STEEL,BLACK OXIDE
20 2 0110361001 |ASSEMBLY ,1PK,3/4IN, T-STUD AND FLANGED NUT
10 2 1000008700 |PLATE,STRAIGHT,PHOTOEYE/REFLECTOR
ITEM|QTY.| PART NO. |[DESCRIPTION
PRAWN AS  DATE  01/16/09 ACCU-SORT SYSTEMS, inc.
CHKD XXX DATE XX XX.XX TELFORD, PA 18969 USA
ENGR ~AS  DATE  XX.XX.XX KIT, MOUNTING, REFLECTOR
bt MECH ENG PHOTOEYE
E- N/A SIZE CAGECODE  DWG. NO. 41222
CUSTOMER  N/A B 53830
CONTRACT # scAlE NONE cADSYS. SOLIDWORKS  SHEET 1 OF 1
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REVISITONS
REV ECO BY DATE
5 05-1323 CDG/TCS | 12.07.05

s
LSS s

Ve

7/

REFLECTOR
MTG SURFACE

PHOTOEYE MTG
BRKT SURFACE

150 | 1000012324 BRACKET, STANDARD PHOTOEYE MOUNTING

110 1 1000012429 BAG,5X7X.002,POLY (NOT SHOWN)

100 4 1000022111 WASHER, #6 LARGE OD,FLAT,,.

90 1 1000019379 LABEL,WIRE 2 IN X .38IN (NOT SHOWN)

80 3 1000018459 NUT, #6-32 HEX

70 3 1000016776 LOCKWASHER, #6 INTERNAL TOOTH

60 | 1000012302 BAG, 10X12X.002,POLY (NOT SHOWN)

50 3 1000009740 SCREW,6-32,2" ,PHILL IPS,MACHINE ,PAN HEAD,STEEL,ZINC

40 | 1000013792 REFLECTOR,3 INCH

30 1 1000011711 BRACKET,SMALL SCANNER PHOTOEYE MOUNTING

ASSEMBLY,LARGE SCANNER SINGLE PHOTOEYE 12 FT

= : 1000002103 SHIELDED CABLE W/AMPHENOL CONNECTOR

10 1 1000001504 DIAGRAM,POLARIZED PHOTOEYE MOUNTING
PART NO. 1000020538 ITEM Q1Y PART NO DESCRIPTION
Bl St g WEOSHIE RN (TR 10,05 of[< ACou SORTD SYSTENS. inc.
THIS DOCUMENT 1S PROVIDED FOR A e S e G0 OATE TELFORD, PA 18969 USA
NG 10N REMA s U proberry. e BN TUBIONE 11,10,05 ASSEMBLY. POLARIZED
[ECIRSE | i e e e e AHOTOEVE HOONTING 1
SPECIFIC PURPOSE. WITHOUT ACCU-SORT'S | ;X000 Le0. o001 xed. 07 fp — S GE e o
EE;ESTZEEZSE%EP%; N Q:ﬁﬁg@"’; (;'XXMO'[@_EL CUSTOMER  N/A C 53830 ' 24130
©2004, ACCU-SORT SYSTEMS, INC. REMOVE SHARP EDGES AND HLRRS CONTRACT # N/A scae NONE ‘CAD sys. CADKEY ‘SHEET I oF 2
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REFLECTOR
MTG SURFACE

PHOTOEYE MTG
BRKT SURFACE

110 | 1000002324 BRACKET, STANDARD PHOTOEYE MOUNTING

100 4 1000022111 WASHER, #6 LARGE OD,FLAT,,,

90 | 1000019379 LABEL,WIRE 2 IN X .38IN (NOT SHOWN)

80 3 1000018459 NUT, #6-32 HEX

70 3 1000016776 LOCKWASHER, #6 INTERNAL TOOTH

60 1 1000012384 BAG, 3X5X.002,POLY (NOT SHOWN)

50 3 1000009740 SCREW,6-32,2" ,PHILL IPS,MACHINE ,PAN HEAD,STEEL,ZINC

40 1 1000013792 REFLECTOR,3 INCH

30 | 1000011711 BRACKET,SMALL SCANNER PHOTODEYE MOUNTING

20 1 1000013425 PHOTOEYE ,POLARIZED 6FT SHIELDED CABLE W/9-PIN DIN

10 | 1000001504 DIAGRAM,POLARIZED PHOTOEYE MOUNTING
PART NO. 1000020527 ITEM | QTY/ASSY|  PART NO DESCRIPTION
s Bl Wl R e | TRIBTILINE) o SR S A
SRS E A R e 0 G o RIpTIE
INFORMAT [ON REMAINS OUR PROPERTY. R eRG AE 1J8 11,10.05 ASSEMBLY, POLARIZED
IT MAY NOT BE DISCLOSED, COPIED. edoso Doz.s0 welooe | EPT- MECH ENG PHOTOEYE MOUNTING DIAGRAM
SRELIFICPORRDSE . W ITHOUT ACEU-SORT'S | 000 CX0.5000 ao.10: [T N/A o
EE;E&QEEZSES&?&HE% gggéggugg%rw Egéﬁg@’(’f& {;‘XXX“’I@_EL CUSTOMER  N/A C 53830 ‘ 24130
©2004, ACCU-SORT SYSTEMS, INC. REMOVE SHARP EDGES AND BURRS CONTRACT # N/A scale NONE ‘CAD svs. CADKEY ‘SHEET 2 o 2

/1 Bl N > I 1




4 3 2 1

NOTES. REVISION

1) COMPONENTS LISTED IN ERP BILL OF MATERIALS REV CHANGE BY DATE
(REF. # 0102974001)

2) ATTACH ONE END OF THE 3 FT. GROUND WIRE TO 05 09-402 AS 10/28/09
ITEM 20 USING #6-32 CAP SCREW AND #6-32 HEX NUT
AS SHOWN.

SHEET 2 100 1 [1000066953 |FERRITE,STAR-RING RINGCORE WITH PLASTIC CASE,BLACK SNAP,CABLE DIA MAX27MM,ROHS EU
SHEET 2 90 1 10102974000 |DIAGRAM,INSTALLATION ANTI-STATIC BRUSH ASSEMBLY
NOT SHOWN| 80 1 1000009725 |SCREW,6-32,1, HEX CAP,SOCKET HEAD,STEEL,BLACK OXDE

70 1 1000053263 |ASSEMBLY ,GROUND-WIRE,ANTI-STATIC BRUSH

60 2 |1000018459 |NUT.#6-32 HEX

50 1 1000050624 |CLAMP,3.5IN HOSE

40 3 [1000009683 | SCREW,6-32,1/4 HEX CAP,SOCKET HEAD,STAINLESS

30 4 (1000016777 |LOCKWASHER, #6 INTERNAL TOOTH,STAINLESS

20 1 10102973001 |BRUSH, TACHOMETER, ANTLSTATIC

10 1 (0102972001 |BRACKET, TACHOMETER BRUSH,ANTI-STATIC

ITEM |QTY.| PART NO. DESCRIPTION
PART NO. 0102974001

THIS IS NOT A CONTROLLED COPY UNLE UNLESS OTHERWISE SPECIFIED 2 )
ST:MSPES"COC,\,?ROLLOED Cocpa |NL,JQED % DIMENSIONS ARE ININCHES MiLLMETERs] "N AS  oaTe 08/26/09 ACCU-SORT SYSTEMS, inc.

ALL ANGLES ARE 90°
THIS DOCUMENT IS PROVIDED FOR A ALL C-CINKS ARE 82° INCLUDED ANGLE oo XXX pate - XX XX. XX TELFORD, PA 18969 USA
SPECIFIC PURPOSE AND THE DISCLOSED ALL BEND RELIEFS TO SUIT
INFORMATION REMAINS OUR PROPERTY.  TOERANCES: o uiar o DJK orre 04/25/01 ASSEMBLY, BRUSH, ANTI-STATIC
IT MAY NOT BE DISCLOSED, COPIED, X+.1000 [X£2.500] X+1.00°  DEPT. MECH ENG
OR REPRODUCED, EXCEPT FOR THE XX+.0200 [.X+0.500] X£0.10°
SPECIFIC PURPOSE, WITHOUT ACCU-SORT'S XXX+.0050 [.XX+0.130] XX£0.01° | E_ N/A
APPEAR ON ANY COPY OR REPRODUCTION  FRACTIONS £1/4 CUSTOMER  N/A C 53830
OF THIS DOCUMENT. FTLIN 21"

¢ 2007, ACCU-SORT SYSTEMS, INC. REMOVE SHARP EDGES AND BURRS CONTRACT # N/A sCALE  NONE CADSYS. o pwORks  SHEET 1 OF 2
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REVISION
05

NOTES:
1) ATTACH OPPOSITE END OF GROUND WIRE TO CONVEYOR

ESTABLISHING EARTH GROUND USING (1) #6-32 SCREW,

(1) #6 HEX NUT, AND (1) #6 LOCKWASHER SUPPLIED.
2) INSTALL BRUSH TOUCHING CONVEYOR NO MORE THAN

1/8" FROM BELT.

3) CABLE TO WRAP AROUND FERRITE A MINIMUM OF 6 TIMES
AS SHOWN.

SEE NOTE 2
FOR POSITIONING INFO.

FERRITE INSTALLATION AND LOCATION

SEE NOTE 3
PART NO. 0102974000
THIS IS NOT A CONTROLLED COPY UNLESS ~ UNLESS OTHERWISE SPECIFIED R i
STAMPED "CONTROLLED COPY" IN RED DIMENSIONS ARE IN INCHES iLLiveTERs] ™™ AS  oae - 08/26/09 ACCU-SORT SYSTEMS, inc.
ALL ANGLES ARE 90°
THIS DOCUMENT IS PROVIDED FOR A ALL C-CINKS ARE 82° INCLUDED ANGLE ciko XXX pate XX XX XX TELFORD, PA 18969 USA
SPECIFIC PURPOSE AND THE DISCLOSED ALL BEND RELIEFS TO SUIT
INFORMATION REMAINS OUR PROPERTY.  TOMERANCES: 0 AR o DJK  oare  04/25/01 ASSEMBLY, BRUSH, ANTI-STATIC
IT MAY NOT BE DISCLOSED, COPIED, X£.1000 [X+2.500] X£1.00° = DEPT.
OR REPRODUCED, EXCEPT FOR THE ocom  possd et o MECHENG INSTALLATION
ASSEMBLED VIEW SPECIFIC PURPOSE, WITHOUT ACCU-SORT'S XXX£.0050 [ XX0.130] XX£0.01° E_ N/A
PRIOR APPROVAL. THIS NOTICE MUST XOXXXE.0005 [ XXX0.013] SIzE CASEZOPE | DWe.NO. 102974
APPEAR ON ANY COPY OR REPRODUCTION  FRACTIONS £1/4 CUSTOMER  N/A C 53830
OF THIS DOCUMENT. FTIN 1"
S 2004, ACCU-SORT SYSTEMS, INC.

REMOVE SHARP EDGES AND BURRS CONTRACT # N/A SCALE NONE CADSYS.  soipwoRrks  SHEET 2 OF 2
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REVISIONS
TACHOMETER REV By | DATE
3 ECO 12-40 JG 02/14/12
PHOTO EYE —
1 ] N
=
FLYING LEAD
SERIAL HOST POWER SUPPLY
RS232 OR RS422 COM 1 ==
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NETWORK
p HOST AND/OR
SCANNER SETUP
This docume'nt is proyided forla specifif: purpose This is not a controlled copy unless stamped O ACCU-SORT SYSTEMS
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reproduced, except for specific purpose, without
Accu-Sort’s prior approval. This notice must
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REVISIONS
Controller-Client configuration using Enhanced Interface Module for the controller and the Basic REV By | paTe
TACHOMETER Interface Module for the client. Refer to drawings 113490 INTERCONNECT DRAWING, AL5010
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MODULE for component wiring directions.
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REVISIONS
Controller-Client configuration using Enhanced Interface Module for the controller and direct power REV BY | DATE
TACHOMETER connection on the client. Refer to drawings 113490 INTERCONNECT DRAWING, AL5010 WITH 1 R A PO
ENHANCED MODULE for component wiring directions.
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NOTES:

I REFERENCE DRAWING 111583 CABLE ASSEMBLY ALS010
FOR CABLE BUILD SPECIFICATIONS

PIN 1

PIN 8

VIEW A-A
SHOWN FROM DEVICE SIDE
SEE TABLE I FOR PIN OUT

PIN 1 PIN 5
PIN 6 PIN 10
PIN 11 PIN 15
VIEW B-B
SHOWN FROM DEVICE SIDE
SEE TABLE 2 FOR PIN OUT
TABLE 3 CABLE PART NUMBERS
ASSEMBLY NO. DIM A
0111593001 IM (38IN)
0111533002 2.8M (114IN)

REVISIONS

REV CHANGES

BY

DATE

1 JINITIAL RELEASE

NRS

12/07/10

OIM A SEE TABLE 3

TABLE 4 BILL [OF MATERIALS

3

I | 32-2298UL RJ 45 MALE PLUG

2

I 11000012241 IS5 PIN MALE D

1

| |ISEE TABLE 3 | CABLE ASSEMBLY ALS010

ITEM

Uryl PART NO. DESCRIPTION

PART NO. SEE TEBLE 3

|

TABLE 1 RJ45 WIRING DIAGRAM
PIN # COLOR AWG FUNCTION
! WHT/ORG 24 ETHERNET TX + (OUT)
2 ORANGE 24 ETHERNET TX - (OUT)
3 WHT/GRN 24 ETHERNET RX + (IN)
6 GREEN 24 ETHERNET RX - (IN)
TABLE 2 15 PIN MALE D WIRING DTAGRAM
PIN # COLOR AWG FUNCTION
! WHT/BLU 24 RS 422 TX + (0OUT)
2 WHT/BRN 24 RS 422 RX + (IN)
3 WHT/GRY 24 RS 232 TX (OUT)
4 WHT/YEL 24 TACH +
5 WHT/PUR 24 TRIG +
6 BLUE 24 RS 422 TX - (OUT)H
7 BROWN 24 RS 422 RX - (IN)
8 GRAY 24 RS 232 RX CIN)
g YELLOW 24 TACH -
10 PURPLE 24 TRIG -
Il PINK 27 [0 - 28V CIND
12 WHT/BLK 22 GROUND
13 RED 22 [0 - 28V CIND
14 BLACK 27 GROUND
S| DRAIN 20 CHASSIS GROUND

THIS IS NOT A CONTROLLED COPY LNLESS
STAMPED *CONTROLLED COPY* IN RED

THIS DOCUMENT IS PROVIDED FOR A
SPECIFIC PURPOSE AND THE DISCLOSED
INFORMATION REMAINS OUR PROPERTY

IT MAY NOT BE DISCLOSED, COPIED,

OR REPRODUCED, EXCEPT FOR THE
SPECIFIC PURPOSE, WITHOUT ACCU-SORT'S
PRIOR APPROVAL. THIS NOTICE MUST
APPEAR ON ANY COPY OR REPRODUCTION
OF THIS DOCLMENT.

©1998, ACCL-SORT SYSTEMS, INC.

UNLESS OTHERWISE SPECIFIED: | ORAWN NRS DATE 12,07/10

ALL DIMENSIONS ARE IN INCHES

ALL ANGLES ARE 90 °

ALL C-SINKS ARE 82 °v/ CHKD DATE

ALL BEND RELIEFS TO SUIT

inc.

zilegéﬁ ACCU-SORT® SYSTEMS,
TELFORD, PA 18969 USA

TOLERANCES :

e 100w o 08 NRS | PATE 12,07/10
Xt 020 Xt 10°

00K 005 X007 DEPT. APP ENG

XXXX+. 0005

FTLIN -+
FRACTIONS +1/4 E- N/A

CABLE ASSEMBLY, AL5010 PIN OUT

SIZE CAGE CODE VG NO
D 53830

@ E CUSTOMER 0

CONTRACT #
REMOVE SHARP EOGES AND BLRRS N/A

113483

SCALE NONE CAD SYS. CADKEY ‘XHEET |

oF 1

2

1






